Copyright
Copyright © 2013 Intergraph® Corporation. All Rights Reserved. Intergraph is part of Hexagon.

Including software, file formats, and audiovisual displays; may be used pursuant to applicable software license agreement; contains confidential and proprietary information of Intergraph and/or third parties which is protected by copyright law, trade secret law, and international treaty, and may not be provided or otherwise made available without proper authorization from Intergraph Corporation.

U.S. Government Restricted Rights Legend

Use, duplication, or disclosure by the government is subject to restrictions as set forth below. For civilian agencies: This was developed at private expense and is "restricted computer software" submitted with restricted rights in accordance with subparagraphs (a) through (d) of the Commercial Computer Software - Restricted Rights clause at 52.227-19 of the Federal Acquisition Regulations ("FAR") and its successors, and is unpublished and all rights are reserved under the copyright laws of the United States. For units of the Department of Defense ("DoD"): This is "commercial computer software" as defined at DFARS 252.227-7014 and the rights of the Government are as specified at DFARS 227.7202-3.

Unpublished - rights reserved under the copyright laws of the United States.

Intergraph Corporation
P.O. Box 240000
Huntsville, AL 35813

Terms of Use

Use of this software product is subject to the End User License Agreement ("EULA") delivered with this software product unless the licensee has a valid signed license for this software product with Intergraph Corporation. If the licensee has a valid signed license for this software product with Intergraph Corporation, the valid signed license shall take precedence and govern the use of this software product. Subject to the terms contained within the applicable license agreement, Intergraph Corporation gives licensee permission to print a reasonable number of copies of the documentation as defined in the applicable license agreement and delivered with the software product for licensee's internal, non-commercial use. The documentation may not be printed for resale or redistribution.

Warranties and Liabilities

All warranties given by Intergraph Corporation about equipment or software are set forth in the EULA provided with the software or applicable license for the software product signed by Intergraph Corporation, and nothing stated in, or implied by, this document or its contents shall be considered or deemed a modification or amendment of such warranties. Intergraph believes the information in this publication is accurate as of its publication date.

The information and the software discussed in this document are subject to change without notice and are subject to applicable technical product descriptions. Intergraph Corporation is not responsible for any error that may appear in this document.

The software discussed in this document is furnished under a license and may be used or copied only in accordance with the terms of this license. No responsibility is assumed by Intergraph for the use or reliability of software on equipment that is not supplied by Intergraph or its affiliated companies. THE USER OF THE SOFTWARE IS EXPECTED TO MAKE THE FINAL EVALUATION AS TO THE USEFULNESS OF THE SOFTWARE IN HIS OWN ENVIRONMENT.

Intergraph is not responsible for the accuracy of delivered data including, but not limited to, catalog, reference and symbol data. Users should verify for themselves that the data is accurate and suitable for their project work.

Trademarks

Intergraph, the Intergraph logo, and GeoMedia are registered trademarks of Intergraph Corporation. Microsoft and Windows are registered trademarks of Microsoft Corporation. Bing is a trademark of Microsoft Corporation. Google Maps is a trademark of Google Incorporated. Pictometry Intelligent Images is a registered trademark of Pictometry International Corporation. ERDAS, ERDAS IMAGINE, Stereo Analyst, IMAGINE Essentials, IMAGINE Advantage, IMAGINE Professional, IMAGINE VirtualGIS, Mapcomposer, Viewfinder, Imagizer, LPS, and ERDAS APOLO are registered trademarks and exclusive property of Intergraph Corporation. Other brands and product names are trademarks of their respective owners.

Government Reserved Rights. MsSID technology incorporated in the Software was developed in part through a project at the Los Alamos National Laboratory, funded by the U.S. Government, managed under contract by the University of California (University), and is under exclusive commercial license to LizardTech, Inc. It is used under license from LizardTech. MrSID is protected by U.S. Patent No. 5,710,835. Foreign patents pending. The U.S. Government and the University have reserved rights in MsSID technology, including without limitation: (a) The U.S. Government has a non-exclusive, nontransferable, irre vocational, paid-up license to practice or have practiced throughout the world, for or on behalf of the United States, inventions covered by U.S. Patent No. 5,710,835 and has other rights under 35 U.S.C. § 200-212 and applicable implementing regulations; (b) If LizardTech's rights in the MrSID Technology terminate during the term of this Agreement, you may continue to use the Software. Any provisions of this license which could reasonably be deemed to do so would then protect the University and/or the U.S. Government; and (c) The University has no obligation to furnish any know-how, technical assistance, or technical data to users of MrSID software and makes no warranty or representation as to the validity of U.S. Patent 5,710,835 nor that the MrSID Software will not infringe any patent or other proprietary right. For further information about these provisions, contact LizardTech, 1008 Western Ave., Suite 200, Seattle, WA 98104.
Contents

Introduction: GeoMedia Objects Reference Guide for ERDAS IMAGINE ............................................. 9

Preparing to Connect .................................................................................................................. 9

Connecting to an Access Warehouse ....................................................................................... 9
Connecting to an ArcInfo Warehouse ...................................................................................... 9
Connecting to an ArcView Warehouse .................................................................................... 10
Connecting to a CAD Warehouse ............................................................................................ 10
Connecting to a FRAMME Warehouse ................................................................................... 12
Connecting to a GeoGraphics Warehouse ............................................................................. 13
Connecting to a GML Warehouse ........................................................................................... 13
Connecting to an I/CAD MAP Warehouse ............................................................................. 13
Connecting to a KML Warehouse ............................................................................................ 15
Connecting to a MapInfo Warehouse ..................................................................................... 15
Connecting to an MGE or MGDM Warehouse ...................................................................... 17
Connecting to an MGSM Warehouse ...................................................................................... 17
Connecting to an ODBC Tabular Warehouse ........................................................................ 17
Connecting to an Oracle Object Model Warehouse .............................................................. 17
  Oracle Read-write Data Server ............................................................................................. 17
Connecting to a SQL Server Warehouse ............................................................................... 18
  SQL Read-write Data Server ............................................................................................... 18
Connecting to a SQL Server Spatial Warehouse .................................................................. 18
  SQL Read-write Data Server ............................................................................................... 18
Connecting to a SmartStore Server Warehouse ................................................................. 19
Connecting to a Text File Server Warehouse ....................................................................... 20
Connecting to a WCS Warehouse .......................................................................................... 20
Connecting to a WFS Server Warehouse .............................................................................. 21
  WFS Read-write Data Server ............................................................................................. 22
Connecting to a WMS Warehouse .......................................................................................... 23

Using Oracle Connections .................................................................................................... 25
  Oracle Read-write Data Server ............................................................................................. 25
Delivery and Connection ........................................................................................................ 25
  Read-Only Connections ..................................................................................................... 25
  Read-Write Connections .................................................................................................... 25
  Domain Authentication ....................................................................................................... 26
  Native Queries .................................................................................................................... 27

Using SQL Server Connections ............................................................................................ 29
  SQL Read-write Data Server ............................................................................................... 29
Delivery and Connection ........................................................................................................ 29
  Prerequisites ....................................................................................................................... 29
  Connections ........................................................................................................................ 29
Displaying Data That Has No Coordinate System Specified ..................................................31
Creating Data Server .INI Files .........................................................................................35
The ARC/INFO Data Server .INI File ..................................................................................35
  CHARACTER SET ..................................................................................................................36
  COORDINATE SYSTEM (ARC/INFO) ...................................................................................36
  LEVEL COLUMN ALIAS: and SYMBOL COLUMN ALIAS: .................................................37
The ArcView Data Server .INI File .......................................................................................39
  The ArcView Data Server .INI File.......................................................................................39
  COORDINATE SYSTEM (ArcView) ......................................................................................39
  MEASURE COLUMN ALIAS:, MINIMUM MEASURE COLUMN ALIAS:, AND
  MAXIMUM MEASURE COLUMN ALIAS: ............................................................................40
  TEXT ENCODING ..................................................................................................................42
  SERVE NUMERIC WIDTH AS INTEGER:, SERVE NUMERIC WIDTH AS LONG:, and
  SERVE NUMERIC WIDTH AS SINGLE ..............................................................................43
The CAD Data Server .INI File ...........................................................................................43
  The CAD Data Server .INI File ...........................................................................................44
  General Keywords ................................................................................................................45
  CACHE FILE ..........................................................................................................................45
  CACHE UPTODATE ..................................................................................................................45
  LOCK TIMEOUT THRESHOLD ..............................................................................................46
  IGDS Keywords ....................................................................................................................46
  GRAPHICSTEXTSTRING DELIMITER .................................................................................46
  FORCE TEXT JUSTIFICATION (CAD) ...................................................................................47
  SERVE CELL ORIGIN, SERVER CELL GEOMETRY, and SERVE CELL TEXT
  Keywords ...............................................................................................................................48
  SERVE CELL ORIGIN .............................................................................................................48
  SERVE CELL GEOMETRY ........................................................................................................48
  SERVE CELL TEXT ..................................................................................................................49
  TEXT ORIGIN BY RANGE .......................................................................................................49
  SERVE RICH TEXT: TRUE/FALSE (And the Related INI Keywords) ....................................49
  GROUP TEXT BY GRAPHIC GROUP: TRUE/FALSE ..............................................................51
  GROUP GEOMETRY BY GRAPHIC GROUP: TRUE/FALSE: ..................................................52
  AutoCAD Keywords ..............................................................................................................52
  SERVE BLOCK ORIGIN .........................................................................................................52
  SERVE BLOCK GEOMETRY .....................................................................................................53
  SERVE BLOCK TEXT ...............................................................................................................54
  SERVE RICH TEXT: TRUE/FALSE: ........................................................................................54
  SERVE CELL ORIGIN .............................................................................................................56
  SERVE CELL GEOMETRY .......................................................................................................56
  SERVE CELL TEXT ..................................................................................................................57
  GROUP TEXT BY GRAPHIC GROUP: TRUE/FALSE ..............................................................57
  GROUP GEOMETRY BY GRAPHIC GROUP: TRUE/FALSE: ..................................................58
  FORCE TEXT JUSTIFICATION : LOWERLEFT / CENTERLEFT / UPPERLEFT: ..................58
Contents

SERVE TEXTNODE AS MULTILINE TEXT ................................................................. 59
MAXIMUM NUMBER OF FILES OPEN ....................................................................... 59

The FRAMME Data Server .INI File .................................................................. 59

The GeoGraphics Data Server .INI File .............................................................. 60

The I/CAD MAP Data Server .INI File ............................................................... 60
  The I/CAD MAP Data Server .INI File ............................................................... 60
  GEOMETRY TYPE ............................................................................................... 60
  NUMBER OF LINKAGES ...................................................................................... 61
  RICH TEXT, SERVE RICH TEXT ......................................................................... 62

The KML Data Server .INI File .......................................................................... 63
  GEOMETRY TYPE ............................................................................................... 63
  KMZ PROCESSING ............................................................................................... 68
  SERVE FILES FROM SECURE SITES WITHOUT A VALID CERTIFICATE ............ 69

The MapInfo Data Server .INI File ..................................................................... 69
  The MapInfo Data Server .INI File ..................................................................... 69
  COORDINATE SYSTEM (MapInfo) ..................................................................... 70
  GEOMETRY TYPE (MapInfo) .............................................................................. 72
  TEXT ..................................................................................................................... 73

The MGDM Data Server .INI File ..................................................................... 73

The MGE Data Server .INI File .......................................................................... 74

The MGSM Data Server .INI File ..................................................................... 74

The WCS Data Server .INI File .......................................................................... 74
  The WCS Data Server .INI File .......................................................................... 74

The WFS Data Server .INI File .......................................................................... 75
  The WFS Data Server .INI File .......................................................................... 75

The WMS Data Server .INI File .......................................................................... 76
  The WMS Data Server .INI File .......................................................................... 77

Overview of the Database Utilities ..................................................................... 79

Overview of the Define CAD Server Schema File Utility .................................. 79
  Define CAD Server Schema File ....................................................................... 79
  Running Define CAD Server Schema File ......................................................... 80
CAD Server Definition Workflow .......................................................... 80
Menus ........................................................................................................... 81
  File Menu .................................................................................................. 82
  Feature Class Menu .................................................................................. 83
  Options Menu .......................................................................................... 84
  Help Menu ............................................................................................... 85
Define CAD Server Schema File Dialog Box ............................................... 85
  Dialog Box Options .................................................................................. 85
Select Map Files Dialog Box ........................................................................ 86
  Dialog Box Options .................................................................................. 86
Select Coordinate System Files Dialog Box .................................................. 88
  Dialog Box Options .................................................................................. 88
Define Feature Class Dialog Box ................................................................ 90
  Dialog Box Options .................................................................................. 90
New (Feature Class Definition) Dialog Box .................................................. 91
  Tabs .......................................................................................................... 91
    General Tab ............................................................................................. 91
    Tab Options ............................................................................................ 91
    Graphic Attributes Tab ........................................................................... 93
    Tab Options ............................................................................................ 93
    Criteria Tab ............................................................................................. 94
    Tab Options ............................................................................................ 94
    Tags Tab ................................................................................................ 95
    Tab Options ............................................................................................ 96
    Linkages Tab ........................................................................................... 96
    Tab Options ............................................................................................ 97
Edit Coordinate System to Map Associations Dialog Box ................................ 97
  Dialog Box Options .................................................................................. 97
Edit Coordinate System to Feature Class Associations Dialog Box ............. 99
  Dialog Box Options .................................................................................. 99
Edit Feature Class to Map Associations Dialog Box ...................................... 100
  Dialog Box Options .................................................................................. 100
Specify Connection Parameters Dialog Box ............................................... 101
  Dialog Box Options .................................................................................. 101
Primary Unique Key Dialog Box ................................................................ 102
  Dialog Box Options .................................................................................. 102
Advanced Database Linkage Dialog Box ...................................................... 104
  Dialog Box Options .................................................................................. 104
Update Map MBRs Dialog Box .................................................................... 105
  Dialog Box Options .................................................................................. 105
  Updating Map MBRs .................................................................................. 106
.INI File ........................................................................................................ 107
  AutoCAD Scanner ..................................................................................... 107
  IGDS Scanner ............................................................................................ 110
  MicroStation V8 Scanner ........................................................................... 116
Appendix ....................................................................................................... 123
  CAD Server Schema ................................................................................. 123
  AutoCAD Scanner ..................................................................................... 124
Overview of the Define Text File Server Format File Utility .......................................................... 187

Introduction ........................................................................................................................................ 187
Workflow ............................................................................................................................................. 188
  Workflow Overview .............................................................................................................................. 188
Supported Formats ............................................................................................................................... 188
  Flow Diagram ...................................................................................................................................... 191
  Example Workflow .............................................................................................................................. 192
  Limitations .......................................................................................................................................... 199
File Type Definition ............................................................................................................................. 200
  Dialog Box Options ............................................................................................................................ 200
Non Uniform Row Definition ............................................................................................................... 202
  Dialog Box Options ............................................................................................................................ 202
Fixed Width Data Definition ................................................................................................................ 204
Delimited Data Definition ................................................................................................................... 206
  Dialog Box Options ............................................................................................................................ 206
Geometry Definition - Point ................................................................................................................ 208
  Dialog Box Options ............................................................................................................................ 210
Geometry Definition - Line and Area .................................................................................................... 210
  Dialog Box Options ............................................................................................................................ 210
Attribute Definition ............................................................................................................................. 212
  Dialog Box Options ............................................................................................................................ 212

Overview of the Define Warehouse Configuration File Utility ............................................................ 215

Introduction to Define Warehouse Configuration File ........................................................................ 215
Workflow for ArcInfo, ArcView, and MapInfo Data Servers ............................................................... 216
Workflow for CAD Data Servers .......................................................................................................... 219
Workflow for I/CAD Map Data Server ................................................................................................ 222
Workflow for KML Data Server .......................................................................................................... 225
Workflow for WCS Data Server .......................................................................................................... 228
Workflow for WFS Read-Only Data Server ......................................................................................... 231
Workflow for WFS Read-Write Data Server ......................................................................................... 234
Workflow for WMS Data Server .......................................................................................................... 237
First Panel - Select Data Server Dialog Box ...................................................................................... 240
  Dialog Box Options ............................................................................................................................ 240
Second Panel - Set Values for INI Keywords ...................................................................................... 242
  Dialog Box Options ............................................................................................................................ 243
Modify Keyword Value Dialog Box .................................................................................................... 247
  Dialog Box Options ............................................................................................................................ 247
Geometry Type - MapInfo Server Keyword Value Dialog Box ......................................................... 248
  Dialog Box Options ............................................................................................................................ 248
Font-related keywords Dialog Box ..................................................................................................... 249
  Dialog Box Options ............................................................................................................................ 249

Index ..................................................................................................................................................... 252
Introduction: GeoMedia Objects Reference Guide for ERDAS IMAGINE

Beginning with the ERDAS IMAGINE 2013 release, GeoMedia Objects are used as the basis for vector operations and run natively in ERDAS IMAGINE.

The following excerpts from GeoMedia documentation provide a useful reference when connecting to various vector data sources in ERDAS IMAGINE.

The term GeoWorkspace used in this context refers to the ERDAS IMAGINE workspace.

Preparing to Connect

As the universal geographic client, the software lets you combine data from many sources and in different formats into one spatially accurate environment. To ensure accuracy, you must set up your data servers and provide the software with certain information about the data you want to view. Each data type requires different information; the following sections cover special procedures or information required for each.

Connecting to an Access Warehouse

To connect to an Access database, you must identify or select an Access GeoMedia Professional Database file (.mdb).

Connecting to an ArcInfo Warehouse

To connect to an ArcInfo, you must identify or select an ArcInfo warehouse folder. Before trying to connect, check the following:

- ArcInfo data must be in native format (not exported). Native format requires a warehouse folder that contains subfolders corresponding to coverages and an \INFO folder that contains an ARCDR9 or ARC.DIR file.
Preparing to Connect

- A coordinate-system file (.csf) for the ArcInfo data must be created with **Define Coordinate System File**.
- The coordinate-system file for the ArcInfo data must be identified in a `<Arc/Infoworkspace folder name>.ini` file, which you may store in the ArcInfo GeoWorkspace folder.
- For ease of maintenance, you should store the .csf and .ini files along with the data in the ArcInfo warehouse folder as the primary location. When this is not possible (due to read-only media, for example), you should store these files in the default warehouse location, and the software will find them there.

The software does not support the PC version of ArcInfo.

*See the “Displaying Data That Has No Coordinate System Specified” section and the “Creating Data Server .INI Files” section.*

### Connecting to an ArcView Warehouse

To connect to an ArcView warehouse, you must identify or select an ArcView Shape Files folder. Before trying to connect, check the following:

- ArcView data must be in native format (not exported). Native format requires a warehouse folder that contains themes with each theme having its individual .dbf, .shp, and .shx files.
- A coordinate-system file (.csf) for the ArcView data must be created with **Define Coordinate System File**.
- The coordinate-system file for the ArcView data should be identified in a `<workspace name>.ini` file, which you may store in the Arc View Shape Files folder.
- For maintenance ease, you should store the .csf and .ini files along with the data in the ArcView Shape Files folder as the primary location. When this is not possible (due to read-only media, for example), you should store these files in the warehouse location, and the software will find them there.

*See the “Displaying Data That Has No Coordinate System Specified” section and the “Creating Data Server .INI Files” section.*

### Connecting to a CAD Warehouse

To connect to a CAD warehouse, you must identify or select a CAD Server Schema file. Before trying to connect, check the following:

- For AutoCAD and MicroStation V8 data, a coordinate-system file (.csf) must have been created with **Define Coordinate System File**.
See the “Displaying Data That Has No Coordinate System Specified” section.

- For IGDS and AutoCAD data, an ODBC data source must have been created if there are database attribute linkages that have to be served.

- A CAD schema definition file (.csd) must have been defined with Define CAD Server Schema File utility. The CAD data server allows you to use MicroStation V7 design files (with or without attribute linkages) or AutoCAD files (.dwg/.dxf with or without database attribute linkages) or MicroStation V8 design files (without attribute linkages) as a GeoMedia Professional data source.

  **NOTE** To use the Define CAD Server Schema File utility, you must have clear and complete understanding of your CAD data.

- You can specify a .ini file in the .csd file that allows for persistent caching. Persistent caching is done in CAD data server to improve server performance. To use the Define CAD Server Schema File utility, you must have clear and complete understanding of your CAD data.

To use the Define CAD Server Schema File utility, you must have clear and complete understanding of your CAD data.

See the “Creating Data Server .INI Files” section.

See the Define CAD Server Schema File utility section for complete information about this utility.

**Supported MicroStation Element Types**

The following table lists the MicroStation element types supported by GeoMedia Objects:

<table>
<thead>
<tr>
<th>Type</th>
<th>Name</th>
<th>GDO Geometry Type</th>
</tr>
</thead>
<tbody>
<tr>
<td>2</td>
<td>Cell (named)</td>
<td>OrientedPointGeometry, TextPointGeometry, and Collection Geometry. This is served based on the .ini file variables.</td>
</tr>
<tr>
<td>2</td>
<td>Cell (orphaned)</td>
<td>BoundaryPolygonGeometry</td>
</tr>
<tr>
<td>2</td>
<td>Cell (unnamed)</td>
<td>BoundaryPolygonGeometry</td>
</tr>
<tr>
<td>3</td>
<td>Line</td>
<td>PolylineGeometry and OrientedPointGeometry. In case of degenerate lines, OrientedPointGeometry is served.</td>
</tr>
<tr>
<td>4</td>
<td>LineString</td>
<td>PolylineGeometry</td>
</tr>
<tr>
<td>6</td>
<td>Shape</td>
<td>PolygonGeometry</td>
</tr>
<tr>
<td>7</td>
<td>TextNode</td>
<td>TextPointGeometry (collection)</td>
</tr>
<tr>
<td>Type</td>
<td>Name</td>
<td>GDO Geometry Type</td>
</tr>
<tr>
<td>------</td>
<td>-----------------</td>
<td>-----------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>11</td>
<td>Curve</td>
<td>Stroked PolylineGeometry</td>
</tr>
<tr>
<td>12</td>
<td>Complex String</td>
<td>CompositePolylineGeometry</td>
</tr>
<tr>
<td>14</td>
<td>Complex Shape</td>
<td>CompositePolygonGeometry</td>
</tr>
<tr>
<td>15</td>
<td>Ellipse</td>
<td>PolygonGeometry</td>
</tr>
<tr>
<td>17</td>
<td>Text</td>
<td>TextPointGeometry</td>
</tr>
<tr>
<td>22</td>
<td>Point</td>
<td>OrientedPointGeometry (collection)</td>
</tr>
<tr>
<td>35</td>
<td>Shared Cell</td>
<td>OrientedPointGeometry, TextPointGeometry, and CollectionGeometry. This is served based on the .ini file variables.</td>
</tr>
</tbody>
</table>

**Connecting to a FRAMME Warehouse**

FRAMME format is not supported in ERDAS IMAGINE.
Connecting to a GeoGraphics Warehouse

GeoGraphics format is not supported in ERDAS IMAGINE.

Connecting to a GML Warehouse

To connect to a GML (Geography Markup Language) Server warehouse, you must indicate the following:

- GML file, the .gml / .xml filename with its full path or address. The file can be a file on the disk or an URL of a .gml file on the Web.

- Advanced options:
  - When the GeoReferenceService (GRS) fails to return the coordinate system (CS) object for a given EPSG code and a matching coordinate system file is not found for a feature class in the default \EPSG folder, the options are:
    - Ignore the coordinate system, that is, serve the feature class data without the coordinate system.
    - Skip the feature class.
    - Abort the connection and report an error about the missing coordinate system file.
  - When the GeoReferenceService (GRS) fails to return the coordinate system (CS) object for a given EPSG code and a matching coordinate system file is not found for a feature instance in the default \EPSG folder, the options are:
    - Serve with the coordinate system of the feature class, that is, serve the feature instance data with the coordinate system of the feature class.
    - Skip the feature instance.
    - Serve only the attributes of feature instance data, that is, the geometry is made NULL.
    - Abort the query and report an error about the missing coordinate system file for the feature instance.
    - Swap the coordinate order for the following coordinate system types: Geographic and Projected.

Connecting to an I/CAD MAP Warehouse

You can connect to an I/CAD MAP warehouse through the New Connection dialog box.
Connecting through the New Connection Command

To connect to an I/CAD MAP warehouse, you specify the following parameters on the New Connection dialog box:

- I/CAD MAP file, required
- Coordinate system file, recommended but not required
- An optional warehouse configuration file (.ini) to provide parameters like geometry types for feature classes, linkage information for the feature classes, and the rich text parameters required to serve text.
Connecting to a KML Warehouse

To connect to a KML (Keyhole Markup Language) Server warehouse, you must indicate the following:

- KML connection name and optional description.
- KML file. Type or browse for the KML or KMZ (zipped KML files) file path and name.
- Warehouse configuration file (optional). Type or browse for the .ini file that may contain the parameters required for the configuration of geometry types for feature classes.

See the “Creating Data Server .INI Files” section.

Connecting to a MapInfo Warehouse

To connect to a MapInfo warehouse, you must specify the folder location of the MapInfo files, the MapInfo Tables folder with valid MapInfo tables (.tab or .txt files). The server can then read the MapInfo tables in the folder and create the feature classes. Before trying to connect, check the following:

- A coordinate-system file (.csf) for the MapInfo data must be created with Define Coordinate System File and be referenced by the .ini file. There can be one .csf file for the entire MapInfo dataset or one .csf file created for each MapInfo table.
- MapInfo data must be in native format (not exported). There should be a table file (.tab), an index file (.id), a map file (.map), and/or an info file (.dat/dbf or .xls). All four files are needed for both geometry and attribution.
- The coordinate-system file(s) for the MapInfo data should be identified in a <MapInfo Tables folder name>.ini file using the COORDINATE SYSTEM: .ini variable. If a <MapInfo Tables folder name >.ini file is not found in the MapInfo Tables folder, the server looks for a <MapInfo Tables folder name>.csf file in the MapInfo Tables folder.
- The software geometry type (point, linear, areal, graphicstext, or anyspatial) for each MapInfo Table can also be defined in the <MapInfo Tables folder name>.ini file using the GEOMETRY TYPE: variable. If there is no entry in the .ini file regarding geometry type for a coverage, the data are served up as AnySpatial.
- If the coverage has text in addition to a point, linear, or areal geometry, use the TEXT: variable in the <MapInfo Tables folder name>.ini file to enable the data server to serve up Text. The server will not display the Text Geometry for a coverage if this is not enabled in the <MapInfo Tables folder name>.ini file.
Preparing to Connect

- The COORDINATE SYSTEM: section should be the first section in the <MapInfo Tables folder name>.ini file. The other sections may or may not be present. If they are present, they may be in any order.

*See the “Displaying Data That Has No Coordinate System Specified” section and the “Creating Data Server .INI Files” section.*
Connecting to an MGE or MGDM Warehouse

MGE and MGDM formats are not supported in ERDAS IMAGINE.

Connecting to an MGSM Warehouse

MGSM format is not supported in ERDAS IMAGINE.

Connecting to an ODBC Tabular Warehouse

ODBC Tabular format is not supported in ERDAS IMAGINE.

Connecting to an Oracle Object Model Warehouse

Before you try to connect to an Oracle Object Model warehouse, you must have already set up an Oracle database server with Oracle's Spatial Cartridge and added a user account containing object model data that you want to access.

At a minimum, the Oracle Client software must reside on the system running the software, and you must create a database alias/service. Use the Oracle Net 8 configuration utility to configure a database alias/service.

See the Oracle documentation for more information.

To connect to Oracle Object Model data, you will need to identify the following:

- Oracle connection name.
- Whether to use Windows to authenticate the network login ID or to use Oracle database to authenticate the user ID and password.
- User name.
- Password.
- Host string. The host string is the Oracle database alias/service name that you create with the Oracle network configuration utility.

Oracle Read-write Data Server

- Available in GeoMedia Professional.
- Oracle Read-write Data Server can be purchased separately.
- Not certified in ERDAS IMAGINE environment.
Connecting to a SQL Server Warehouse

Before you try to connect to a SQL Server warehouse, you must set up a SQL Server database.

To connect to SQL Server data, you will need to indicate the following:

- SQL connection name.
- Server name.
- SQL Server database name.
- Whether to use Windows to authenticate the network login ID or to use SQL Server to authenticate the user ID and password.
- Login.
- Password.

SQL Read-write Data Server

- Available in GeoMedia Professional.
- SQL Read-write Data Server can be purchased separately.
- Not certified in ERDAS IMAGINE environment.

Connecting to a SQL Server Spatial Warehouse

Before you try to connect to a SQL Server Spatial warehouse, you must set up a SQL Server Spatial database.

To connect to SQL Server Spatial data, you will need to indicate the following:

- SQL connection name.
- Server name.
- SQL Server database name.
- Whether to use Windows to authenticate the network login ID (the default) or to use SQL Server Spatial to authenticate the user ID and password.

If the SQL Server connection is set to use Windows authentication, your domain login account will need to be added to SQL Server by a database administrator and appropriate privileges will need to be granted on the databases you want to access. On connection, you will only need to supply the server name and the database name.
If you are using SQL Server authentication, you will need to have a valid SQL Server user account and password as well as the appropriate privileges on the database you want to connect to.

- Login.
- Password.

**SQL Read-write Data Server**

- Available in GeoMedia Professional.
- SQL Read-write Data Server can be purchased separately.
- Not certified in ERDAS IMAGINE environment.

**Connecting to a SmartStore Server Warehouse**

GeoMedia SmartStore format is not supported in ERDAS IMAGINE.
Connecting to a Text File Server Warehouse

To connect to Text File Server data, you will need to indicate the following:

- Input data text file, which can be any ASCII file.
- Text format definition file (.tfd)
- Coordinate system file (.csf) - optional

Connecting to the Text File Server is a two-step process. You must first define the format of the input data file so that the server can understand it. The Define Text File Server Format File utility lets you perform this definition. Then you perform the actual connection with the New Connection command, using the format definition file as input, in addition to the input data file, and an optional coordinate system file.

See the Define Text File Server Format File utility section for complete information.

Connecting to a WCS Warehouse

To connect to a WCS (Web Coverage Server) warehouse, you must indicate the following:

- WCS connection name and optional description.
- Web Coverage Server (WCS) URL
  - Type the WCS URL in the format http://host[:port]/path?{name=value}&. If the name-value parameters are specified, the request type should be 'GetCapabilities', and the REQUEST parameter should be specified only as "REQUEST=GetCapabilities".
  - Example formats are:
    http://host[:port]/path, OR
    http://host[:port]/path?REQUEST=GetCapabilities&SERVICE=WCS&VERSION=1.0.0
  - Example URL: http://lapserv/CoverageWebService/coverage.aspx
  - If you do not specify a version parameter, the data server issues the request with version 1.0.0. If the WCS does not support this version, then the connection fails and an error is presented as: "Version negotiation failed. The WCS does not support the versions supported by the data server (1.0.0)."
- Warehouse configuration (.ini) file (optional)
- Advanced options:
Preparing to Connect

If no matching coordinate system is found for a feature class (coverage), select one of the following options that give the connect command instruction for cases where no matching coordinate system is found for a feature class:

- Ignore coordinate system
  
  If the software cannot automatically translate the given EPSG code into a coordinate system definition and if a matching coordinate system file is not found in the default \Program\EPSG folder, the feature class will be served without a coordinate system.

- Skip feature class
  
  If the software cannot automatically translate the given EPSG code into a coordinate system definition and if a matching coordinate system file is not found in the default \Program\EPSG folder, the feature class is not shown (that is, no tabledef is created by the data server for this feature class).

- Abort connection and report error
  
  If the software cannot automatically translate the given EPSG code into a coordinate system definition and if a matching coordinate system file is not found in the default \Program\EPSG folder, an error is displayed that indicates the location and name of the missing coordinate system file. Also, the connection fails.

The ..\Common Files\Intergraph\CoordSystems\Program\EPSG folder is designated to be the default folder for coordinate system files (CSF).

Connecting to a WFS Server Warehouse

Before you try to connect to a WFS (Web Feature Server) warehouse, you indicate the following:

- WFS connection name and optional description
- Web Feature Server (WFS) URL
  
  Type the WFS URL in the format http://host[:port]/path?{name=value}&. If the name-value parameters are specified, the request type should be 'GetCapabilities', and the REQUEST parameter should be specified only as "REQUEST=GetCapabilities". Example formats are:
  
  http://host[:port]/path, OR
  
  http://host[:port]/path?REQUEST=GetCapabilities&SERVICE=WFS&VERSION=(1.1.0/1.0 .0/0.0.14/0.0.13)
- Example URL: http://lapserv/ManipulateFeatureService/request.aspx
- If you do not specify a version parameter, version negotiation takes place between the WFS and the data server for a mutually agreeable version. If the WFS does not support any of the versions supported by the data server (1.1.0/1.0.0/0.0.14/0.0.13), an error is presented as: "WFS does not support the versions supported by the data server (1.1.0/1.0.0/0.0.14/0.0.13)."
- Warehouse configuration (.ini) file (optional)
- Advanced options:
  - When a matching coordinate system file is not found for a feature class in the default $\text{EPSG}$ folder, the options are:
    - Ignore the coordinate system, that is, serve the feature class data without coordinate system.
    - Skip the feature class.
    - Abort the connection and report an error about the missing coordinate system file.
  - Swap the coordinate order for the following coordinate system types: Geographic and Projected.

**WFS Read-write Data Server**

- WFS Read-write is supported in IMAGINE. However, to write to an Oracle or SQL Server WFS server, an additional module is required (Oracle Read-write Data Server or SQL Read-write Data Server).
- These modules are included with GeoMedia Professional. Therefore, if GeoMedia Professional is also installed on the same computer, IMAGINE will be able to utilize the modules.
- These modules are also available by separate purchase for GeoMedia. In situations where this has been done IMAGINE will be able to utilize them as well.
- Oracle or SQL Server WFS server is not certified in ERDAS IMAGINE environment.
Connecting to a WMS Warehouse

Before you try to connect to a WMS (WebMap Server) warehouse, you need to indicate the following:

- WMS connection name and optional description
- Web Map Server (WMS) URL
  - Type the WMS URL in the format http://host[:port]/path?{name=value}&. If the name-value parameters are specified, the request type should 'GetCapabilities', and the REQUEST parameter should be specified only as "REQUEST=GetCapabilities". For WMS 1.1.0, 1.1.1 and 1.3.0, "SERVICE=WMS" parameter is mandatory. Example formats are:
    - http://host[:port]/path, OR
    - http://host[:port]/path?REQUEST=GetCapabilities&SERVICE=WMS&VERSION=(1.3.0/1.1.1/1.1.0/1.0.0)
  - Example URL: http://lapserv/GenerateMapService/request.aspx
  - If you do not specify a version parameter, version negotiation takes place between the WMS and the data server for a mutually agreeable version. If the WMS does not support any of the versions supported by the data server (1.3.0/1.1.1/1.1.0/1.0.0), an error is presented as: "WMS does not support the versions supported by the data server (1.3.0/1.1.1/1.1.0/1.0.0)."
- Warehouse configuration (.ini) file (optional)
- Advanced options:
  - When the GeoReferenceService (GRS) fails to return a coordinate system (CS) object for a given EPSG code and a matching coordinate system file is not found for a feature class in the default \EPSG folder, the options are:
    - Skip feature class.
    - Abort the connection and report an error about the missing coordinate system file.
  - In the case of secured sites, you can type the user name and password.
  - You can choose the file format from the drop-down list that has two items – image/png and image/jpeg. If you do not make a selection, the format defaults to image/png.
SECTION 2

Using Oracle Connections

ERDAS IMAGINE provides an Oracle Object Model data server that facilitates connections to Oracle-based warehouses. This allows ERDAS IMAGINE to access both Oracle simple data types and Oracle location-based data using the SDO_GEOMETRY data type. There are two variations of the Oracle Object Model Data Server, a read-only data server and a read-write data server. These are accessed through the New Connection command. This appendix applies to both variations.

Oracle Read-write Data Server

- Oracle Read-write Data Server can be purchased separately.
- Not certified in ERDAS IMAGINE environment.

Delivery and Connection

Read-Only Connections

To make a read-only connection to an Oracle warehouse, you must provide a valid Oracle connection string, which usually consists of an Oracle username, password, and net service name. Net service names are created using Oracle’s Net Configuration Assistant and reflect the database you are trying to connect to (the information is stored in the tnsnames.ora file. You can also connect using Oracle’s EZConnect format; server:port/sid. For example, the connection string for the Oracle sid ORCL located on server DBSERVER would be DBSERVER:1521/ORCL.

Read-only connections rely completely on Oracle’s native data model; no specific GeoMedia metadata information is required. There will be limits on what IMAGINE can interpret from existing spatial data, but metadata itself is not a requirement for display. In fact, you can use the Oracle Object Model data server to view and to use any tables within the IMAGINE environment as long as the connection is read-only.

Read-Write Connections

NOTE: Oracle read-write data server is not certified in ERDAS IMAGINE environment.
Domain Authentication

Connections to Oracle based schemas can utilize either Oracle authentication (the default mode) or Windows domain authentication. To use Windows domain authentication, you need to first set some Oracle configuration parameters.

In the SPFILE or the initialization file, INIT.ORA, you need to set the following:

- `REMOTE_OS_AUTHENT=TRUE`
  this enables remote authentication in the instance.

- `OS_AUTHENT_PREFIX=<auth_prefix>`
  this sets the prefix Oracle will use for domain authenticated user names. IMAGINE does not support the default prefix OPS$. You will need to choose a prefix that does not contain the $ character. Any prefix will work, but the only special character allowed is the underbar (_).

  For example:
  ```
  REMOTE_OS_AUTHENT=TRUE
  OS_AUTHENT_PREFIX="DA_
  ```

  You may need to restart the database instance after setting these values.

Create your user account in Oracle using the `OS_AUTHENT_PREFIX`, and specify `External Authentication` for the password. For example, if your domain account is JSMITH, your Oracle user name is DA_JSMITH. As with normal Oracle user accounts, you need to assign the appropriate roles and privileges to this user, typically connect and resource, but that is up to the Database Administrator (DBA). To connect in IMAGINE, set the connection option to User Windows authentication, and enter the database service name.

If your domain authenticated username contains any special characters (such as / or -), you can still use it to connect, but it will not be able to own any database objects. IMAGINE uses an OWNER.TABLE syntax when working with tables/views and special characters will cause this to fail.
Native Queries

Native query operations are not supported in ERDAS IMAGINE.
SECTION 3

Using SQL Server Connections

IMAGINE provides a SQL Server data server that facilitates connections to Microsoft’s Sequel Server (SQL Server) databases. This allows IMAGINE applications to use SQL Server databases as geospatial warehouses. The SQL Data Server is delivered as a read-only data server. This can be accessed through the New Connection command.

SQL Read-write Data Server

- SQL Read-write Data Server can be purchased separately.
- Not certified in ERDAS IMAGINE environment

Delivery and Connection

Prerequisites

SQL Server connections do not require client software. The SQL Server data server will be installed whether SQL Server is present or not. Connections can be made to SQL Server installations that are configured as case-sensitive or case-insensitive. Both Windows authentication and SQL Server authentication are supported for user accounts. A SQL Server database must already exist and must have the required metadata tables before a SQL Server Read-Write or Read-Only connection can be made. The SQL Server data server is built on OLEDB and must have the latest version installed. This is automatically done for you if you are using Windows XP or later.

Connections

IMAGINE applications require specific metadata tables to exist in the SQL Server database before connection.

To make a connection to SQL Server, provide a valid server name, and then a valid username and password. Any databases the specified user has privilege to see will appear in the drop down database list. SQL Server has two modes for validating users: Windows domain authentication and SQL Server authentication.

If the SQL Server connection is set to use Windows authentication (the default), your domain login account will need to be added to SQL Server by a database administrator and appropriate
privileges will need to be granted on the databases you want to access. On connection, you will only need to supply the server name and the database name.

If you are using SQL Server authentication, you will need to have a valid SQL Server user account and password as well as the appropriate privileges on the database you want to connect to.
Displaying Data That Has No Coordinate System Specified

To be displayed accurately in a GeoWorkspace, all data must specify a coordinate system. ArcInfo, Arc/View, MapInfo data, and some CAD and raster data do not specify coordinate systems. To accommodate data with no specified coordinate system, you first define a coordinate-system file (.csf) outside of the software.

**To define a coordinate-system file:**

1. Click Manage Data tab > GeoMedia Tools > GeoMedia Utilities > Coordinate System File Utility.
2. On the General tab of the Define Coordinate System File dialog box, select the base storage type—Geographic, Projection, or Geocentric—of the coordinate-system that is to be saved to the file.
3. Optional: To change the storage units and storage center, select the Storage Space tab.

   **NOTE:** Changing the coordinate system type from Projection or Geocentric to Geographic resets the horizontal storage unit to 1 degree and the vertical storage unit to 1 meter. Changing the coordinate system type from Geographic or Geocentric to Projection resets the horizontal and vertical storage units to 1 meter. Changing the coordinate system type from Projection or Geographic to Geocentric resets the geocentric storage unit to 1 meter. Each of these changes resets the storage center to (0,0,0).
4. For projected coordinate systems only: On the Projection Space tab, select a projection algorithm from the Projection algorithm drop-down list.
5. Optional: To change parameters, click Projection Parameters. Depending on the projection algorithm selected, some text boxes may be read-only.
6. On the Geographic Space tab, select the geodetic datum from the Geodetic datum drop-down list.
7. Optional: If you select a user-defined (non-standard) geodetic datum, you can change the ellipsoid on the Geographic Space tab; and if you select a user-defined (non-standard) ellipsoid, you can change ellipsoid parameters as well.
8. On the Geographic Space tab, select the vertical datum from the Vertical datum drop-down list, which contains all of the standard (pre-defined) vertical datums available on the system.
NOTE Changing the coordinate system type from Projection or Geographic to Geocentric resets the vertical datum to Ellipsoid (geometric).

9. Optional: On the General tab, type values in the coordinate system Name and Description fields.
   These will be saved in the .csf file. Many data servers that use .csf files will use these values as the name and description exposed for a coordinate system, which may, for example, be seen during Review of feature properties within the Feature Class Definition command.

10. On the Define Coordinate System File dialog box, click Save As.

11. On the Save Coordinate System File As dialog box, select the drive and folder where you want to save the coordinate-system file. If you do not select a path, the coordinate-system file will be saved in the root folder of your active drive.
    Select one of the following locations:
    - The folder containing the specific warehouse for which the coordinate-system file defines coordinate data. This is the preferred location.
    - The folder where the warehouses are stored.

12. In the File name text box, type the name that you want to give to the coordinate-system file.

13. Verify that the Save as type is set to Coordinate System File (*.csf).

14. Click Save.

To display ArcInfo data:
(.csf) You identify the coordinate-system file for the ArcInfo data by creating a <workspace>.ini file, where <workspace> is the name of the ArcInfo GeoWorkspace data folder. Within this file, you specify the coordinate-system file to be used. You may place the <workspace>.ini file in the ArcInfo GeoWorkspace folder.
See the “Creating Data Server .INI Files” topic.

To display ArcView data:
You identify the coordinate-system file for the ArcView data by creating a <workspace>.ini file, where <workspace> is the name of the ArcView GeoWorkspace data folder. Within this file, you specify the coordinate-system file (.csf) to be used. You may place the <workspace>.ini file in the ArcView GeoWorkspace folder.
Displaying Data That Has No Coordinate System Specified

See the “Creating Data Server .INI Files” topic.

To display CAD-server data:
For CAD-server data, perform the following:

- Specify the coordinate-system file(s) in the CAD schema definition (.csd) file.
- While creating the .csd file on the Files tab of the CAD Server Definition dialog box, select all the coordinate-system files to be used, and specify the coordinate-system file on the Coordinate Systems tab.
- For the IGDS Scanner, you can use either a .dgn file (with a type-56 element) or a .csf file (created by Define Coordinate System File) to specify the coordinate-system information.
- For the AutoCAD Scanner, you can use only a .csf file (created by Define Coordinate System File) to specify the coordinate-system information.

To display FRAMME data:
FRAMME format is not supported in ERDAS IMAGINE.

To display MapInfo data:
You identify the coordinate-system file for the MapInfo data by creating a <workspace>.ini file, where <workspace> is the name of the MapInfo GeoWorkspace folder. Within this file, you specify the coordinate-system file (.csf) to be used. You may place the <workspace>.ini file in the MapInfo GeoWorkspace folder.

If there is no .ini file, the data server will look for a .csf file in the MapInfo GeoWorkspace folder that bears the same name as the MapInfo table and use that .csf file for the corresponding GeoMedia Professional feature class. This way, you need one .csf file for one feature class in the GeoWorkspace folder. You cannot use a single .csf file for the whole folder unless you specify it in the .ini file.

See the “Creating Data Server .INI Files” topic.

To edit a coordinate-system file:
To edit an existing .csf file, double click the file name. This opens the Define Coordinate System File dialog box. Make changes to the file, and click OK.
Creating Data Server .INI Files

Your ARC/INFO, ArcView, MapInfo, CAD, and I/CAD MAP data may require you to create an .ini file to perform certain tasks more efficiently or to customize the way the software handles your data. The .ini file allows you to specify additional parameters that the data server may need in order to process your data. An .ini file is necessary in most cases when you are using the ARC/INFO, ArcView, MapInfo, data servers.

The .ini file is an ASCII file that you can create with a text editor, such as Notepad. You can also use the Define Warehouse Configuration File utility to help you create an .ini file and set .ini file variables (keywords). The Define Warehouse Configuration File utility guides you through creating or validating an .ini file. This utility has self-documenting .ini variables to help you determine which entries or keywords are needed in the .ini file. Follow the simple instructions on the dialog boxes for creating or validating .ini files.

Unless you are only working with one project, you should place your .ini files in each of your project directories. This is the best way to ensure that the software uses the correct .ini file for each project. For example, if the CAD project folder is C:\prj\test, then the project_name.ini file would be located at C:\prj\test\project_name.ini.

The software looks for .ini files in the project folder. It is recommended that you place the .ini file in the project folder.

The ARC/INFO Data Server .INI File

For ARC/INFO data to align properly with other data in a GeoWorkspace (the GeoMedia product .gws file), the ARC/INFO data server must be able to locate a coordinate system. Coverages in an ARC/INFO workspace (the ARC/INFO project folder) can have different coordinate systems, or the entire ARC/INFO workspace can have a single coordinate system. Thus, it is necessary to address specifying the coordinate system for both cases.

You can specify a coordinate-system file for the ARC/INFO data by creating an <ARC/INFO workspace folder name>.ini file, where <ARC/INFO workspace name> is the name of the ARC/INFO workspace data folder specified in the connection. Within this file, you specify the coordinate-system file (.csf) to be used. Place the <ARC/INFO workspace folder name>.ini file in the ARC/INFO project folder.
The ARC/INFO data server looks in the workspace folder for the `<Workspace folder name>.ini` file.

**CHARACTER SET**

The **CHARACTER SET**: keyword lets you specify the character set of the incoming ARC/INFO data in order to serve the Chinese CNS (Chinese National Standard) character set. The server can assume the default encoding scheme of the specified character set for further processing of the data. For example, CNS 11643 characters are usually encoded by the EUC (Extended UNIX Coding) encoding scheme. This `.ini` variable will be used as follows:

- If language ID = Traditional Chinese
  - If INI variable CHARACTER SET = CNS 11643
  - Call the function that does the translation to local code page Big5
- Else
  - Use the default Value Big5

**Syntax:**

```
CHARACTER SET:<Name of the character set>
```

Default Value: Big5

**Example:**

```
CHARACTER SET:CNS 11643
```

**COORDINATE SYSTEM (ARC/INFO)**

The ARC/INFO data server can read a `.csf` file output from the Define Coordinate System File (`DefCSF.exe`) executable that is delivered with IMAGINE. The data server looks initially at the `<ARC/INFO workspace folder name>.ini` file to determine the `.csf` file to be used for each ARC/INFO coverage or for the entire ARC/INFO workspace. The format of the `.ini` file for each case is as follows:
Syntax:

COORDINATE SYSTEM:
<coverage1> = <full path and filename of the .csf file>
<coverage2> = <full path and filename of the .csf file>
OR
COORDINATE SYSTEM:
<ARC/INFO workspace name> = <full path and filename of the .csf file>

If an <ARC/INFO workspace folder name>.ini file is not found, the ARC/INFO data server looks for a .csf file in each coverage folder. If a coverage folder contains more than one .csf file, the data server uses the first .csf file that it finds.

Example:
COORDINATE SYSTEM:
roads=C:\madison\roads\roads.csf

LEVEL COLUMN ALIAS: and SYMBOL COLUMN ALIAS:

The LEVEL COLUMN ALIAS: and SYMBOL COLUMN ALIAS: keywords let you override the default names of LEVEL and SYMBOL GFields of the TXT annotation feature class. The ARC/INFO data server first looks for entries in the .ini file and if found, it uses the alias; otherwise, it defaults to the names as described in the next paragraphs. The ARC/INFO server validates these field names specified through INI keys for GDO standards before exposing them.

For both TXT and TAT annotation, three feature classes are created – one each for text features, leader line features, and leader line terminators.

TXT annotation – For TXT annotation feature classes, GFields are populated with three attributes ID, LEVEL and SYMBOL. All three attributes are of type gdbLong, and the ‘ID’ field is set as the primary key field. The names of LEVEL and SYMBOL fields can be overridden in the INI file. Two new INI keys are added for this purpose. For both leader line and leader line terminator feature classes, the ‘ID’ field, which is carried over from the TXT annotation feature class, is set as the primary key field.
TAT annotation – For TAT annotation feature classes, GFields are populated with attributes read from the annotation table. The ‘<Text file name>_’ field is the primary key field. For both leader line and leader line terminator feature classes, the ‘<Text file name>_’ field, which is carried over from the TAT annotation feature class, is set as the primary key field.

For a given TXT or TAT annotation, the primary key field for the associated leader line and leader line terminator instances are assigned the same value as the text feature instance.

The format of the .ini file is as follows:

Syntax:
LEVEL COLUMN ALIAS:<Alias name for level field of TXT annotation>

Example:
LEVEL COLUMN ALIAS:Layer

Syntax:
SYMBOL COLUMN ALIAS:<Alias name for symbol field of TXT annotation>

Example:
SYMBOL COLUMN ALIAS:Layer
The ArcView Data Server .INI File

The topics in this section describe the ArcView Data Server .ini file options.

The ArcView Data Server .INI File

In order for ArcView data to align properly with other data, it must expose a coordinate system. Coverages of an ArcView workspace can have different coordinate systems, or the entire ArcView workspace can have a single coordinate system. Thus, it is necessary to address specifying the coordinate system for both these cases.

COORDINATE SYSTEM (ArcView)

The ArcView data server will be able to read a .csf file output from the Define Coordinate Systems executable delivered with the product. The data server looks initially at the <ArcView workspace folder name>.ini file to determine the name of the .csf file to be used for each ArcView theme.

Syntax:
COORDINATE SYSTEM:
<coverage1> = <full path and filename of the .csf file>
<coverage2> = <full path and filename of the .csf file>
(For separate coordinate systems for each coverage.)
OR
COORDINATE SYSTEM:
<ArcView workspace name>=<full path and filename of the .csf file>
(For one coordinate system for all coverages.)
If an <ArcView workspace name>.ini file is not found, the server will look for a <coverage>.csf file in the workspace directory.
In the case of the workspace directory having multiple coverages and some of the coverages not having a `.csf` file, the server will populate the coordinate system information only for those coverages having a `.csf` file.

If there are no `.csf` or `.ini` files, the server will not populate the coordinate system information.

**Example:**

**COORDINATE SYSTEM:**

```
roads=C:\madison\roads\roads.csf
```

**NOTE**  The ArcView shapefile data server looks for the `<ArcView workspace folder name>.ini` file in the workspace folder.

For IMAGINE, the server will look for a `<theme name>.csf` file in the workspace folder.

For IMAGINE only:

- For a workspace folder having multiple themes and some of the themes not having a `.csf` file, the server will populate coordinate-system information only for the themes having a `.csf` file.
- If there are no `.csf` and `.ini` files, the server will not populate the coordinate-system information in the `GCoordinateSystem` table.

**MEASURE COLUMN ALIAS:, MINIMUM MEASURE COLUMN ALIAS:, AND MAXIMUM MEASURE COLUMN ALIAS**

**MEASURE COLUMN ALIAS:, MINIMUM MEASURE COLUMN ALIAS:, and MAXIMUM MEASURE COLUMN ALIAS:** keywords let you override the default names of measure GFields created by the server for measured and 3-D shape types. The default values of **MEASURE COLUMN ALIAS:** keyword is Measure, **MINIMUM MEASURE COLUMN ALIAS:** keyword is MeasureMin, and **MAXIMUM MEASURE COLUMN ALIAS:** keyword is MeasureMax. The ArcView data server first looks for entries in the INI file and, if found, the alias is used. Otherwise, the default names are used. ArcView server validates the field names specified through INI keys for GDO standards before exposing them.

**Syntax:**

`MEASURE COLUMN ALIAS:<Alias name for measure field>`
MINIMUM MEASURE COLUMN ALIAS:<Alias name for MeasureMin field>
MAXIMUM MEASURE COLUMN ALIAS:<Alias name for MeasureMax field>

Example:
MEASURE COLUMN ALIAS:Distance
MINIMUM MEASURE COLUMN ALIAS:FromMeasure
MAXIMUM MEASURE COLUMN ALIAS:ToMeasure.
TEXT ENCODING

The **TEXT ENCODING** keyword allows you to specify the text encoding of the source data. The value of `<text encoding>` must be set to any one of the following:

- ANSI
- UTF-8
- UTF-16
- UTF-16BE

The default value is ANSI, in the absence of an INI key/INI file or invalid value.

**Syntax:**

```
TEXT ENCODING:
<theme1> = <text encoding>
<theme2> = <text encoding>
```

The option in the INI file for “all themes” is as follows:

```
TEXT ENCODING:
<AV Workspace name>=<text encoding>
```

**Example:**

```
TEXT ENCODING:
Cities=ANSI
States=UTF-8
Rivers=UTF-16
Interstates=UTF-16BE
```

When the same encoding is applicable to all themes under the `/USSampleData` folder:

```
TEXT ENCODING:
USSampleData=UTF-8
```
SERVE NUMERIC WIDTH AS INTEGER:, SERVE NUMERIC WIDTH AS LONG:, and SERVE NUMERIC WIDTH AS SINGLE

The **SERVE NUMERIC WIDTH AS INTEGER:, SERVE NUMERIC WIDTH AS LONG:,** and **SERVE NUMERIC WIDTH AS SINGLE** keywords let you override the default Native-GDO Type field mapping. As according to default mapping, the Numeric dBASE type having field width less than 10 with zero (0) decimal places will be served as gdbLong. Otherwise, it will be served as gdbDouble. To force serving of a numeric field up to a certain width as gdbInteger, gdbLong, or gdbSingle, the INI variables **SERVE NUMERIC WIDTH AS INTEGER, SERVE NUMERIC WIDTH AS LONG, and SERVE NUMERIC WIDTH AS SINGLE** are supported. According to default mapping, the Float dBASE type will be served as gdbDouble. The **SERVE NUMERIC WIDTH AS SINGLE:** keyword is also applicable to force serving of the float field with zero or more decimal places up to a certain width as gdbSingle. Presence of these INI variables will override the default Native-GDO Type field mapping. The default value for the **SERVE NUMERIC WIDTH AS LONG** keyword is 10.

**Syntax:**

SERVE NUMERIC WIDTH AS INTEGER:<Number of characters width>
SERVE NUMERIC WIDTH AS LONG:<Number of characters width>
SERVE NUMERIC WIDTH AS SINGLE:<Number of characters width>

**Example:**

SERVE NUMERIC WIDTH AS INTEGER:6
SERVE NUMERIC WIDTH AS LONG:11
SERVE NUMERIC WIDTH AS SINGLE:20

---

The CAD Data Server .INI File

The topics in this section describe the CAD Data Server .ini file options.
The CAD Data Server .INI File

The CAD data server allows you to use a .ini file to control the manner in which it processes your CAD data. Unlike the other data servers, the CAD data server refers to the .ini file as the scanner .ini file. You specify the name and location of the scanner .ini file using the Define CAD Server Schema File utility.

See the Define CAD Server Schema File online Help for additional information about the scanner .ini file.

The scanner .ini file allows you to specify that the CAD server is to use persistent caching, which can improve system performance. Persistent caching can increase the speed of feature display, by eliminating the multiple scanning of map files. This is achieved by storing the scanned information in a cache file. The CAD server caches geometry locations in a temporary Access database file. By default, this database file is deleted when you close the CAD connection. However, you can use a scanner .ini file to specify that the CAD server is to keep this geometry cache file for subsequent use. If you want to conserve disk space, multiple users of the same data set can share the same cache file. If you do not specify a scanner .ini file, the software uses the normal temporary cache file.
General Keywords

The following are the keywords that you can use in the scanner .ini file: CACHE FILE:, CACHE UPTODATE:, and LOCK TIMEOUT THRESHOLD:

CACHE FILE

This keyword specifies the cache file name, with or without the path. The default cache directory is the directory containing the CAD server schema (.csd) file. The default file extension for the cache file is .csc.

Syntax:
CACHE FILE: <cache file name>

Example:
CACHE FILE: CADcache.csc

CACHE UPTODATE

This keyword specifies whether the cache file is to be treated by the software as if it was always current. If set to TRUE, the software will not do date comparisons between the data in the cache file and the original design files. However, the software will continue to perform incremental cache updates for missing files if necessary. Setting this keyword to TRUE can improve performance for those situations where the original data is static and not subject to change. The default value is FALSE, which means that the software will always do date comparisons and update the cache to reflect changes in the original design files.

Syntax:
CACHE UPTODATE: <TRUE|FALSE|T|F>

Example:
CACHE UPTODATE: TRUE
LOCK TIMEOUT THRESHOLD

This keyword specifies a timeout value for locks. The CAD data server uses a lock column to control multiple access to the cache file. The lock is set before the software performs date comparisons and updates, and then released when this process is completed. You can use the LOCK TIMEOUT THRESHOLD: keyword to handle the case where there is an abnormal termination of processing that results in locks being left uncleared. If the timeout value is exceeded, the software will issue an error message and you will be able to either discard the current cache file, or manually clear the locks that have been set in the mapinfo table. You should set the LOCK TIMEOUT THRESHOLD: to a reasonable value that is based on the size of the design files. The value should be long enough to allow for normal scanning and updates to the cache file, but short enough to notify you within a reasonable amount of time that a locking error has occurred. The default value is 60 seconds.

Syntax:
LOCK TIMEOUT THRESHOLD: <timeout value in seconds>

Example:
LOCK TIMEOUT THRESHOLD: 90

IGDS Keywords

The following .ini keywords apply only to the IGDS scanner: GRAPHICSTEXTSTRING DELIMITER: and FORCE TEXT JUSTIFICATION:.

GRAPHICSTEXTSTRING DELIMITER

In the IGDS scanner, the value of a CAD text string is exposed as an attribute in IMAGINE. This attribute can then be used within IMAGINE for subsequent analytic and data integration purposes.
To handle text nodes and collections of text and/or text nodes, the software concatenates all of the text strings with a special syntax to delimit them as in:

<string 1>;<string 2>;....

The default delimiter is a semicolon (;), but you can override the delimiter in the .ini file for the scanner to ensure there is no conflict with the data.

**Syntax:**

GRAPHICSTEXTSTRING DELIMITER: #

The pound sign (#) is the string to be used as the delimiter. Multiple characters may be used for the delimiter.

**FORCE TEXT JUSTIFICATION (CAD)**

There are cases in which the exact position of IGDS text cannot be accurately determined due to idiosyncrasies of its storage in design files and MicroStation font resource files. This is most common in instances in which there is center or right/top justified text.

The **FORCE TEXT JUSTIFICATION**: .ini keyword serves all IGDS text left-justified. It sets the alignment of each output TextPointGeometry to the designated setting, minimizing or limiting text positioning errors. By default, in absence of this .ini keyword, each IGDS text element is served with its actual justification.

While use of this .ini keyword does not preserve the original justification of the IGDS text, it does correctly position the text, assuming selection of a TrueType font for display that maps well to the font used in MicroStation.

**Syntax:**

FORCE TEXT JUSTIFICATION: LOWERLEFT/CENTERLEFT/UPPERLEFT
SERVE CELL ORIGIN, SERVER CELL GEOMETRY, and SERVE CELL TEXT Keywords

If a cell is to be expanded and it includes both geometry and text, then both of the latter two options should be set. However, cells that include just geometry, or just text, need not have the other geometry field present, unused, and populated with nulls.

In your .csd file, you must have defined the appropriate geometry types for receiving the various cell data. If you request the origin without providing a Point field, the geometry without providing an AnySpatial field, or the text without providing a GraphicsText field, then the .ini file variables are ignored.

Orphan cells will be served as boundary polygons irrespective of these keywords.

SERVE CELL ORIGIN

Do or do not serve the origin of the cell as an oriented point geometry. The default value is TRUE.

Syntax:
SERVE CELL ORIGIN: <TRUE|FALSE|T|F>

SERVE CELL GEOMETRY

Do or do not serve the spatial components of the cell as a collection of geometry. The default value is FALSE. If this option is TRUE, but a particular cell does not contain geometry or contains any unsupported elements, then a NULL geometry is served for that cell.

Syntax:
SERVE CELL ORIGIN: <TRUE|FALSE|T|F>
SERVE CELL GEOMETRY: <TRUE|FALSE|T|F>
SERVE CELL TEXT

Do or do not serve the text components of the cell as a collection of graphics text. The default value is FALSE. If this option is TRUE, but a particular cell does not contain text, then a NULL geometry is served for that cell.

Syntax:
SERVE CELL TEXT: <TRUE|FALSE|T|F>

TEXT ORIGIN BY RANGE

This keyword preserves the actual alignment of each output TextPointGeometry while calculating the position from the text element range. By default, in the absence of this .ini variable, each IGDS text element is served with its position calculated from the origin. If the .ini variable FORCE TEXT JUSTIFICATION is present, it overrides the .ini variable TEXT ORIGIN BY RANGE. The default behavior in the absence of this .ini variable is FALSE.

SERVE RICH TEXT: TRUE/FALSE (And the Related INI Keywords)

The following INI variables help the user in specifying the font details to serve the text in rich text format:

SERVE RICH TEXT: TRUE/FALSE: You can specify that all the text be served as rich text with this INI variable. The default value of this variable, in the absence of the text font related INI variables (SERVE RICH TEXT and FONT NUMBER), is FALSE. The client will ignore the LegendEntry extension served by the data server for the text features populated in rich text format if SERVE RICH TEXT is set to TRUE.

FONT NUMBER: This INI variable is used to map the MicroStation font number to the font name of rich text format, along with the font pitch, font family, character set, bold, underline, italic qualifiers and the scaling factor for the corresponding font. This helps in serving the text in user specified font. An IGDS text element has the font information as the font number,
The CAD Data Server .INI File

which is again mapped to the font name, using an external font resource file. The user can
specify the font scaling factor (with the fscale: identifier) to be used to map the text height to
the font size, while serving the text in rtf. This value will be multiplied with the text height (in
decimal master design file units) and rounded off to the nearest integer to get the font size of
the rtf text. The default value of the font scaling factor, is 0.1.

**NOTE** This 0.1 value, in terms of decimal master design file units, is required on a per-font
basis because the character size differs from font to font. A default value of 0.1 is chosen
following the precedent of the ExportToDesignFile service.

The value specified against the charset: identifier specifies the character set of a font in the
font table. The default value of this identifier is 0. The value specified against the pitch:
identifier specifies the pitch of the font in the font table. The valid values for the pitch identifier
are 0 (default pitch), 1 (fixed pitch) and 2 (variable pitch). The default value of this identifier is
0. The value specified against the family: identifier specifies the family of the font in the font
table. The valid values are nil, roman, swiss, modern, script, decor, tech, bidi. The default value
of this identifier is nil.

You must mention the mapping for all the font numbers used in the design file. The syntax is as
follows:

```
FONT NUMBER <font number1> = <fontname1>,[b],[i],[u],fscale:<value>,pitch:<0/1/2>,family:<nil/roman/
swiss/modern/script/decor/tech/bidi>,charset:<value>]

FONT NUMBER <font number2> = <font
name2>,[b],[i],[u],fscale:<value>,pitch:<0/1/2>,family:<nil/roman/
swiss/modern/script/decor/tech/bidi>,charset:<value>]

DEFAULT FONT = <font name3>,[b],[i],[u],fscale:<value>,pitch:<0/1/2>,family:<nil/roman/
swiss/modern/script/decor/tech/bidi>,charset:<value>]
```

The keyword DEFAULT FONT allows all the text elements (other than those mapped explicitly in
the INI file) to be displayed in the font as specified against the keyword DEFAULT FONT.

**Example:**

```
FONT NUMBER 1 = Arial,ul,fscale:7
FONT NUMBER 2 = Times New Roman,b,i,ul,fscale:10
FONT NUMBER 3 = Times New Roman
DEFAULT FONT = Courier New,b,fscale:8
```

In the above example, the MicroStation font number 1 will be mapped to Arial font and text
will be underlined and the font size of the text will be 7 times the text height in decimal master
design file units. This means that if the MicroStation text element had a text height of 2
decimal master design file units, the rtf text will be served with a font size of 14. In the above
example, MicroStation font number 3 will be mapped to the Times New Roman font with a
font scaling of 10, which is the default font scale factor.

The font names specified in the INI file will not be validated. If the client does not recognize the
font name for a particular text element, then the display font for that text element will be
according to the client’s behavior.

In the absence of the font mapping keyword in the INI file, or in the absence of a mapping for a
particular font number and the DEFAULT FONT, the default font of Arial will be used.

The font mapping specified in the INI file is ignored if the INI variable SERVE RICH TEXT: is set to
FALSE.

GROUP TEXT BY GRAPHIC GROUP: TRUE/FALSE

Graphic groups are the most flexible grouping technique in MicroStation. However, each of the
elements can have different graphic properties. This concept is used to export the elements
with the same graphic group number to indicate the "grouping" if the GraphicGroup property
of the export service is not set. For example, a Collection geometry will be exported as multiple
elements with the same graphic group number assigned to each of them.

You can group all of your text with the same graphic group number as a single record using this
INI variable. When this variable is set to TRUE, the data server will serve all the grouped text
elements as a collection. If the length of each of these text strings is less than or equal to one,
the data server sets the options field of each text blob to gptCompositeText (0x01) to indicate
that the geometry is part of a collection Geometry containing an ordered set of single
character TextPointGeometry members exclusively.

The graphic properties and attribute linkages of the first text element will be considered for
populating the respective GFields. However, the “GraphicTextString” and
“GraphicTextStringMemo” attributes are populated from the text strings of all the text
elements that form the collection, separated by a delimiter (as specified by the
GRAPHICTEXTSTRING DELIMITER INI keyword). By default, in the absence of this INI variable,
each IGDS text element is served as a different record.
GROUP GEOMETRY BY GRAPHIC GROUP: TRUE/FALSE:

You can group all of your elements with the same graphic group number as a single record using this INI variable. When this variable is set to TRUE, the data server will serve all the grouped elements as a collection geometry. Note that irrespective of this INI variable, a boundary geometry will always be created from the consecutive IGDS elements if the first one is solid and complex and the following are complex with hole flag set. The graphic properties and attribute linkages of the first element will be considered for populating the respective GFields. By default, in the absence of this INI variable, each IGDS element is served as a different record.

AutoCAD Keywords

The following .ini keywords apply only to AutoCAD data: SERVE BLOCK ORIGIN:, SERVE BLOCK GEOMETRY:, and SERVE BLOCK TEXT:

If a block is to be expanded and it includes both geometry and text, then both of the latter two options should be set. However, blocks that include just geometry, or just text, need not have the other geometry field present, unused, and populated with nulls.

In your .csd file, you must have defined the appropriate geometry types for receiving the various block data. If you request the origin without providing a Point field, the geometry without providing an AnySpatial field, or the text without providing a GraphicsText field, then the .ini file variables are ignored.

SERVE BLOCK ORIGIN

Do or do not serve the origin of the block as an oriented point geometry. The default value is TRUE.
In the .csd file, the fields must be defined with the appropriate geometry types/subtypes, for receiving the various block data. If you request the origin without providing a Point field, the INI file variables will be ignored.

**Syntax:**
SERVE BLOCK ORIGIN: <TRUE|FALSE|T|F>

---

**SERVE BLOCK GEOMETRY**

If the value is set to TRUE, the data server serves the block’s spatial components as a GeometryCollection in a field of type/subtype gdbSpatial/gdbAnySpatial. If the value is set to FALSE, the block’s spatial components are not served. The default value is FALSE. If this option is TRUE, but a particular block does not contain geometry, then a NULL geometry is served for that block.

If the value is set to EXPLODE, the data server processes each of the block’s spatial components as separate entities. Thus, the data server will generate different records for a block entity, with the graphic properties of the constituent components. The feature class criteria are applied on each of the spatial components individually.

For example, suppose that a particular block has three polyline entities. When this INI variable is set to TRUE, the data server will serve the block as a collection of the polyline geometries with the graphic properties of the block. When the INI variable is set to FALSE, the data server will not serve the geometry – a NULL geometry is served with the graphic properties of the block. When this INI variable is set to EXPLODE, the data server will serve three different records for each of the polyline entity with the graphic properties of the respective components.

In the .csd file, the fields must be defined with the appropriate geometry types/subtypes, for receiving the various block data. If you request the geometry without providing an AnySpatial field, the INI file variables will be ignored.

The default value is FALSE.

**Syntax:**
SERVE BLOCK GEOMETRY: <TRUE|FALSE|EXPLODE>
The CAD Data Server .INI File

SERVE BLOCK TEXT

If the value is set to TRUE, the data server serves the block’s text components as a GeometryCollection in a field of type/subtype gdbGraphic/gdbGraphicsText. If the value is set to FALSE, the block’s text components are not served. The default value is FALSE. If this option is TRUE, but a particular block does not contain text, then a NULL geometry is served for that block.

If the value is set to EXPLODE, the data server processes the block’s text components as separate entities. Thus, the data server will generate different records for a block entity, with the graphic properties of the respective text components. The feature class criteria are applied on each of the text components individually.

For example, suppose that a particular block has three text components with the text strings “text1”, “text2”, “text3”. When this INI variable is set to TRUE, the data server will serve this as a collection of text geometries with the graphic properties of the block. When the INI variable is set to FALSE, the data server will not serve the geometry – a NULL geometry is served with the graphic properties of the block. When this INI variable is set to EXPLODE, the data server will serve three different records for each of the text components with the graphic properties of the respective text components.

In the .csd file, the fields must be defined with the appropriate geometry types/subtypes, for receiving the various block data. If you request the text without providing a GraphicsText field, then the INI file variables will be ignored.

The default value is FALSE.

Syntax:

SERVE BLOCK TEXT: <TRUE|FALSE|EXPLODE>

SERVE RICH TEXT: TRUE/FALSE:

The following INI variables help the user in specifying the font details to serve the text (stored in AutoCAD SHX fonts) in rich text format:

You can specify that all the text be served as rich text with this INI variable. The default value of this variable, in the absence of the text font related INI variables (SERVE RICH TEXT and FONT
NAME), is FALSE. The client will ignore the LegendEntry extension served by the data server for the text features populated in rich text format if SERVE RICH TEXT is set to TRUE.

FONT NAME: This INI variable is used to map the AutoCAD SHX font name to the font name of rich text format, along with the font pitch, font family, character set, bold and italic qualifiers and the scaling factor for the corresponding font. This helps in serving the text in user specified font. You can specify the font scaling factor (with the fscale: identifier) to be used to map the text height to the font size, while serving the text in rtf. This value will be multiplied with the text height (in drawing units) and rounded off to the nearest integer to get the font size of the rtf text. The default value of the font scaling factor, is 10. The value specified against the charset: identifier specifies the character set of a font in the font table. The default value of this identifier is 0. The value specified against the pitch: identifier specifies the pitch of the font in the font table. The valid values for the pitch identifier are 0 (default pitch), 1(fixed pitch) and 2 (variable pitch). The default value of this identifier is 0. The value specified against the family: identifier specifies the family of the font in the font table. The valid values are nil, roman, swiss, modern, script, decor, tech, bidi. The default value of this identifier is nil.

You must mention the mapping for all the SHX fonts used in the drawing file. For true type fonts, the scaling factor alone has to be specified. The syntax is as follows:

FONT NAME <name1> = <font name1>,[b],[i],[fscale:<value>],[pitch:<0/1/2>],[family:<nil/roman/swiss/modern/script/decor/tech/bidi>],[charset:<value>]

FONT NAME <name2> = <font name2>,[b],[i],[fscale:<value>],[pitch:<0/1/2>],[family:<nil/roman/swiss/modern/script/decor/tech/bidi>],[charset:<value>]

DEFAULT FONT = <font name3>,[b],[i],[fscale:<value>],[pitch:<0/1/2>],[family:<nil/roman/swiss/modern/script/decor/tech/bidi>],[charset:<value>]

The keyword DEFAULT FONT allows all the text elements (other than those mapped explicitly in the INI file) to be displayed in the font as specified against the keyword DEFAULT FONT.

Example:

FONT NAME RomanT.SHX = Times New Roman,b,fscale:50

FONT NAME Italic.SHX = Arial,i

FONT NAME Times New Roman = Times New Roman,fscale:50

DEFAULT FONT = Courier New,b,fscale:8

In the above example, the AutoCAD SHX font RomanT will be mapped to the Times New Roman font, the text will be bold, and the font size of the text will be 50 times the text height in
drawing units. This means that if the AutoCAD text entity had a text height of 0.2 drawing units, the rtf text will be served with a font size of 10. In the above example, AutoCAD SHX font Italic will be mapped to Arial font with a font scaling of 10, which is the default font scale factor, and a font scaling factor of 50 will be applied to the TrueType font Times New Roman. The font names specified in the INI file will not be validated. If the client does not recognize the font name for a particular text element, then the display font for that text element will be according to the client’s behavior. In the absence of the font mapping keyword in the INI file, or in the absence of a mapping for a particular font name and the DEFAULT FONT, the default font of Arial will be used. The font mapping specified in the INI file is ignored if the INI variable SERVE RICH TEXT: is set to FALSE.

**SERVE CELL ORIGIN**

Do or do not serve the cell’s origin as an OrientedPointGeometry in a field of type/subtype gdbSpatial/gdbPoint. The default value is TRUE.

**Syntax:**

SERVE CELL ORIGIN: <TRUE|FALSE|T|F>

**SERVE CELL GEOMETRY**

Do or do not serve the spatial components of the cell as a collection of geometry. The default value is FALSE. If this option is TRUE, but a particular cell does not contain geometry or contains any unsupported elements, then a NULL geometry is served for that cell.

**Syntax:**

SERVE CELL ORIGIN: <TRUE|FALSE|T|F>
SERVE CELL GEOMETRY: <TRUE|FALSE|T|F>
SERVE CELL TEXT

Do or do not serve the text components of the cell as a collection of graphics text. The default value is FALSE. If this option is TRUE, but a particular cell does not contain text, then a NULL geometry is served for that cell.

Syntax:
SERVE CELL TEXT: <TRUE|FALSE|T|F>

GROUP TEXT BY GRAPHIC GROUP: TRUE/FALSE

Graphic groups are the most flexible grouping technique in MicroStation. However, each of the elements can have different graphic properties. This concept is used to export the elements with the same graphic group number to indicate the "grouping" if the GraphicGroup property of the export service is not set. For example, a Collection geometry will be exported as multiple elements with the same graphic group number assigned to each of them.

You can group all of your text with the same graphic group number as a single record using this INI variable. When this variable is set to TRUE, the data server will serve all the grouped text elements as a collection. If the length of each of these text strings is less than or equal to one, the data server sets the options field of each text blob to gptCompositeText (0x01) to indicate that the geometry is part of a collection Geometry containing an ordered set of single character TextPointGeometry members exclusively.

The graphic properties and attribute linkages of the first text element will be considered for populating the respective GFields. However, the “GraphicTextString” and “GraphicTextStringMemo” attributes are populated from the text strings of all the text elements that form the collection, separated by a delimiter (as specified by the GRAPHCETXTSTRING DELIMITER INI keyword). By default, in the absence of this INI variable, each IGDS text element is served as a different record.
GROUP GEOMETRY BY GRAPHIC GROUP: TRUE/FALSE:

You can group all of your elements with the same graphic group number as a single record using this INI variable. When this variable is set to TRUE, the data server will serve all the grouped elements as a collection geometry. Note that irrespective of this INI variable, a boundary geometry will always be created from the consecutive IGDS elements if the first one is solid and complex and the following are complex with hole flag set. The graphic properties and attribute linkages of the first element will be considered for populating the respective GFields. By default, in the absence of this INI variable, each IGDS element is served as a different record.

FORCE TEXT JUSTIFICATION: LOWERLEFT / CENTERLEFT / UPPERLEFT:

You can serve all of your text left justified using this INI variable. This INI variable sets the alignment of each output TextPointGeometry to the designated setting, minimizing or eliminating text positioning errors. By default, in the absence of this INI variable, each text element is served with its actual justification.

While use of this INI variable does not preserve the original justification of the text element, it does correctly position the text, assuming that you choose a TrueType font for your TextStyle, which maps well to the font used in MicroStation.

The provision of LowerLeft alignment would yield the only truly accurate origin. The provision of CenterLeft and UpperLeft options is to accommodate another idiosyncrasy of text handling, specifically that MicroStation font heights are measured from baseline to ascender, while Microsoft font heights are measured from descender to ascender. Provision of these three options offers you the flexibility needed to get the most accurate text positioning.
SERVE TEXTNODE AS MULTILINE TEXT

By default, MicroStation V8 scanner serves Text Node as a text geometry collection. If the INI variable “SERVE TEXTNODE AS MULTILINE TEXT” is set to TRUE, Text Node is served as multi-line text geometry. The default value is FALSE.

For text along element (which is a text node) this INI keyword will be ignored, that is, the scanner always serves it as a composite text collection.

Syntax:

SERVE TEXTNODE AS MULTILINE TEXT: <TRUE|FALSE|T|F>

MAXIMUM NUMBER OF FILES OPEN

By design, MicroStation V8 scanner and AutoCAD scanner scans all design/drawing files in a dataset to determine if the elements within each design/drawing file match the criteria specified for the feature class definition. The scanner subsequently reads only the matching elements to serve the necessary attributes and geometry. Opening and closing the design/drawing file for each process stage is costly and can result in poor performance; however, keeping all the design/drawing files open might lead to excessive memory consumption, especially in cases where the dataset contains many design/drawing files. As a result, the data server, by default, keeps only a maximum of 100 design/drawing files concurrently open. This usually provides a good balance between application memory consumption and performance. For dataset cases where this default number of concurrently open files is not optimal, the keyword MAXIMUM NUMBER OF FILES OPEN can be set to a more appropriate number for the given dataset. The default value is 100.

Syntax:

MAXIMUM NUMBER OF FILES OPEN: 10

The FRAMME Data Server .INI File

FRAMME format is not supported in ERDAS IMAGINE.
GeoGraphics format is not supported in ERDAS IMAGINE.

The I/CAD MAP Data Server .INI File

An .ini file is optional but recommended for the I/CAD MAP data server. The warehouse configuration file will contain information about the geometry types for the feature classes, linkage information for the feature classes, and the rich text parameters required to serve text.

The connection string has the following syntax:

DATA=<MAP file name with the complete path>[;CSF=<coordinate system file name with the complete path>][;INI=<INI file name with the complete path>]

GEOMETRY TYPE

By default, all the feature classes are served as Compound. Also, a secondary geometry field of type Text is served for each feature class.

This keyword allows you to specify the geometry type(s) for a feature class.

Syntax:

[GEOMETRY TYPE]
LEVEL<Level Number>=<comma separated geometry type(s)>
DEFAULT=<comma separated geometry type(s)>

Valid values for Geometry types are LINE, POINT, AREA, COMPOUND and TEXT.
If more than one geometry type is specified for a level number (feature class), additional
geometry fields will be added for every geometry type. The first specified geometry field will be
the primary geometry field. The geometry type specified by the DEFAULT keyword will be used
for all the levels that do not have the geometry type specified for them. If the data server
encounters an element whose geometry does not conform to any of the geometry fields
specified, that particular record is skipped.

Example:

[GEOMETRY TYPE]
LEVEL36=COMPOUND, TEXT
DEFAULT=POINT

In this case, Level 36 is served with gdbAnySpatial as the primary geometry and
gdbGraphicText as the secondary geometry. All the other feature classes are served with
gdbPoint as the primary geometry. So, for example, if the data server encounters a polygon
geometry while serving the text geometry field for Level 36, a NULL value is served for the text
geometry field.

NUMBER OF LINKAGES

By default, the EntityNumber1 and OccurrenceNumber1 fields are added for every feature
class. This way, only the first linkage value for the element can be served by the data server.
This keyword allows you to specify the number of linkages to serve for every feature class. The
names of these fields are of the form EntityNumber<numeric value>, OccurrenceNumber<
numeric value>, and these are constructed by appending a numeric value to “EntityNumber”
and “OccurrenceNumber”. The number of linkages specified by the DEFAULT keyword will be
used for all the levels that do not have the number of linkages specified for them.

Syntax:

[NUMBERS OF LINKAGES]
LEVEL<Level Number>=<number of linkages>
DEFAULT=<number of linkages>

Example:
[NUMBER OF LINKAGES]
LEVEL10=3
DEFAULT=2
In this case, Level 10 will be served with three sets of linkage fields, while all the other feature classes are served with two sets of linkage fields.

RICH TEXT, SERVE RICH TEXT

If you want the text to be served as unformatted text, the INI keyword `SERVE RICH TEXT` has to be set to FALSE. The default value of this keyword is TRUE.

To serve rich text, the data server needs rich text parameters (such as the font scaling factor and the bold, italic, and underline options) in addition to the font details available in the MAP file. This mapping can be specified using the FONT keyword.

If the font information is available in the MAP file, the data server serves rich text with the following parameters:
- Font name taken from the font table in the MAP file
- Font size calculated by multiplying the text height with the font scaling factor
- Other font parameters (along with the font size) taken from the font mapping specified in the INI file
- Color taken from the text element’s color

If the font information is not available in the MAP file, the data server serves rich text with the default font details specified using the DEFAULT FONT keyword. Otherwise, text is served as rich text with a default font of Arial and a default font scaling factor of 0.1.

If the `SERVE RICH TEXT` keyword was set to FALSE, the data server ignores the other font parameters and serves all the text as unformatted text.

Syntax:

[RICH TEXT]
SERVE RICH TEXT = <TRUE/FALSE>

FONT <font name1> = [b][i][u][,fscale:<value>][,pitch:<0/1/2>][,family:<nil/roman/swiss/modern/script/decor.tech/bidi>][,charset:<value>]

FONT <font name2> = [b][i][u][,fscale:<value>][,pitch:<0/1/2>][,family:<nil/roman/swiss/modern/script/decor.tech/bidi>][,charset:<value>]
DEFAULT FONT=<TrueType font name>
[,b][,i][,u][,fscale:<value>][,pitch:<0/1/2>][,family:<nil/roman/swiss/modern/script.decor/tech/bidi>][,charset:<value>]

Example:
[RICH TEXT]
FONT Arial =b,fscale:0.01
DEFAULT FONT=Courier New, fscale:0.001
In this case, the data server calculates the font size by multiplying the text height for all the
text elements in Arial font with a value of 0.01 and serves such text as bolded. And if the font
information is missing in the MAP file, the data server serves all the text with the font name set
to Courier New and applies a font scale factor of 0.001.

The KML Data Server .INI File

An .ini file is optional but recommended for the KML data server. The warehouse configuration
file will define information about the geometry types for the feature classes.

GEOMETRY TYPE

By default, all the feature classes are served as Compound. Also, secondary geometry fields of
type Text and Coverage are served for each feature class.
This keyword lets you specify the geometry type(s) for a feature class.

Syntax:
[GEOMETRY TYPE]
<FEATURE CLASS NAME>=<comma separated geometry type(s)>
DEFAULT=<comma separated geometry type(s)>
Valid values for Geometry types are LINE, POINT, AREA, COMPOUND, TEXT and IMAGE.
If more than one geometry type is specified for a feature class, additional geometry fields are
added for every geometry type. The first specified geometry field will be the primary geometry
field. The geometry type specified by the DEFAULT keyword will be used for all the feature classes that do not have the geometry type specified for them. If the data server encounters an element whose geometry does not conform to any of the geometry fields specified, a NULL value is served for the geometry field.

**Example:**

```
[GEOMETRY TYPE]
STATES=AREA, IMAGE
DEFAULT=POINT
```

In this case, the folder States is served with Area as the primary geometry and Coverage as secondary geometry. All the other feature classes are served with Point as primary geometry. Therefore, if the data server encounters a polygon geometry while serving the coverage geometry field for States folder, a NULL value is served for the coverage geometry field.

<FEATURE CLASS NAME> is the GDO sanitized name of the Folder / Document in the KML file.

**NOTE** The GDO sanitized name is constructed according to the norms defined for GDO field name (that is, the name must start with a letter and can include letters, numbers, and the underscore characters, but it cannot include punctuation or spaces). If a Folder or Document name contains any invalid characters according to this definition, the server will prefix the character "F" to the feature name if the invalid character is the first character. If the invalid character is at any other character position, that character will be replaced by an underscore.

**For Example:**

Following are the contents of a KML file:

```xml
<?xml version="1.0" encoding="UTF-8"?>
<kml xmlns="http://earth.google.com/kml/2.1">
  <Document>
    <name>KmlFile_Document</name>
    <Schema parent="Placemark" name="Test21Schema">
      <SimpleField type="string" name="CityName"/>
      <SimpleField type="int" name="Population"/>
    </Schema>
    <Folder>
```

64 GeoMedia Objects Reference Guide for ERDAS IMAGINE
<name>KML 2.1_Folder</name>
<open>1</open>

<Placemark>
  <name>Test21Schema</name>
  <CityName>"Hyderabad"</CityName>
  <Population>100000</Population>
  <PolyStyle>
    <color>ff7fffff</color>
  </PolyStyle>
  <LineStyle>
    <color>ff0055aa</color>
    <width>25</width>
  </LineStyle>
  <Polygon>
    <tessellate>1</tessellate>
    <outerBoundaryIs>
      <LinearRing>
        <coordinates>
          75.44058678510427,27.10615408179821,0
          73.47431888375749,23.59183716429401,0
          76.73826318402453,21.22476057754922,0
          79.39537202346719,23.43212699844056,0
          79.01729762376544,27.20910933243529,0
          75.44058678510427,27.10615408179821,0
        </coordinates>
      </LinearRing>
    </outerBoundaryIs>
  </Polygon>
</Placemark>
INI Mapping:

 According to design, a Document/Folder element in the KML file which contains at least one Place mark/Ground overlay element defined in it will be considered as a feature class in IMAGINE.

 Therefore, in the above example, one Document (with name KmlFile_Document) and one Folder (named KML 2.1_Folder) element are defined. But only Folder element contains a place mark (named Test21Schema) defined in it. So, the data server considers only Folder as feature class, with the name as KML_2_1_Folder. Note that the space and period ( . ) characters have been replaced with an underbar (_).

 Geometry mapping for this can be specified as follows (note that the KML file has a Polygon geometry defined in it).

 [GEOMETRY TYPE]

 KML_2_1_Folder = Area

 Mapping in case of Nested Folders:

 Following are the contents of the KML file:

 ```xml
<?xml version="1.0" encoding="UTF-8"?>
<kml xmlns="http://earth.google.com/kml/2.1">
  <Document>
    <name>KmlFile_Document</name>
    <Schema parent="Placemark" name="Test21Schema">
      <SimpleField type="string" name="CityName"/>
    </Schema>
  </Document>
</kml>
```
<SimpleField type="int" name="Population"/>
</Schema>

<Folder>
  <name>Folder_Parent</name>
  <Folder>
    <name>KML 2.1_Folder</name>
    <open>1</open>
    <Placemark>
      <name>Test21Schema</name>
      <CityName>"Hyderabad"</CityName>
      <Population>100000</Population>
      <LineStyle>
        <color>ff0055aa</color>
        <width>25</width>
      </LineStyle>
      <coordinates>
        75.44058678510427,27.10615408179821,0
        73.47431888375749,23.59183716429401,0
        76.73826318402453,21.22476057754922,0
        79.39537202346719,23.43212699844056,0
        79.01729762376544,27.20910933243529,0
        75.44058678510427
      </coordinates>
    </Placemark>
  </Folder>
</Folder>
INI Mapping:
The above example contains nested folders. The Folder named KML 2.1_Folder is defined within another folder named Folder_Parent. In this case, only the Folder named KML 2.1_Folder will be considered as feature class by the data server. But according to design, to maintain the hierarchy, the feature class name will become Folder_Parent_KML_2_1_Folder (that is, the parent Folder’s name and child Folder’s name separated by an underscore.) Geometry mapping for this can be specified as follows (note that the KML file has a Linestring geometry defined in it).

[GEOMETRY TYPE]
Folder_Parent_KML_2_1_Folder = Line.

KMZ PROCESSING
By default, the KMZ file contents are extracted to a temporary folder under the /warehouses folder. This keyword allows you to override the default folder path. A temporary folder with the KMZ file name is created under the specified folder path, to which the KMZ file contents are extracted.

Syntax:
[KMZ PROCESSING]
KMZ FOLDER PATH=<Folder path>

Example:
[KMZ PROCESSING]
KMZ FOLDER PATH = c:\temp\
SERVE FILES FROM SECURE SITES WITHOUT A VALID CERTIFICATE

Downloading the files from secure sites can be potentially unsafe if the security certificate for the specified sites has expired or is invalid. By default, the data server does not download the files from such secure sites whose security certificate is not valid. The keyword SERVE FILES FROM SECURE SITES WITHOUT A VALID CERTIFICATE allows you to override this behavior and let the data server download the files from secure sites. Note that this keyword is not needed to process files from the secure sites that have a valid security certificate – the data server can process those files without problem.

Syntax:

[URL PROCESSING]
SERVE FILES FROM SECURE SITES WITHOUT A VALID CERTIFICATE: <TRUE/FALSE>

Example:

[URL PROCESSING]
SERVE FILES FROM SECURE SITES WITHOUT A VALID CERTIFICATE: TRUE
create an .ini for your data configuration, you can place the file in the MapInfo Tables folder. This is the recommended location for the .ini file. Placing the .ini file in the MapInfo Tables folder is the best way to ensure that the correct .ini file is being used by the software.

- .

If an .ini file is not found in this location, then the software does not use an .ini file.

The .ini file must have the same filename as the name of the MapInfo Tables folder, with the .ini file extension.

**COORDINATE SYSTEM (MapInfo)**

In order for MapInfo data to align properly with other data, it must expose a coordinate system. The MapInfo tables in a MapInfo Tables folder can have different coordinate systems, or the entire MapInfo Tables folder can have a single coordinate system.

You can use a .csf file to define the coordinate system for your MapInfo data. Use the **Define Coordinate System** executable that is delivered with the software to create the .csf file.

When you are working with a MapInfo Tables folder that has multiple tables, you can use the .ini file to specify the .csf files for the tables that have different coordinate systems. You must name the .ini file using the same name as the MapInfo Tables folder you specified when you created the data server connection in the **Connection Wizard**.

When you are working with a seamless table that contains tables in different coordinate systems, the .ini file should have the same name as that of the MapInfo Tables folder.

The data server looks at the `<MapInfo workspace name>.ini` file to determine the name of the .csf file that it is to use for each MapInfo table.

If the .ini file is not found in the workspace folder specified in the connection wizard, then the server checks for the existence of the .csf file in the folder containing the base table.

**Syntax:**

The syntax for the **COORDINATE SYSTEM** keyword for the case where you have one coordinate system (and therefore one .csf file) for all MapInfo tables is as follows:

COORDINATE SYSTEM:

<MapInfo Tables Folder> = <full path and filename of .csf file>

**Example:**
city=d:\city\city.csf

Syntax:
The syntax for the **COORDINATE SYSTEM**: keyword for the case where you have a different coordinate system (and therefore a different .csf file) for each MapInfo table is as follows:

**COORDINATE SYSTEM:**
<MapInfoTable1> = <full path and filename of .csf file>
<MapInfoTable2> = <full path and filename of .csf file>

Example:
roads=d:\city\roads.csf
rivers=d:\city\rivers.csf

Syntax:
The syntax for the case where you have seamless tables uses a concatenation of the seamless table name followed by an under bar and the base table name as the name of the coverage:

**COORDINATE SYSTEM:**
<SeamlessTableName1_BaseTableName1> = <full path and filename of .csf file>
<SeamlessTableName1_BaseTableName2> = <full path and filename of .csf file>

Example:
In the following example, it is assumed that you have a seamless table named Table1, and its corresponding base tables are named base1 and base2:

**COORDINATE SYSTEM:**
Table1_base1=d:\coverage1\base1.csf
Table1_base2=d:\coverage1\base2.csf

**NOTE** If you do not want to use a .ini file, you can specify the coordinate system by placing one or more .csf files in the directories containing your MapInfo data. Name the .csf file using the name of the MapInfo table, with the .csf extension. If you want to specify the same coordinate system for the entire MapInfo Tables folder, place a .csf file with the same name as your MapInfo Tables folder name in the folder containing your data.

When you are working with seamless tables, place the .csf file in the folder containing the base table.
GEOMETRY TYPE (MapInfo)

MapInfo data can have point, linear, areal and text data all in one map. The default behavior of the data server is to serve up all the geometry as the compound data type (gdbAnySpatial). The MapInfo data server allows you to use the optional GEOMETRY TYPE: keyword to change this default behavior and to serve up geometry from a particular coverage as a specific geometry type.

If you have enough familiarity with your data to be able to determine what is the geometry type of a feature class, you can use the GEOMETRY TYPE: keyword to specify that a feature class is either an areal, linear, point, or text feature. With the exception of text, if an entry in the .ini file does not exist for a particular feature class, it is treated as the gdbAnySpatial geometry type, and all the geometry for the feature is served up as this type. If an entry does exist indicating the geometry type, the data is served up as the indicated type, dropping out any data that does not match the type you specified. If the data contains text features, there must be an entry in the .ini file (either GEOMETRY TYPE: or TEXT:) for the MapInfo data server to serve up the text features. If there is no entry in the .ini file, text features will not be served up.

The geometry type can be one of the following types:
- POINT
- LINE
- AREA
- COMPOUND
- TEXT

For backward compatibility, the data server will also support the old GEOMETRY TYPE keyword values – POINT, LINEAR, AREAL, ANYSPATIAL and TEXT.

Syntax:
GEOMETRY TYPE:

Example:
GEOMETRY TYPE:
The **TEXT** keyword is required in the case where a MapInfo coverage contains text geometry in addition to other graphic data (for example, point, line, and/or area graphics). In this case, if you want to view the text geometry, you must use the **TEXT** keyword to enable text geometry for each coverage. If you do not use the **TEXT** keyword to enable text geometry, only graphic data is served up (point, line, and/or area geometry), and the text geometry is not served up. If a coverage contains only text, you can use the **GEOMETRY TYPE** keyword to specify that text is the geometry type for that coverage. If you specify **GRAPHICSTEXT** as the **GEOMETRY TYPE**, you do not need to use the **TEXT** keyword to display the text geometry.

**Syntax:**

```
TEXT:
<MapInfoTable1>=ENABLED
<MapInfoTable2>=ENABLED
```

**Example:**

```
TEXT:
roads=ENABLED
rivers=ENABLED
```

**NOTE:** If the data contains text features, there must be an entry in the .ini file (either **TEXT** or **GEOMETRY TYPE**) for the MapInfo data server to serve up the text features. If there is no entry in the .ini file, text features will not be served up.

---

**The MGDM Data Server .INI File**

MGDM format is not supported in ERDAS IMAGINE.
The MGE Data Server .INI File

MGE format is not supported in ERDAS IMAGINE.

The MGSM Data Server .INI File

MGSM format is not supported in ERDAS IMAGINE.

The WCS Data Server .INI File

The topic in this section describes the WCS Data Server .ini file options.

The WCS Data Server .INI File

An .ini file is optional but recommended for the WCS data server. The warehouse configuration file will define information about the SRS to be used for the feature classes. This file also provides the ability to specify the CSF to be used for an SRS.

**Syntax:**

INI=<full path and filename>;

**Example:**

INI=C:\projects\INI Files\USA.ini

The format in the warehouse configuration file is as follows:

[SRS for Feature Classes]
Default=<SRS as in the capabilities response>

<Layer Title>=<SRS as in the DescribeCoverage response>
The user will be able to specify what SRS out of the available SRS supported for the feature class should be treated as the feature class’ coordinate system. If the user does not specify this for a feature class, the value against the Default keyword will be used. If the Default is missing, SRS for the feature class will be the first supported SRS in the requestResponseCRSs tag of the DescribeCoverage response.

[SRS to CSF Mapping]

The user will be able to specify the full path and filename of a CSF file for an SRS. If it is found, it will be used for the SRS code. If not, the matching coordinate system will be found using GeoreferenceService or filename lookup in the EPSG folder.

The WFS Data Server .INI File

The topic in this section describes the WFS Data Server .ini file options.

The WFS Data Server .INI File

An .ini file is optional but recommended for the WFS data server, Read-Only (GeoMedia Professional, GeoMedia, and ERDAS IMAGINE) or Read-Write (GeoMedia Professional and ERDAS IMAGINE). The warehouse configuration file will define information about the SRS to be used for the feature classes. This file also provides the ability to specify the CSF to be used for an SRS.

Syntax:

INI=<full path and filename>;
Example:
INI=C:\projects\INI Files\USA.ini
The format in the warehouse configuration file is as follows:
[SRS for Feature Classes]
Default=<SRS as in the GetCapabilities response>
<Layer Title>=<SRS as in the GetCapabilities response>
<Layer Title>=<SRS as in the GetCapabilities response>
<Layer Title>=<SRS as in the GetCapabilities response>
The user will be able to specify what SRS out of the available SRS supported for the feature class should be treated as the feature class’ coordinate system. If the user does not specify this for a feature class, the value against the Default keyword will be used. If the Default is missing, SRS for the feature class will be the first supported SRS in the SRS tag of the GetCapabilities response.
[SRS to CSF Mapping]
<SRS as in the GetCapabilities response>=<full path and filename of csf file>
<SRS as in the GetCapabilities response>=<full path and filename of csf file>
<SRS as in the GetCapabilities response>=<full path and filename of csf file>
The user will be able to specify the full path and filename of a CSF file for an SRS. If it is found, it will be used for the SRS code. If not, the matching coordinate system will be found using GeoreferenceService or filename lookup in the EPSG folder.

The WMS Data Server .INI File

The topic in this section describes the WMS Data Server .ini file options.
The WMS Data Server .INI File

An .ini file is optional but recommended for the WMS data server. The warehouse configuration file will define information about the SRS to be used for the feature classes. This file also provides the ability to specify the CSF to be used for an SRS.

Syntax:
INI=<full path and filename>;

Example:
INI=C:\projects\INI Files\USA.ini

The format in the warehouse configuration file is as follows:
[SRS for Feature Classes]
Default=<SRS as in the GetCapabilities response>
<LAYER Title>=<SRS as in the GetCapabilities response>
<LAYER Title>=<SRS as in the GetCapabilities response>
<LAYER Title>=<SRS as in the GetCapabilities response>

The user will be able to specify what SRS out of the available SRS supported for the feature class should be treated as the feature class’ coordinate system. If the user does not specify this for a feature class, the value against the Default keyword will be used. If the Default is missing, SRS for the feature class will be the first supported SRS in the SRS or CRS tag of the GetCapabilities response.

[SRS to CSF Mapping]
<SRS as in the GetCapabilities response>=<full path and filename of csf file>
<SRS as in the GetCapabilities response>=<full path and filename of csf file>
<SRS as in the GetCapabilities response>=<full path and filename of csf file>

The user will be able to specify the full path and filename of a CSF file for an SRS. If it is found, it will be used for the SRS code. If not, the matching coordinate system will be found using GeoreferenceService or filename lookup in the EPSG folder.

[WMS Coordinate Order]
<SRS as in the capabilities response>=X,Y or Y,X
<SRS as in the capabilities response>=X,Y or Y,X
<SRS as in the capabilities response>=X,Y or Y,X
In the Capabilities response, the coordinate order for a layer’s BBOX can be advertised as <latitude, longitude> (Y,X) or <longitude, latitude> (X,Y). This order is dependent on the SRS code’s definition by an authority, like EPSG.

For example, in WMS 1.3.0, BBOX for EPSG:4326 is advertised as latitude, longitude (Y,X), whereas in WMS 1.1.1, the BBOX is advertised as longitude, latitude (X,Y).

The WMS services do not consistently follow these guidelines. To accommodate such WMS services, this INI keyword will allow the user to specify the order in which the BBOX is advertised in the Capabilities response.

In the absence of this INI keyword value, the following logic is used to determine a default coordinate order:

If the WMS version is 1.3.0, the authority is EPSG, and the EPSG code range is >=4000 and <5000, the default is Y,X, else, the default is X,Y.
Section 6

Overview of the Database Utilities

The Database Utilities consist of several utilities for managing and updating Microsoft® Access, Oracle® Spatial Object Model, and Microsoft® SQL Server. These utilities are delivered with GeoMedia® Professional and GeoMedia® Web Map and can be used with ERDAS IMAGINE. The Database Utilities are not supplied with ERDAS IMAGINE.

Section 7

Overview of the Define CAD Server Schema File Utility

The Define CAD Server Schema File utility allows you to specify the parameters the software uses when creating connections with the CAD data server. The CAD data server allows you to use IGDS (MicroStation V7) design files, MicroStation V8 design files, or AutoCAD files as a data source.

Define CAD Server Schema File

The Define CAD Server Schema File utility allows you to specify the parameters the software uses when creating connections with the CAD data server. The CAD data server allows you to use IGDS (MicroStation V7) design files, MicroStation V8 design files, or AutoCAD files as a data source.
Overview of the Define CAD Server Schema File Utility

Please note that in order to make full use of the Define CAD Server Schema File utility you must have a complete understanding of your CAD data structure. For example, you would need to know the following:

- CAD criteria such as level, layer names, color, and so forth
- The conventions used for digitizing and assigning attributes to features in your project
- Whether graphics in the project have attributes
- The nature and structure of the attribute data

Running Define CAD Server Schema File


2. Select File > New to create a new CAD server schema file.

   OR

3. Select File > Open to open an existing CAD server schema file. Note: You can also double-click on an existing CAD Server Definition (.csd) file to open it in the Define CAD Server Schema File utility.

CAD Server Definition Workflow

This section describes the Define CAD Server Schema File dialog box workflow. Each step is described in detail in the sections that follow.


2. Select File > Open or File > New on the File menu to open an existing .csd file or to create a new .csd file.

   NOTE When using the File > New option, you will need to select the appropriate CAD template based on the type and version of CAD to which you are going to connect.

3. Select Feature Class > Select Maps and Feature Class > Select Coordinate System Files from the Feature Class menu to select maps and coordinate system files.
4. Select **Feature Class > Define Feature Class** from the **Feature Class** menu to display the **Define Feature Class** dialog box.

5. Click **New** on the **Define Feature Class** dialog box and use the different tabs of the **New <FeatureClass Name>** dialog box to set the feature class definition parameters.

   **NOTE**: When you create a new .csd file, you will be prompted to enter the minimum required information and the dialog boxes used to enter that information will be displayed. At a minimum, you will be required to use the following dialog boxes to create a .csd file:

   - **Select Map Files** dialog box - Use this dialog box to select the map files to be processed.
   - **Select Coordinate System Files** dialog box - Use this dialog box to select the coordinate system (.csf) files be applied to the data.
   - **Define Feature Class** dialog box - Click **New** on this dialog box this dialog box to display the **New <feature class name>** dialog box, which allows you to enter the criteria for a new feature class.
   - **New <feature class name>** dialog box - Use this dialog box to specify the criteria that define the new feature class.

6. Select **Feature Class > Edit Coordinate System to Map Associations** from the **Feature Class** menu to associate the map files with the respective coordinate system files.

7. Select **Feature Class > Edit Coordinate System to Feature Class Associations** from the **Feature Class** menu to associate the feature classes with the respective coordinate system files.

8. Select **Feature Class > Edit Feature Class to Map Associations** from the **Feature Class** menu to associate the feature classes with the respective map files.

9. Use the **Options** pull-down menu to specify the connection-specific parameters for your CAD data, specify the primary unique key for CAD data with database linkages, specify advanced database linkage parameters, or update map MBRs. If your feature class has database linkages, you must use the **Specify Connection Parameters** dialog box to specify the information necessary to connect to the database.

**Menus**

The Define CAD Server Schema File utility provides you with the following pull-down menus:

- **File** (see "File Menu" on page 82)
Overview of the Define CAD Server Schema File Utility

- **Feature Class** (see "Feature Class Menu" on page 83) - This menu does not appear until you open a new or existing .csd file.
- **Options** (see "Options Menu" on page 84) - This menu does not appear until you open a new or existing .csd file.
- **Help** (see "Help Menu" on page 85)

**File Menu**

The File menu contains the following options:

**New**
Displays the New dialog box, which is a file dialog box with the default path set to the CADSchemaDefinition templates folder -<drive>:\Program Files (x86)\Common Files\Intergraph\GeoMedia\Templates where all the template files are stored. The dialog box will have a filter of CAD Schema Template Files (*.csd).

By default, the product delivers three template files:
- **AutoCadTemplate.csd** - Select this template if you are using AutoCAD data.
- **MstnTemplate.csd** - Select this template if you are using Microstation V7 data.
- **MstnV8Template.csd** - Select this template if you are using Microstation V8 data.

After you select a template, it opens a new .csd file with the default name Untitled.csd, based on the selected template. Its keyboard mnemonic is Ctrl+N. If there is a .csd file currently open, you are prompted to save that file (if appropriate) before the template selection file dialog box is displayed.

In order to help you with the normal workflow for defining your .csd file, the Define CAD Server Schema File utility enters a wizard mode that displays the dialog boxes that you must use to define the new .csd file. Once you have selected a template and click **New**, the Select Maps dialog box is automatically displayed to allow you to select the map files you want to process. Once you have selected your maps and click **OK**, the Select Coordinate System Files dialog box is automatically displayed to allow you to select the coordinate system files you want to use. Once you have selected the coordinate system files and click **OK**, the Define Feature Class dialog box is automatically displayed to allow you to define the feature classes for your .csd file. Clicking **Cancel** on either the Select Maps dialog box or the Select Coordinate System Files dialog box, exits this wizard mode and allows you to use the pull down menus to select commands manually.

**Open**
This option displays the **Open** dialog box, which allows you to select and open an existing `.csd` file. Its shortcut key is Ctrl+O. If a `.csd` file is already open, you are prompted to save that file (if appropriate) before the **Open** dialog box is displayed. To open a `.csd` file, select the file and click **Open**. The title bar will now change, displaying the name of the `.csd` file. The **Save**, **Save As** and **Close** menu options are activated. The **Open** dialog box has a filter of **CAD Schema Definition Files (*.csd)**. The selected folders, map files, and coordinate system files are validated for their existence when a `.csd` file is opened and appropriate error messages are given.

**Close**

Closes the active `.csd` file. If you have made any changes to the file since the last time it was saved, then you are prompted to save the file before closing. If the file has not ever been saved to disk, then clicking **Yes** on the message box displays the **Save As** dialog box allowing you to specify the filename and the path where the file should be saved. The file menu options **Save**, **Save As**, and **Close** are disabled.

**Save**

Saves the active `.csd` file. If the current `.csd` file has not been saved before, then this option works just like **Save As**. Otherwise, it saves the current definition to disk. **Save** is enabled only if there is a `.csd` file open. Its shortcut key is Ctrl+S. If you attempt to save a read-only file, the **Save As** dialog box is displayed to allow you to specify a different file name.

**Save As**

Displays the **Save As** dialog box, which allows you to enter or select a filename to be used for the output `.csd` file. If the file already exists, you are prompted whether to overwrite the file. **Save As** is enabled only if there is a `.csd` file open.

**Exit**

Exits the utility. If you have made any changes to the file since the last time it was saved, a message box appears that prompts you to save the file. If you click **Yes**, then the changes to the file will be saved. If the file has never been saved to disk, then clicking **Yes** on the message box will display the **Save As** dialog box, which allows you to specify the filename and the path where the file should be saved.

**Feature Class Menu**

Once you have opened a `.csd` file, the **Feature Class** menu is is added to the **Define CAD Server Schema File** dialog box. When you first start the Define CAD Server Schema file utility, this menu is not displayed. The **Feature Class** menu contains the following options:
Overview of the Define CAD Server Schema File Utility

Select Maps
Displays the Select Map Files dialog box, which allows you to select the folders and maps for feature classes.

Select Coordinate System Files
Displays the Select Coordinate System Files dialog box, which allows you to specify the coordinate system files to be associated with the feature classes and with the map files.

Define Feature Class
Displays the Define Feature Class dialog box, which allows you to create, edit, copy, or delete feature definitions.

Edit Coordinate System To Map Associations
Displays the Edit Coordinate System to Map Associations dialog box, where you can edit the association of map files with the coordinate system files.

Edit Coordinate System To Feature Class Associations
Displays the Edit Coordinate System to Feature Class Associations dialog box, which allows you to edit the association of feature classes with a coordinate system files. The workflow of this command is similar to that for the Edit Coordinate System To Map Associations dialog box.

Edit Feature Class To Map Associations
Displays the Edit Feature Class to Map Associations dialog box, which allows you to edit the association of map files with the feature classes. The workflow of this command is similar to that for the Edit Coordinate System To Map Associations dialog box.

Options Menu
Once you have opened a .csd file, the Options menu is added to the Define CAD Server Schema File dialog box. When you first start the Define CAD Server Schema file utility, this menu is not displayed. The Options menu contains the following options:

Connection
Displays the Specify Connection Parameters dialog box, which allows you to specify the connection parameters for your .csd file.

Primary Unique Key
Displays the **Primary Unique Key** dialog box, which allows you to specify which graphic attribute the CAD server is to use to define the primary unique key for all graphic-only feature classes and for all database-linked feature classes.

**Advanced Database Linkage**

Displays the **Advanced Database Linkage** dialog box, which allows you to specify the database linkage options if you want the CAD server to serve up attribute data from a database.

**Update Map MBRs**

Displays the **Update Map MBRs** dialog box, which allows you to update the MBR information for the map files in your .csd file.

### Help Menu

The **Help** menu contains the following options:

- **Help Topics F1**
  
  Displays this help file.

### Define CAD Server Schema File Dialog Box

The **Define CAD Server Schema File** dialog box is the main dialog box for the Define CAD Server Schema File utility. This dialog box allows you to access the menus and other dialog boxes that allow you to create and edit CAD Server Schema (.csd) files. You can resize this dialog box.

### Dialog Box Options

#### Menus

When you first start the Define CAD Server Schema File utility the dialog box is displayed with only the **File** and **Help** menus. Once you have opened a new or existing .csd file, the **Feature Class** and **Options** menus are displayed.

#### Status bar

The status bar of the utility is used to display the template type (scanner type) – MicroStation V7, MicroStation V8, or AutoCAD. If the chosen template is neither MicroStation V7 nor
MicroStation V8 nor AutoCAD, then the status bar will display the value of “Unknown”. This information is displayed immediately after creating/opening a .csd file.

Select Map Files Dialog Box

The Select Map Files dialog box allows you to select the folders and maps for feature classes. You can resize this dialog box.

Dialog Box Options

Available folders
Lists all the available folders you have selected. Initially it will be empty. If the list is not empty when the dialog is initially displayed, the first folder in this list will be pre-selected. The existing folders are associated with the folder icon. The missing folders are associated with a different folder icon and are shown in red color.

New
Displays the Browse For Folder dialog box that allows you to browse for and select the folder or folders that contain your map files. You can select any folder in which the required maps exist. The new folder is automatically made the active folder.

Change
Allows you to change the selected folder to a new folder. The Change button is enabled when a folder is selected in the Available folders list. If the selected folder also contains any selected coordinate system files, then upon changing the folder, a message box appears that asks if the change should reflect the selected coordinate system files. If you click No, then a new folder is added to the folders list and all the selected map files of the previous folder are attached to the new folder irrespective of their existence and the coordinate system files are not disturbed. If you select Yes, then the previous folder is changed to the selected folder and both selected map and coordinate system files are attached to the changed folder irrespective of their existence. The changed folder is automatically made the active folder.

Remove
Allows you to remove the selected folder from the Available folders list. The Remove button is enabled when a folder is selected in the Available folders list.

Map files
Lists all of the map files in the selected folder. This list is pre-populated with all selected map files of all the folders and all the available map files in the selected folder. If all the folders are selected, it lists all the map files of all the folders. A map file can be selected by clicking the associated check box. Any non-existing map files will be displayed in red.

**Files of type**

Allows you to change the filter that controls which map files are displayed in the **Map files** list. You can use wild card filter strings separated by semicolons, such as par*.dgn; inter*.dgn. This does not affect the selected map files. The filter is persisted in the .csd file and is used for the selected folders. For any new folder, the default filter is used. The default filter is *.dgn for a MicroStation V7 or MicroStation V8 template, and *.dwg;*.dxf for the AutoCAD template.

**Select All**

Selects all the unselected files. The **Select All** button is enabled when map files are available in the **Map files** list and at least one map file is not selected. Once all the map files are selected, the button is disabled.

**Unselect All**

Unselects all the selected files. This button control is enabled when map files are available in the **Map files** list and at least one map file is selected. Upon clicking this button all the selected files will be unselected and the button will be disabled.

**OK**

Saves your changes and closes the dialog box. If you have selected coordinate system files, the first coordinate system file is associated with each newly selected map that does not have an associated coordinate system and all the newly selected map file will be associated with all the feature classes that are not associated with map files.

**Cancel**

Closes the dialog box without saving your changes.

**NOTES**

- If you remove a folder and there are .csf files in the folder that are associated with feature classes or map files, then a message box is displayed to inform you that the action will de-select those .csf files and the respective association will be lost.
- If you select map files, then the newly selected map files are associated with the first available .csf file.
- The same map files will also get associated with all the feature classes that are not associated with any map files.
• The already selected map files (which were available when you enter the command) will not get associated with either .csf files or feature classes.

Select Coordinate System Files Dialog Box

The Select Coordinate System Files dialog box allows you to specify the coordinate system files to be associated with the feature classes and with the map files. While working with IGDS design files, you can use either a .dgn file that contains a type-56 element as the coordinate system file, or you can use a .csf file. When working with AutoCAD drawing files or MicroStation V8 design files, you must use a .csf file. This command works in the same way as Feature Class > Select Maps command. You can resize this dialog box.

Dialog Box Options

Available folders
Lists all the available folders you have selected. Initially it will be empty. If the list is not empty when the dialog is initially displayed, the first folder in this list will be pre-selected.

New
Displays the Browse For Folder dialog box that allows you to browse for and select the folder or folders that contain your map files. You can select any folder in which the required maps exist. The new folder is automatically made the active folder.

Change
Allows you to change the selected folder to a new folder. All the selected files of selected folder will be attached to the changed folder irrespective of their existence in the new folder location. The changed folder is automatically made the active folder. The Change button is enabled when a folder is selected in the Available folders list.

Remove
Allows you to remove the selected folder from the Available folders list. The Remove button is enabled when a folder is selected in the Available folders list.

Coordinate system files
Lists all of the coordinate system files in the selected folder. This list is pre-populated with all available selected coordinate system files. If all the folders are selected, it lists all the
coordinate system files of all the folders. A coordinate system file can be selected by clicking the associated check box.

**Files of type**

Allows you to change the filter that controls which map files are displayed in the **Coordinate system files** list. You can use wild card filter strings separated by semicolons, such as `par*.csf`; `inter*.csf`. This does not affect the selected coordinate system files. The filter is persisted in the `.csd` file.

**Select All**

Selects all the unselected files. The **Select All** button is enabled when map files are available in the **Coordinate system files** list and at least one map file is not selected. Once all the coordinate system files are selected, the button is disabled.

**Unselect All**

Unselects all the selected files. This button is enabled when map files are available in the **Coordinate system files** list and at least one coordinate system file is selected. Upon clicking this button all the selected files will be unselected and the button will be disabled.

**OK**

Saves your changes and closes the dialog box. By default, the first selected coordinate system file will be associated with all the selected map files and with all the feature classes that do not have an association with coordinate system file.

**Cancel**

Closes the dialog box without saving your changes.

**NOTES**

- If you remove a folder in this command and there are map files in this folder that are associated with feature classes, then a message box is displayed to inform you that the action will de-select those map files and the association of feature class to map file will be lost.
- If you select `.csf` files, then the first available newly selected `.csf` file will get associated with all the map files and feature classes which are not associated with any `.csf` files.
- The same `.csf` files will also get associated with all the feature classes that are not associated with any `.csf` files.
- The already selected `.csf` files (which were available when you enter the command) will not get associated with either map files or feature classes.
Define Feature Class Dialog Box

The Define Feature Class dialog box allows you to create, edit, copy, or delete feature definitions. The list view contains the list of feature classes already defined in the .csd file, along with the buttons for New, Edit, Copy, Delete, and Close operations. When you select multiple feature classes, the Edit and Copy buttons are disabled. You can resize this dialog box.

Dialog Box Options

Feature classes
Lists all the feature classes. Multiple feature classes can be selected at a time. The first feature class will be selected automatically. You can <Ctrl> click on a selected feature class as a means of de-selecting a feature class.

New
Displays the New - <feature class name> dialog box, which allow you to define the new feature class. This button will always be enabled.

Edit
Allows you to select any single feature class and edit it. This button will be enabled only when a single feature class is selected.

Copy
Allows you to copy the a selected feature class definition. Selecting a feature class and then clicking Copy displays the Copy - <feature class name> dialog box with the properties of the selected feature class. You can modify and rename this copy of the original feature class in order to more quickly create a feature class definition that shares many of the parameters of the original feature class definition. This button will be enabled only when a single feature class is selected from the given list.

Delete
Deletes the selected feature classes from the schema file. This button will be enabled when you select one or more feature classes. You will be prompted with a confirmatory warning message when you click this button.

Close
Closes the Define Feature Class dialog box.
New (Feature Class Definition) Dialog Box

The New <feature class name> dialog box allows you to define a new feature class for your .csd file. This dialog box is displayed when you click New, Edit, or Copy in the Define Feature Class dialog box. The caption of this feature class definition dialog box will be New – <Feature Class Name>, Copy – <Feature class Name>, or Edit - <Feature Class Name> based on the option you chose. The dialog box is opened in the view as a modeless dialog box, enabling you to run other commands while you are within the feature class definition process.

Tabs

General (see "General Tab" on page 91)

Graphic Attributes (see "Graphic Attributes Tab" on page 93)
Criteria (see "Criteria Tab" on page 94)
Tags (see "Tags Tab" on page 95)
Linkages (see "Linkages Tab" on page 96)

General Tab

The General tab allows you to specify the Name, Geometry type, and Primary geometry for a feature class. You can optionally specify whether you want to serve/expose database attributes by enabling the database linkage option. For AutoCAD .csd files, you can also specify whether the feature class has tags.

For AutoCAD .csd files, there is an additional checkbox This feature class has tags on the General tab and two additional tabs (Tags and Linkages). These two tabs are enabled only if the respective checkboxes are selected. In case of an "unknown" type of scanner the feature class will have neither the database linkage nor the block attributes.

Tab Options

Name

Allows you to specify the name of the new feature class. You can edit the feature class name. You must key in a valid, unique name for the feature class in the Name field.
**Geometry type**

Allows you to specify the geometry type for the new feature class by selecting the check box by one or more geometry types. This is a list of all the geometry fields. Select the **Geometry type(s)** for the feature class by checking the respective check box(es) to the left of each **Geometry type**. You can select multiple geometry types for a feature class. In this case, the feature class will have multiple geometry columns. Graphic elements that do not conform to the geometry type chosen are served up with NULL values in the geometry column. For example, if **Line** is chosen as the geometry type and if the feature class is defined as all graphics (that is, all the graphics of the **Compound** geometry type) on level 1, then **Point**, **Text**, and **Area** geometries that are found on level 1 will be served up with NULL as the value in the geometry column.

**Note**: Point geometry will contain the origin point for text and text node elements. If you want to use a text feature for spatial operations, both **Point** and **Text** attributes should be exposed, and **Point** should be selected as the primary geometry.

**Primary geometry**

Allows you to specify the geometry type that is the primary geometry type for the new feature class, by selecting it from the drop-down list of geometry types. The choices available on the list are:

- **PointGeometry**
- **LinearGeometry**
- **AreaGeometry**
- **TextGeometry**

This is a mandatory field. **TextGeometry** can be set as the primary geometry type only when no other geometry type is selected.

**This feature class has database linkages**

Allows you to specify that the new feature class has database linkages. This option (along with the **Tags** tab and the **Linkages** tab) will appear only for AutoCAD, MicroStation V7, and for the MicroStation V8 template .csd files. This check box must be checked if the feature class has block attribute information (which is also known as **Tags**). Upon checking this check box, the **Linkages** tab is enabled. If a feature class is linked to a database table, all the attributes from that table will be exposed in IMAGINE. The **Linkages** tab allows you to specify the database table name and the link field name associated with the feature class. If the primary key for database linked feature classes has not been specified, then by default the link field name will be taken as the primary unique key.
This feature class has tags (block attributes)

Allows you to specify that the new feature class has tags (block attributes). This option only appears if your .csd file is of the AutoCAD type. Select this option if the feature class has block attribute information (also known as tags). When you select this option the Tags tab will be enabled.

OK

Accepts your input and closes the dialog box.

Cancel

Dismisses the dialog box without saving the parameters you entered.

Graphic Attributes Tab

The Graphic Attributes tab allows you to select the graphic attributes for a feature class. Any enabled graphic attributes will be available for use in IMAGINE.

Tab Options

Graphic Attribute Name

Lists the available graphic attributes that you can select for the feature class. This tab has a grid that is populated with the list of all the graphic attributes (defined in the template file). To add a particular graphic attribute to the schema of the feature class, you must check the corresponding check box to the left of the Graphic Attribute Name. The Graphic Attribute Name column of the grid is read only. You must select all the graphic attributes you want the CAD data server to expose for the new feature class. See the AutoCAD Scanner (on page 124), IGDS Scanner (on page 134), and MicroStation Version 8 Scanner (on page 145) sections in the Appendix for the list of the supported graphic attributes for each of the CAD data server scanners.

For IGDS/MicroStation V8-based projects, if the data has database linkages and if the CAD data server has to serve up attribute data from the database, both the Database to Table Linkage (that is, EntityNumber) and the Database to Row Linkage attribute (that is, OccurrenceNumber) will be selected by default. Either of the linkage attributes (EntityNumber/OccurrenceNumber) must be selected for every database-linked feature class.
Overview of the Define CAD Server Schema File Utility

Type
Lists the data type defined for each graphic attribute. The Type column of the grid is read only.

Select All
Selects all of the graphic attributes for the feature class.

Unselect All
Unselects all of the graphic attributes.

OK
Saves all of your changes and closes the dialog box. If any map files have been selected on the Select Maps dialog box and if no map file has previously been associated with the feature class, then by default all the selected map files will be associated with the feature class. If any coordinate system files have been selected on the Select Coordinate System Files dialog box and if no coordinate system file has previously been associated with the feature class, then by default the first coordinate system file will be associated with the feature class.

Cancel
Closes the dialog box without saving your changes.

Criteria Tab
The Criteria tab allows you to specify the Attribute Name and Classification Criteria that allow the CAD data server to identify and serve up a feature class.

Tab Options

Attribute Name
Lists the attributes available for the feature class. This tab has a grid that is populated with all those graphic attributes that can be used to set the criteria for the feature class. The Attribute Name column of the grid is read only.

Type
Lists the data type defined for each attribute. The Type column of the grid is read only.

Classification Criteria
Allows you to specify the criteria for a particular attribute that the CAD data server is to use to identify the feature class. You must set the criteria on a particular attribute by selecting the
attribute (using the check box in the first column) and specifying the values in the **Classification Criteria** column. These values define the criteria the CAD data server uses to decide if a graphic element is a member of the feature class. See the appendix for the list of supported feature class definition attributes. The criteria must be set on at least one attribute for the feature class definition to be complete.

**NOTE**  **EntityNumber** must be included in the feature classification criteria for MicroStation database-linked feature classes. Therefore, it will be automatically selected and cannot be de-selected if the **This feature has database linkages** option is selected.

You can key in individual values or a range of values. For attributes of the Boolean type, you must enter either 1 for true or 0 for false. For example, if all road features reside on level 1, you could key in 1 in the **Classification Criteria** field. If road features were on levels 1 through 5, you could key in:

1-5
1,2,3,4,5
OR
1,2,3-5

**OK**

Saves all the changes you have made and closes the dialog box. If any map files have been selected on the **Select Maps** dialog box and if no map file has been previously associated with the feature class, then by default all the selected map files will be associated with the feature class. If any coordinate system files have been selected on the **Select Coordinate System Files** dialog box and if no coordinate system file has been previously associated with the feature class, then by default the first coordinate system file will be associated with the feature class.

**Cancel**

Closes the dialog box without saving your changes.

---

**Tags Tab**

The **Tags** tab appears only for AutoCAD .csd files where you have selected **This feature class has tags (block attributes)** on the **General** tab. It allows you to select the tags that apply to the feature class.
Overview of the Define CAD Server Schema File Utility

Tab Options

Name
Lists the available tags. You can select the tags that apply to the feature class by checking the check box to the left of the tag Name.

Type
Lists the Type of the available tags.

Size
Lists the Size of the available tags.

Show Available Tags
This button will be enabled if map file(s) are selected. Clicking this button causes the grid to be populated with the available block attributes found in the associated map files. If no map files are associated with the feature class, then the grid is populated with the tags (block attributes) from all the selected map files. Once you select tags (block attributes), the selection is retained irrespective of changes in the map file list.

Select All
Selects all of the displayed tags for the feature class.

Unselect All
Unselects all of the displayed tags.

OK
Saves all the changes you have made. If any map files have been selected on the Select Maps dialog box and if no map file has been previously associated with the feature class, then by default all the selected map files will be associated with the feature class. If any coordinate system files have been selected on the Select Coordinate System Files dialog box and if no coordinate system file has been previously associated with the feature class, then by default the first coordinate system file will be associated with the feature class.

Cancel
Closes the dialog box and you will lose all the changes done to the feature class definition.

Linkages Tab

In case of template file of AutoCAD type the Linkage tab will be enabled. The Linkage tab is available only with AutoCAD .csd files. The Linkage tab allows you to specify the database
Overview of the Define CAD Server Schema File Utility

Table Name and the Link Field Name associated with the feature class. If a feature class is linked to a database table, all the attributes from that table will be exposed in IMAGINE.

Tab Options

Table Name
Allows you to specify the database Table Name associated with the feature class.

Link Field Name
Allows you to specify the Link Field Name associated with the feature class. If you have not specified the primary key for database linked feature classes, then by default the Link Field Name will be taken as the primary unique key.

OK
Saves all the changes you have made. If any map files have been selected on the Select Maps dialog box and if no map file has been previously associated with the feature class, then by default all the selected map files will be associated with the feature class. If any coordinate system files have been selected on the Select Coordinate System Files dialog box and if no coordinate system file has been previously associated with the feature class, then by default the first coordinate system file will be associated with the feature class.

Cancel
Closes the dialog box without saving your changes.

Edit Coordinate System to Map Associations Dialog Box

The Edit Coordinate System to Map Associations dialog box allows you to edit a map file's association with the coordinate system files. This command is enabled only if the map files and coordinate system files have been selected. You can resize this dialog box.

Dialog Box Options

Available coordinate system files
Lists all the coordinate system files or the selected coordinate system files depending on the option you have selected on the Select Coordinate System Files dialog box. This list box is single-selectable.
All/Associated/Dissociated map files
Lists the map files you selected on the Select Map Files dialog box. This list is multi-selectable. The title and content of this list changes depending on what Display option you have selected.

Coordinate system to map associations
Shows the association of each coordinate system file with one or more map(s). In this tree view, the coordinate system files are the root nodes and the map(s) associated with them form the leaf nodes below the coordinate system files.

Associate
Allows you to associate a coordinate system file with one or more map(s). Select a coordinate system file in the Available coordinate system files list and select one or more maps in the All/Associated map files list, then click Associate to associate the selected map files with the selected coordinate system file. The Associate button is enabled when you select a map file that is not associated with a coordinate system file.

Dissociate
Allows you to dissociate a coordinate system file from one or more map(s). Select a coordinate system file in the Available coordinate system files list and select one or more maps in the All/Associated map files list, then click Dissociate to dissociate the selected map files from the selected coordinate system file. The Dissociate button is enabled when you select a map file that is associated with a coordinate system file.

Display
Allows you to choose to display All map files, Associated map files, or Disassociated map files by selecting one of these options from the drop-down list. Selecting All map files displays all the available map file names in the All map files list box. Selecting Associated map files displays the map files associated with the selected coordinate system file from the Available coordinate system files list box. Selecting Disassociated map files displays the map files that are not associated with the selected coordinate system file from the Available coordinate system files list box.

OK
Closes the dialog box and saves your changes.

Cancel
Closes the dialog box without saving your changes.
Overview of the Define CAD Server Schema File Utility

Edit Coordinate System to Feature Class Associations Dialog Box

The Edit Coordinate System to Feature Class Associations dialog box allows you to edit the associations of feature classes with a coordinate system files. The workflow of this command is similar to that for the Edit Coordinate System to Map Associations dialog box. This command is enabled only if the coordinate system files have been selected and the feature classes have been defined. You can resize this dialog box.

Dialog Box Options

Available coordinate system files
Lists all the coordinate system files or the selected coordinate system files depending on the option you selected on the Select Coordinate System Files dialog box. This list box is single-selectable.

All/Associated/Dissociated feature classes
Lists all the feature classes defined in the .csd file. This is multi-selectable. The title and content of this list changes depending on what Display option you have selected.

Coordinate system to feature class associations
Shows the association of each coordinate system file with one or more feature classes. The coordinate system files are the root nodes and the feature class(es) associated with them form the leaf nodes below the coordinate system files.

Associate
Allows you to associate a coordinate system file with one or more feature class(es). Select a coordinate system file in the Available coordinate system files list and select one or more feature classes in the All/Dissociated feature classes list, then click Associate to associate the selected feature classes with the selected coordinate system file. The Associate button is enabled when you select a feature class that is not associated with a coordinate system file.

Dissociate
Allows you to disassociate a coordinate system file from one or more feature class(es). Select a coordinate system file in the Available coordinate system files list and select one or more feature classes in the All/Associated feature classes list, then click Dissociate to dissociate the selected feature classes from the selected coordinate system file. The Dissociate button is enabled when you select a feature class that is associated with a coordinate system file.
Display
Allows you to choose to display All feature classes, Associated feature classes, or Disassociated feature classes by selecting one of these options from the drop-down list. Selecting All feature classes displays all the available feature class names in the All feature classes list box. Selecting Associated feature classes displays the feature classes that are associated with the selected coordinate system file from the Available coordinate system files list box. Selecting Disassociated feature classes displays the feature classes that are not associated with the selected coordinate system file from the Available coordinate system files list box.

OK
Closes the dialog box and saves your changes.

Cancel
Closes the dialog box without saving your changes.

Edit Feature Class to Map Associations Dialog Box
The Edit Feature Class to Map Associations dialog box allows you to edit the association of map files with the feature classes. This command is enabled only if the map files have been selected and the feature classes have been defined. You can resize this dialog box.

Dialog Box Options

Available feature classes
Lists all the feature classes available in the .csd file and is multi-selectable.

All/Associated/Dissociated map files
Lists the map files available in the .csd file and is multi-selectable. The title and content of this list changes depending on what Display option you have selected.

Feature class to map associations
Shows the association of each feature class with one or more map files. In this tree view the feature classes are the root nodes and the map files associated with them form the leaf nodes below the feature classes.

Associate
Overview of the Define CAD Server Schema File Utility

Allows you to associate map file(s) to one or more feature classes. Select a feature class in the Available feature classes list and select one or more maps in the All/Disassociated map files list, then click Associate to associate the selected map files with the selected feature class. The Associate button is enabled when you select a map file that is not associated with a feature class.

Disassociate
Allows you to dissociate map file(s) from one or more feature classes. Select a feature class in the Available feature classes list and select one or more maps in the All/Associated map files list, then click Dissociate to dissociate the selected map files from the selected feature class. The Dissociate button is enabled when you select a map file that is associated with a feature class.

Display
Allows you to choose to display All map files, Associated map files, or Disassociated map files by selecting one of these options from the drop-down list. Selecting All map files displays all the available map file names in the All map files list box. Selecting Associated map files displays the map files associated with the selected feature class from the Available feature classes list box. Selecting Disassociated map files displays map files that are not associated with the selected feature class from the Available feature classes list box.

OK
Closes the dialog box and saves your changes.

Cancel
Closes the dialog box without saving your changes.

Specify Connection Parameters Dialog Box

The Specify connection Parameters dialog box allows you to specify the connection parameters for your .csd file.

Dialog Box Options

Warehouse configuration file
Overview of the Define CAD Server Schema File Utility

Allows you to specify the warehouse configuration file name. See the .INI File (on page 107) section for the more information about .ini file variables. You can use the Warehouse Configuration Utility to create .ini files.

**Browse**

Allows you to browse for the warehouse configuration file. Clicking **Browse** displays the **Select a warehouse configuration file** dialog box has a default filter **INI Files (*.ini)**. The **All Files** filter is also available.

**ODBC data source**

Allows you to select an ODBC data source from a drop-down list of all available ODBC data source on your system. This is required if you want to expose CAD attributes that are stored in a database. You can also enter any other name in the text field and create the ODBC data source name at a later time. Validation of the ODBC data source is not done. The ODBC data source name should point to the database where the CAD attributes are stored.

**User ID**

Allows you to specify the user id of the ODBC data source, if required.

**Password**

Allows you to specify the password for the ODBC data source, if required.

**Additional ODBC parameters**

Allows you to specify additional information (if any) about the ODBC data source.

**NOTE** Consult your database vendor or web resources for ODBC connection-specific parameters.

---

**Primary Unique Key Dialog Box**

The **Primary Unique Key** dialog box allows you to specify which graphic attribute the CAD server is to use to define the primary unique key for all graphic-only feature classes and for all database-linked feature classes. This dialog box has two controls to set the primary key:

- Select primary unique key for all the graphic only feature classes
- Select primary unique key for all the database linked feature classes

The lists are populated with the list of the graphic attributes.
Dialog Box Options

Select primary unique key for all the graphic only feature classes:

Name
Displays a list of the default graphic attribute names. The Name corresponds to the name of the graphic attribute. You can check the corresponding check box of a particular attribute to make it a primary unique key. You can modify the primary key name once you have selected it as the primary key. Once the primary key is selected the name text becomes editable. You can set the primary key on only one graphic attribute. By default, the graphic attribute ID is selected as the primary key for all the graphic only feature classes and the database linked feature classes. If ID is set as the primary key, then it is added to the list of graphic attributes to be exposed for the feature class. Note that the ID field is not listed in the graphic attributes tab of the feature class definition dialog box (for example the New - <Feature Class Name> dialog box).

Select primary unique key for all the database linked feature classes

Name
Displays a list of the default graphic attribute names. The Name corresponds to the name of the graphic attribute. You can check the corresponding check box of a particular attribute to make it a primary unique key. You can modify the primary key name once you have selected it as the primary key. Once the primary key is selected the name text becomes editable. You can set the primary key on only one graphic attribute. By default, the graphic attribute ID is selected as the primary key for all the graphic only feature classes and the database linked feature classes.

OK
Saves your changes and closes the Primary Unique Key dialog box.

Cancel
Closes the Primary Unique Key dialog box without saving your changes.

NOTE  In the case of AutoCAD template type, nothing might be selected as primary unique key for all the database linked feature classes. In that case, by default, the respective link field name will be taken as the primary unique key for the database linked feature classes.
Overview of the Define CAD Server Schema File Utility

Advanced Database Linkage Dialog Box

The Advanced Database Linkage dialog box allows you to specify the database linkage options if you want the CAD server to serve up attribute data from a database. This dialog box allows you to define what characteristic(s) of the elements in the map file the CAD server is to use to define the database linkages. This command is enabled only if a feature class exists with the database linkages.

Dialog Box Options

Select graphic to database table linkage:

- **Graphic Attribute Name**
  Displays a list of the available graphic attributes. Select the check box by the Graphic Attribute Name to specify what graphic attribute has to be used to define the graphic-to-database-table linkages. **EntityNumber** is the default for MicroStation (IGDS) template.

- **Database Scanner Attribute Name**
  Displays a list of the available database scanner attributes. Change the Database Scanner Attribute Name if it is different from the column name in your database. For example, **OccurrenceNumber** is associated with the MSLINK column by default in the Graphic to database row linkage group (for MicroStation IGDS template). If your database column name is different, you must edit the Database Scanner Attribute Name to match your database.

Select graphic to database row linkage:

- **Graphic Attribute Name**
  Displays a list of the available graphic attributes. Select the check box by the Graphic Attribute Name to specify what graphic attribute has to be used to define the graphic-to-database-row linkages. **OccurrenceNumber** is the default for MicroStation (IGDS) template.

- **Database Scanner Attribute Name**
  Displays a list of the available database scanner attributes. Change the Database Scanner Attribute Name if it is different from the column name in your database. For example, **OccurrenceNumber** is associated with the MSLINK column by default in the Graphic to database row linkage group (for MicroStation IGDS template). If your database column name is different, you must edit the Database Scanner Attribute Name to match your database.

**OK**

Saves your changes and closes the Advanced Database Linkage dialog box.

**Cancel**

Closes the Advanced Database Linkage dialog box without saving your changes.
For .csd files based on the MicroStation V7 template, the Database Scanner Attribute Name, for both graphic to table linkage (typically EntityNumber), and graphic to row linkage (typically MSLINK) must be referenced in the database table MSCATALOG.

**Update Map MBRs Dialog Box**

The **Update Map MBRs** dialog box allows you to get the minimum bounding rectangle (MBR) information for the map files in your .csd file. This command is enabled only if the map files have been selected. You can resize this dialog box.

**Dialog Box Options**

- **Select All**
  Allows you to select all of the unselected map files for processing.

- **Unselect All**
  Allows you to unselect all of the selected map files.

- **Apply**
  Processes the selected map files for MBR values and updates them to the .csd file. This button is enabled when you select one or more map files. Clicking **Apply** updates the X Low, X High, Y Low, and Y High fields and saves the values to the .csd file. If the map file cannot be processed, the X Low, X High, Y Low, and Y High will be updated with NULL values. If a particular map file could not be opened, then the Status column will be updated with relevant information. In the case of an "Unknown" .csd file type, clicking **Apply** updates the keyed in MBR values to the .csd file.

- **Close**
  Closes the Update Map MBRs dialog box.

**Grid Control**

The **Update Map MBRs** dialog box contains a grid control. This grid control's first column is a check box that allows you to select the map file. The second column is populated with all the selected map files irrespective of their association to a feature class. The columns of the grid control for displaying MBRs (X Low, X High, Y Low, and Y High) are non-editable for .csd files built from the known template files (AutoCAD, MicroStation V7, and MicroStation V8). For .csd
files of an "unknown" type, you must key in these values. The fifth column (Map File Status) is only present for known template files (AutoCAD, MicroStation V7, and MicroStation V8).

Upon selection of one or more map files, the Apply button will be enabled. Clicking Apply causes the files to be populated with the MBR coordinates of the map files and saves those coordinates to the .csd file. If a particular map file could not be opened, then the Map File Status column will be updated with the relevant information. If the map file cannot be processed, the MBR values will be updated with NULL values.

For .csd files of the "unknown" type, the X Low, X High, Y Low, and Y High columns are editable to allow you to key in MBR values. You can update the MBR values by keying in the values by selecting a particular map file.

Clicking Apply updates the keyed in MBR values to the .csd file.

### Updating Map MBRs

The MBR coordinates of the selected map files of a .csd file can be updated in any of the following two ways:

- **Running the DefCSD utility**: If you have a .csd file for which MBR coordinates of the selected map files are not updated, then the desired Update MBRs command can be run from the Options menu after opening the .csd file.

- **Using command line**: If you want to update only the MBR coordinates of an existing .csd file without invoking the GUI then any one of the given two command line options can be used.

  - `defcsd <.csd file name with the path> /u` - where the argument /u causes the software to update the MBR coordinates without invoking the GUI. The software displays an error message if automatic MBRs calculation functionality is not supported for a particular type of scanner. In this case, you must explicitly open the Define CAD Server Schema File utility and key in the MBR coordinate values for each map using the X Low, X High, Y Low, and Y High fields.

  - `updatembr <csd file name with the path>` - This option is supported for backward compatibility. The functionality of this command line option is exactly the same as the earlier one. The UpdateMBR executable is a wrapper around the DefCSD functionality. The UpdateMBR utility internally calls the DefCSD utility with the parameter /u.
.INI File

AutoCAD Scanner

The .ini file has to be specified in the .csd file. This section explains the variables that can be used in the .ini file to specify the behavior of the CAD-AutoCAD server.

For serving blocks:

An AutoCAD "block" can be composed of many types of subordinate elements. An AutoCAD block is manifest in an AutoCAD .dwg file through an "insert". Each insert has its own location, rotation, scaling, and so forth. Each of the constituent entities within the block can be from a different layer, with its own set of graphic properties while the block itself can be in a different layer. The block entity is served based on the .ini file variables. Any one or more of the following .ini file settings may be used:

- **SERVE BLOCK ORIGIN:** TRUE/FALSE – do or do not serve the block's origin as an OrientedPointGeometry in a field of type/subtype gdbSpatial/gdbPoint. The default value is TRUE.

- **SERVE BLOCK GEOMETRY:** TRUE/FALSE/EXPLODE – If the value is set to TRUE, the data server serves the block's spatial components as a GeometryCollection in a field of type/subtype gdbSpatial/gdbAnySpatial. If the value is set to FALSE, the block's spatial components are not served. The default value is FALSE. If this option is TRUE, but a particular block does not contain geometry, then a NULL geometry is served for that block.

- If the value is set to EXPLODE, the data server processes each of the block's spatial components as separate entities. Thus, the data server will generate different records for a block entity, with the graphic properties of the constituent components. The feature class criteria are applied on each of the spatial components individually.

- For example, suppose that a particular block has three polyline entities. When this .ini variable is set to TRUE, the data server will serve the block as a collection of the polyline geometries with the graphic properties of the block. When the .ini variable is set to FALSE, the data server will not serve the geometry – a NULL geometry is served with the graphic properties of the block. When this .ini variable is set to EXPLODE, the data server will serve three different records for each of the polyline entity with the graphic properties of the respective components.

- **SERVE BLOCK TEXT:** TRUE/FALSE/EXPLODE – If the value is set to TRUE, the data server serves the block's text components as a GeometryCollection in a field of type/subtype...
gdbGraphic/gdbGraphicsText. If the value is set to FALSE, the block’s text components are not served. The default value is FALSE. If this option is TRUE, but a particular block does not contain text, then a NULL geometry is served for that block.

- If the value is set to EXPLODE, the data server processes the block’s text components as separate entities. Thus, the data server will generate different records for a block entity, with the graphic properties of the respective text components. The feature class criteria are applied on each of the text components individually. For example, suppose that a particular block has three text components with the text strings "text1", "text2", "text3". When this .ini variable is set to TRUE, the data server will serve this as a collection of text geometries with the graphic properties of the block. When the .ini variable is set to FALSE, the data server will not serve the geometry – a NULL geometry is served with the graphic properties of the block. When this .ini variable is set to EXPLODE, the data server will serve three different records for each of the text components with the graphic properties of the respective text components. In the .csd file, the fields must be defined with the appropriate geometry types/subtypes, for receiving the various block data. If the user requests the origin without providing a Point field, requests the geometry without providing an AnySpatial field, or requests the text without providing a GraphicsText field, then the .ini file variables will be ignored.

**For serving text:**

The following .ini file variables help the user in specifying the font details to serve the text (stored in AutoCAD SHX fonts) in rich text format.

- **SERVE RICH TEXT: TRUE/FALSE:** The user can specify that all the text be served as rich text with this .ini variable. The default value of this variable, in the absence of the text font related .ini variables (SERVE RICH TEXT and FONT NAME), is FALSE. The user will ignore the LegendEntry extension served by the data server for the text features populated in rich text format if SERVE RICH TEXT is set to TRUE.

- **FONT NAME <xyz> =** This .ini file variable is used to map the AutoCAD SHX font name to the font name of rich text format, along with the font pitch, font family, character set, bold and italic qualifiers and the scaling factor for the corresponding font. This helps in serving the text in user specified font. The user can specify the font scaling factor (with the fscale: identifier) to be used to map the text height to the font size, while serving the text in RTF. This value will be multiplied with the text height (in drawing units) and rounded off to the nearest integer to get the font size of the RTF text. The default value of the font scaling factor, is 10. This value is required on a per font basis because the character size might differ from font to font. The value specified against the charset: identifier specifies the
character set of a font in the font table. Default value of this identifier is 0. The value specified against the pitch: identifier specifies the pitch of the font in the font table. The valid values for the pitch identifier are 0 (default pitch), 1 (fixed pitch) and 2 (variable pitch). The default value of this identifier is 0. The value specified against the family: identifier specifies the family of the font in the font table. The valid values are nil, roman, swiss, modern, script, decor, tech, bidi. The default value of this identifier is "nil". Refer to the Rich Text (RTF) Format Specification (see "Rich Text Format (RTF) Specification" on page 163) section for more details on font pitch, font family and charset.

- You must mention the mapping for all the SHX fonts used in the drawing file. For true type fonts, the scaling factor alone has to be specified. The syntax is as follows: FONT NAME <name1> = <font name1>[,b][,i][,fscale:<value>][,pitch:<0/1/2>][,family:<nil/roman/swiss/modern/script/tech/bidi>][,charset:<value>] FONT NAME <name2> = <font name2>[,b][,i][,fscale:<value>][,pitch:<0/1/2>][,family:<nil/roman/swiss/modern/script/tech/bidi>][,charset:<value>] DEFAULT FONT = <font name3>[,b][,i][,fscale:<value>][,pitch:<0/1/2>][,family:<nil/roman/swiss/modern/script/tech/bidi>][,charset:<value>] The keyword DEFAULT FONT allows all the text elements (other than those mapped explicitly in the .ini file) to be displayed in the font as specified against the keyword DEFAULT FONT. Example: FONT NAME RomanT.SHX = Times New Roman,b,fscale:50 FONT NAME Italic.SHX = Arial,I FONT NAME Times New Roman = Times New Roman,fscale:50 DEFAULT FONT = Courier New,b,fscale:8 In the above example, the AutoCAD SHX font "RomanT" will be mapped to "Times New Roman" font and text will be bold and the font size of the text will be 50 times the text height in drawing units – this means that if the AutoCAD text entity had a text height of 0.2 drawing units, the RTF text will be served with a font size of 10. In the above example, AutoCAD SHX font "Italic" will be mapped to "Arial" font with a font scaling of 10, which is the default font scale factor and a font scaling factor of 50 will be applied to the TrueType font "Times New Roman". The font names specified in the .ini file will not be validated. If the client does not recognize the font name for a particular text element, then the display font for that text element will be according to the client’s behavior. In the absence of the font mapping keyword in the .ini file, or in the absence of a mapping for a particular font name and the DEFAULT FONT, the default font of Arial will be used. The font mapping specified in the .ini file is ignored if the .ini variable SERVE RICH TEXT: is set to FALSE.
**MAXIMUM NUMBER OF FILES OPEN keyword:**

By design, AutoCAD Scanner scans all drawing files in a dataset to determine if the elements within each drawing file match the criteria specified for the feature class definition. The scanner subsequently reads only the matching elements to serve the necessary attributes and geometry. Opening and closing the drawing file for each process stage is costly and can result in poor performance; however, keeping all the drawing files open might lead to excessive memory consumption, especially in cases where the dataset contains many drawing files. As a result, the data server, by default, keeps only a maximum of 100 drawing files concurrently open. This usually provides a good balance between application memory consumption and performance. For dataset cases where this default number of concurrently open files is not optimal, the keyword “MAXIMUM NUMBER OF FILES OPEN” can be set to a more appropriate number for the given dataset. The default value is 100.

Usage: MAXIMUM NUMBER OF FILES OPEN: 10

**IGDS Scanner**

The .ini file has to be specified in the .csd file. This section explains the variables that can be used in the .ini file to specify the behavior of the CAD-IGDS server.

**For serving cells:**

If the cell is an orphan cell, the cell components will be served as a BoundaryGeometry in a field of type/subtype gdbSpatial/gdbAreal. For all other circumstances, the cell is served based on the .ini variables. Any one or more of the following .ini file settings may be used.

- **SERVE CELL ORIGIN:**TRUE/FALSE – do or do not serve the cell’s origin as an OrientedPointGeometry in a field of type/subtype gdbSpatial/gdbPoint. The default value is TRUE.
- **SERVE CELL GEOMETRY:**TRUE/FALSE – do or do not serve the cell’s spatial components as a GeometryCollection in a field of type/subtype gdbSpatial/gdbAnySpatial. The default value is FALSE. If this option is TRUE, but a particular cell does not contain geometry or contains any unsupported elements, then a NULL geometry is served for that cell.
- **SERVE CELL TEXT:**TRUE/FALSE – do or do not serve the cell’s text components as a GeometryCollection in a field of type/subtype gdbGraphic/gdbGraphicsText. The default value is FALSE. If this option is TRUE, but a particular cell does not contain text, then a NULL geometry is served for that cell.
The above *.ini* options are not mutually exclusive. In the *.csd* file, the fields must be defined with the appropriate geometry types/subtypes, for receiving the various cell data. If the user requests the origin without providing a Point field, requests the geometry without providing an AnySpatial field, or requests the text without providing a GraphicsText field, then the *.ini* file variables will be ignored.

**For text justification:**

By default the "Justification" characteristic of IGDS text is faithfully carried through to the “Alignment” property of each corresponding TextPointGeometry.

IGDS text is always stored with a lower left origin. Therefore, in order to correctly position each TextPointGeometry, the data server by default calculates its origin by starting with the IGDS text origin and adding either half (for Center) or all (for Right/Upper) of the text width or height, according to the Justification setting.

Unfortunately, the exact text width and height of IGDS text cannot be accurately determined, so in many instances in which you have center or right/top justified text, the TextPointGeometry appears to be in the wrong location. The following *.ini* variables can be used to eliminate the text positioning errors.

- **FORCE TEXT JUSTIFICATION: LOWERLEFT / CENTERLEFT / UPPERLEFT:** You can serve all of your text left-justified using this *.ini* variable. This *.ini* variable sets the alignment of each output TextPointGeometry to the designated setting, minimizing or eliminating text positioning errors. By default, in the absence of this *.ini* variable, each IGDS text element is served with its actual justification.

- **TEXT ORIGIN BY RANGE: TRUE/FALSE:** The text origin is calculated based on the element range using this *.ini* variable. Setting this variable preserves the actual alignment of each output TextPointGeometry while calculating the position from the text element range. By default, in the absence of this *.ini* variable, each IGDS text element is served with its
position calculated from the origin. If the .ini variable **FORCE TEXT JUSTIFICATION** is present, it overrides the .ini variable **TEXT ORIGIN BY RANGE**. The default behavior in the absence of this .ini variable is FALSE.

- If this variable is set to TRUE, the text origin is calculated based on the element range (xlo, xhi, etc.) and that position is returned as the origin of the TextPointGeometry, with the proper alignment.

**For Text font:**

The following .ini variables help you in specifying the font details to serve the text in rich text format.

- **SERVE RICH TEXT: TRUE/FALSE**: The user can specify that all the text be served as rich text with this .ini variable. The default value of this variable, in the absence of the text font related .ini variables (**SERVE RICH TEXT** and **FONT MAPPING**), is FALSE. The user will ignore the LegendEntry extension served by the data server for the text features populated in rich text format if SERVE RICH TEXT is set to TRUE.

- **FONT NUMBER <xyz> =** This .ini variable is used to map the MicroStation font number to the font name of rich text format, along with the font pitch, font family, character set, bold, underline, italic qualifiers and the scaling factor for the corresponding font. This helps in serving the text in a user-specified font. IGDS text element has the font information as the font number, which is again mapped to the font name, using an external font resource file. You can specify the font scaling factor (with the fscale: identifier) to be used to map the text height to the font size, while serving the text in RTF. This value will be multiplied with the text height (in decimal master design file units) and rounded off to the nearest integer to get the font size of the RTF text. The default value of the font scaling factor, is 0.1. This value, in terms of decimal master design file units, is required on a per font basis because the character size differs from font to font. The default value is 0.1. The value specified against the charset: identifier specifies the character set of a font in the font table. Default value of this identifier is 0. The value specified against the pitch: identifier specifies the pitch of the font in the font table. The valid values for the pitch identifier are 0 (default pitch), 1 (fixed pitch) and 2 (variable pitch). The default value of this identifier is 0. The value specified against the family: identifier specifies the family of the font in the font table. The valid values are nil, roman, swiss, modern, script, decor, tech, bidi. The default value of this identifier is “nil”. Refer to the *Rich Text Format (RTF) Specification* (on page 163) section for more details on font pitch, font family and charset.
You must mention the mapping for all the font numbers used in the design file. The syntax is as follows:

```
FONT NUMBER <font number1> =<fontname1>,[b],[i],[u],[fscale:<value>],[,pitch:<0/1/2>],[,family:<nil/roman/swiss/modern/script/decor.tech/bidi>],[,charset:<value>]
FONT NUMBER <font number2> =<fontname2>,[b],[i],[u],[fscale:<value>],[,pitch:<0/1/2>],[,family:<nil/roman/swiss/modern/script/decor.tech/bidi>],[,charset:<value>]
DEFAULT FONT =<fontname3>,[b],[i],[u],[fscale:<value>],[,pitch:<0/1/2>],[,family:<nil/roman/swiss/modern/script/decor.tech/bidi>],[,charset:<value>]
```

The keyword **DEFAULT FONT** allows all the text elements (other than those mapped explicitly in the .ini file) to be displayed in the font as specified against the keyword **DEFAULT FONT**.

**Example:**

```
FONT NUMBER 1 = Arial,ul,fscale:7
FONT NUMBER 2 = Times New Roman,b,i,ul,fscale:10
FONT NUMBER 3 = Times New Roman
DEFAULT FONT = Courier New,b,fscale:8
```

In the above example, the MicroStation font number 1 will be mapped to “Arial” font and text will be underlined and the font size of the text will be 7 times the text height in decimal master design file units – this means that if the MicroStation text element had a text height of 2 decimal master design file units, the RTF text will be served with a font size of 14. In the above example, MicroStation font number 3 will be mapped to “Times New Roman” font with a font scaling of 0.1, which is the default font scale factor.

The font names specified in the .ini file will not be validated. If the client does not recognize the font name for a particular text element, then the display font for that text element will be according to the client’s behavior.

In the absence of the font mapping keyword in the .ini file, or in the absence of a mapping for a particular font number and the **DEFAULT FONT**, the default font of Arial will be used.

The font mapping specified in the .ini file is ignored if the .ini variable **SERVE RICH TEXT** is set to FALSE.

**NOTE:** You can display MicroStation text as Rich Text Format (RTF) in the GeoWorkspace. This can be accomplished by using **SERVE RICH TEXT**: TRUE in the warehouse configuration file (.ini) defined for the CAD connection. The Define Warehouse Configuration Utility can be used to
create the .ini file. Once created, edit the CAD Schema Definition (.csd) file and use Options > Connection to select the .ini file for the Warehouse configuration file.

RTF text embeds the text characteristics into the geometry of the record, so if you import the data into a read/write warehouse you can use the Edit > Text command to review/edit the characteristics. Serving text as RTF text is useful for situations where you have multiple text sizes within the same feature class. For example, if you have city names text each piece of MicroStation text can have different font characteristics. If your text has basically the same sizes and font within any one feature class then serving RTF may not be required. Use of GeoMedia Style Definitions would be good in such cases for defining the default text characteristics.

When serving text as RTF you should also map the MicroStation fonts to Windows True Type fonts declaring FONT NUMBER and/or DEFAULT FONT mappings in the .ini file. These mappings allow you to essentially match MicroStation fonts to the desired windows font and font characteristics (for example, bold, italic, etc.). More importantly, they also allow you to set the font scaling (fscale) factor.

Example from a warehouse configuration (.ini) file:

```ini
SERVE RICH TEXT:TRUE
FONT NUMBER 59 = MONOTYPE CORSIVA,i,b,u,fscale:0.05
DEFAULT FONT =Times New Roman,b,fscale:.07
```

Note that font mappings using either FONT NUMBER and/or DEFAULT FONT are ignored if SERVE RICH TEXT is not set to TRUE.

In the above example, the CAD text will be served as RTF text into IMAGINE. If the CAD text is font 59 then it will be displayed in IMAGINE as:

Monotype Corsiva font, italic, bold, and underlined. The size of the text in IMAGINE will be a point size derived from the fscale value (0.05 in this case) where the Point Size = (fscale value)*(MicroStation Master Unit Text Height).

So if font 59 text was 147 feet (master units) high in the MicroStation CAD file. Then the resultant point size in IMAGINE would be 0.05 * 147=7.35. Since text point sizes must map to integer values, the resultant pt size in IMAGINE would be 7.

If any other font is found besides font 59, then the Default Font will be used, in our example: Times New Roman, Bold with a scaling factor of 0.07.
For grouping the elements with the same graphic group number:

Graphic groups are the most flexible grouping technique in MicroStation. However, each of the elements can have different graphic properties. When a text is placed in MicroStation “along element”, each letter of the text string is placed as an independent text (Type 17) element with the same graphic group number assigned to each of the text elements. The ExportToDesignFileService object also uses this concept to export the elements with the same graphic group number to indicate the “grouping”, if the GraphicGroup property of the export service is not set. For example, a Collection geometry will be exported as multiple IGDS elements with the same graphic group number assigned to each of them. The following *.ini variables are used by the data server to serve the IGDS elements with the same graphic group number as a collection.

- **GROUP TEXT BY GRAPHIC GROUP: TRUE/FALSE:** You can group all of your text with the same graphic group number as a single record, using this *.ini variable. When this variable is set to TRUE, the data server will serve all the grouped text elements as a collection. Only the elements with the same graphic group number in a single design file are grouped. The graphic properties and attribute linkages of the first text element will be considered for populating the respective GFields. However the "GraphicTextString" and "GraphicTextStringMemo" attributes are populated from the text strings of all the text elements that form the collection, separated by a delimiter (as specified by the GRAPHICTEXTSTRING_DELIMITER *.ini keyword). By default, in the absence of this *.ini variable, each IGDS text element is served as a different record.

- **GROUP GEOMETRY BY GRAPHIC GROUP: TRUE/FALSE:** You can group all of his elements with the same graphic group number as a single record, using this *.ini variable. When this variable is set to TRUE, the data server will serve all the grouped elements as a collection geometry. Only the elements with the same graphic group number in a single design file are grouped. Note that irrespective of this *.ini variable, a boundary geometry will always be created from the consecutive IGDS elements if the first one is solid and complex and the following are complex with hole flag set.

- The graphic properties and attribute linkages of the first element will be considered for populating the respective GFields. By default, in the absence of this *.ini variable, each IGDS element is served as a different record.

- **GRAPHICTEXTSTRING DELIMITER:** The IGDS scanner serves the text string of either a Type 7 or a Type 17 text element in the “GraphicTextString” attribute and “GraphicTextStringMemo” attributes. For Type 17 text element, this attribute is served with the text string and for Type 17 text node element, this attribute is served by
Overview of the Define CAD Server Schema File Utility

concatenating all the text strings from the corresponding text elements. The delimiter to be used to concatenate these text elements can be specified using the INI variable “GRAPHICTEXTSTRING DELIMITER”. Default value is semicolon - “;”.

Example: GRAPHICTEXTSTRING DELIMITER: $

MicroStation V8 Scanner

The .ini file has to be specified in the .csd file. This section explains the variables that can be used in the .ini file to specify the behavior of the CAD-MicroStation V8 server.

For serving named and shared cells:

The cell is served based on the .ini variables. Any one or more of the following .ini file settings may be used.

- **SERVE CELL ORIGIN**: TRUE/FALSE – do or do not serve the cell’s origin as an OrientedPointGeometry in a field of type/subtype gdbSpatial/gdbPoint. The default value is TRUE.

- **SERVE CELL GEOMETRY**: TRUE/FALSE – do or do not serve the cell’s spatial components as a GeometryCollection in a field of type/subtype gdbSpatial/gdbAnySpatial. The default value is FALSE. If this option is TRUE, but a particular cell does not contain geometry, then a NULL geometry is served for that cell.

- **SERVE CELL TEXT**: TRUE/FALSE – do or do not serve the cell’s text components as a GeometryCollection in a field of type/subtype gdbGraphic/gdbGraphicsText. The default value is FALSE. If this option is TRUE, but a particular cell does not contain text, then a NULL geometry is served for that cell.

In the .csd file, the fields must be defined with the appropriate geometry types/subtypes, for receiving the various cell data. If the user requests the origin without providing a Point field, requests the geometry without providing an AnySpatial field, or requests the text without providing a GraphicsText field, then the .ini file variables will be ignored.

An orphan cell is served as BoundaryGeometry, irrespective of above .ini variables.

For grouping the elements with the same graphic group number:

Graphic groups are the most flexible grouping technique in MicroStation. However, each of the elements can have different graphic properties. When text is placed in MicroStation “along element”, each letter of the text string is placed as an independent text (Type 17) element with the same graphic group number assigned to each of the text elements. The ExportToMstnV8Service object also uses this concept to export the elements with the same
graphic group number to indicate the “grouping”, if the GraphicGroup property of the export service is not set. For example, a Collection geometry will be exported as multiple .dgn elements with the same graphic group number assigned to each of them. The following .ini variables are used by the data server to serve the .dgn file elements with the same graphic group number as a collection.

- **GROUP TEXT BY GRAPHIC GROUP: TRUE/FALSE**: You can group all of your text with the same graphic group number as a single record, using this .ini variable. When this variable is set to TRUE, the data server will serve all the grouped text elements as a collection. Only the elements with the same graphic group number in a single design file are grouped. The graphic properties of the first text element will be considered for populating the respective GFields. However the "GraphicTextString" and "GraphicTextStringMemo" attributes are populated from the text strings of all the text elements that form the collection, separated by a delimiter (as specified by the GRAPHICTEXTSTRING DELIMITER .ini keyword). By default, in the absence of this .ini variable, each text element is served as a different record.

- **GROUP GEOMETRY BY GRAPHIC GROUP: TRUE/FALSE**: You can group all of your elements with the same graphic group number as a single record, using this .ini variable. When this variable is set to TRUE, the data server will serve all the grouped elements as a collection geometry. Only the elements with the same graphic group number in a single design file are grouped. Note that irrespective of this .ini variable, a boundary geometry will always be created from the consecutive elements if the first one is solid and complex and the following are complex with hole flag set. The graphic properties of the first element will be considered for populating the respective GFields. By default, in the absence of this .ini variable, each element is served as a different record.

- **GRAPHICTEXTSTRING DELIMITER**: The MicroStation V8 scanner serves the text string of either a Type 7 or a Type 17 text element in the “GraphicTextString” attribute and “GraphicTextStringMemo” attributes. For Type 17 text element, this attribute is served with the text string and for Type 17 text node element, this attribute is served by concatenating all the text strings from the corresponding text elements. The delimiter to be used to concatenate these text elements can be specified using the INI variable “GRAPHICTEXTSTRING DELIMITER”. Default value is semicolon - “;”.

**Example**: GRAPHICTEXTSTRING DELIMITER: $
For serving TextNode as multiline test:

- **SERVE TEXTNODE AS MULTILINE TEXT** keyword: By default, MicroStation V8 scanner serves Text Node as text geometry collection. If the INI variable “SERVE TEXTNODE AS MULTILINE TEXT” is set to TRUE, Text Node is served as multi-line text geometry. The default value is FALSE. For text along element (which is a text node), this INI keyword will be ignored, i.e., the scanner always serves it as a composite text collection.

For maximum number of files open:

- **MAXIMUM NUMBER OF FILES OPEN** keyword: By design, MicroStation V8 scanner scans all design files in a dataset to determine if the elements within each design file match the criteria specified for the feature class definition. The scanner subsequently reads only the matching elements to serve the necessary attributes and geometry. Opening and closing the design file for each process stage is costly and can result in poor performance; however, keeping all the design files open might lead to excessive memory consumption, especially in cases where the dataset contains many design files. As a result, the dataserver, by default, keeps only a maximum of 100 design files concurrently open. This usually provides a good balance between application memory consumption and performance. For dataset cases where this default number of concurrently open files is not optimal, the keyword “MAXIMUM NUMBER OF FILES OPEN” can be set to a more appropriate number for the given dataset. The default value is 100.

Example Usage: MAXIMUM NUMBER OF FILES OPEN: 10

For text justification:

By default the "Justification" characteristic of the text element is faithfully carried through to the "Alignment" property of each corresponding TextPointGeometry.

MicroStation stores text with a lower left origin. Therefore, in order to correctly position each TextPointGeometry, the data server by default calculates its origin by starting with the origin of the text element and adding either half (for Center) or all (for Right/Upper) of the text width or height, according to the Justification setting.

Unfortunately, the exact text width and height of the text element cannot be accurately determined, so in many instances in which you have center or right/top justified text, the TextPointGeometry appears to be in the wrong location. The following .ini variables can be used to eliminate the text positioning errors.

- **FORCE TEXT JUSTIFICATION: LOWERLEFT / CENTERLEFT / UPPERLEFT**: You can serve all of your text left-justified using this .ini variable. This .ini variable sets the alignment of each
output TextPointGeometry to the designated setting, minimizing or eliminating text positioning errors. By default, in the absence of this .ini variable, each text element is served with its actual justification.

- While use of this .ini variable does not preserve the original justification of the text element, it does correctly position the text, assuming that you chose a TrueType font for your TextStyle which maps well to the font used in MicroStation.

- The provision of LowerLeft alignment would yield the only truly accurate origin. The provision of CenterLeft and UpperLeft options is to accommodate another idiosyncrasy of text handling, specifically that MicroStation font heights are measured from baseline to ascender, while Microsoft font heights are measured from descender to ascender. Provision of these three options offers you the flexibility needed to get the most accurate text positioning.

- **TEXT ORIGIN BY RANGE: TRUE/FALSE**: The text origin is calculated based on the element range using this .ini variable. Setting this variable preserves the actual alignment of each output TextPointGeometry while calculating the position from the text element range. By default, in the absence of this .ini variable, each text element is served with its position calculated from the origin. If the .ini variable **FORCE TEXT JUSTIFICATION** is present, it overrides the .ini variable **TEXT ORIGIN BY RANGE**. The default behavior in the absence of this .ini variable is FALSE.

  - If this variable is set to TRUE, the text origin is calculated based on the element range (xlo, xhi, etc.) and that position is returned as the origin of the TextPointGeometry, with the proper alignment.

  **NOTE**: **TEXT ORIGIN BY RANGE** will usually provide better results than **FORCE TEXT JUSTIFICATION**.

**For Text font:**

MicroStation V8 supports TrueType and AutoCAD SHX fonts natively, alone with the traditional MicroStation fonts stored in the resource file. The following .ini variables help you in specifying the font details to serve the text in rich text format.

- **SERVE RICH TEXT: TRUE/FALSE**: The you can specify that all the text be served as rich text with this .ini variable. The default value of this variable, in the absence of the text font related .ini variables (**SERVE RICH TEXT** and **FONT NUMBER/NAME**), is FALSE. The user will ignore the LegendEntry extension served by the data server for the text features populated in rich text format if **SERVE RICH TEXT** is set to TRUE.
Overview of the Define CAD Server Schema File Utility

- **FONT NUMBER <xyz> =** This `.ini` variable is used to map the MicroStation (or AutoCAD SHX) font number to the font name of rich text format, along with the font pitch, font family, character set, bold qualifier, and the scaling factor for the corresponding font. With MicroStation V8, underline and italic qualifiers specified while placing text are stored as user data linkages along with the text element. As these qualifiers are read from the design file itself, no `.ini` variables are required to specify these qualifiers.

- **FONT NAME <xyz> =** This `.ini` variable is used to map the AutoCAD SHX font name to the font name of rich text format, along with the font pitch, font family, character set, bold qualifier and the scaling factor for the corresponding font. For a particular AutoCAD SHX font, if both the font number and font name mappings are specified, the font name mapping will override the font number mapping.

For TrueType fonts, the scaling factor alone has to be specified.

The above variables help in serving the text in a user-specified font. You can specify the font scaling factor (with the `fscale:` identifier) to be used to map the text height to the font size, while serving the text in RTF. This value will be multiplied with the text height (in decimal master design file units) and rounded off to the nearest integer to get the font size of the RTF text. The default value of the font scaling factor, is 0.1. This value, in terms of decimal master design file units, is required on a per font basis because the character size differs from font to font. The default value is 0.1. The value specified against the `charset:` identifier specifies the character set of a font in the font table. Default value of this identifier is 0. The value specified against the `pitch:` identifier specifies the pitch of the font in the font table. The valid values for the `pitch` identifier are 0 (default pitch), 1 (fixed pitch) and 2 (variable pitch). The default value of this identifier is 0. The value specified against the `family:` identifier specifies the family of the font in the font table. The valid values are `nil`, `roman`, `swiss`, `modern`, `script`, `decor`, `tech`, `bidi`. The default value of this identifier is “nil”. Refer to the Rich Text Format (RTF) Specification (on page 163) section for more details on font pitch, font family and `charset`.

You must mention the mapping for all the font numbers used in the design file. The syntax is as follows:

```
FONT NUMBER <font number1> =
<fontname1>[,b][,fscale:<value>][,pitch:<0/1/2>][,family:<nil/roman/swiss/modern/script/decor/tech/bidi>][,charset:<value>]

FONT NUMBER <font number2> = <font
name2>[,b][,fscale:<value>][,pitch:<0/1/2>][,family:<nil/roman/swiss/modern/script/decor/tech/bidi>][,charset:<value>]
```
Overview of the Define CAD Server Schema File Utility

DEFAULT FONT = <font name3>[,b][,fscale:<value>][,pitch:<0/1/2>][,family:<nil/roman/swiss/modern/script/decor/tech/bidi>][,charset:<value>]

The keyword DEFAULT FONT allows all the text elements (other than those mapped explicitly in the .ini file) to be displayed in the font as specified against the keyword DEFAULT FONT.

Example:

FONT NUMBER 1 = Arial,fscale:7
FONT NUMBER 2 = Times New Roman,b,fscale:10
FONT NAME Italic.SHX = Verdana
FONT NAME Times New Roman = Times New Roman,fscale:9
DEFAULT FONT = Courier New,b,fscale:8

In the above example, the MicroStation font number 1 is mapped to “Arial” font and the font size of the text will be 7 times the text height in decimal master design file units – this means that if the MicroStation text element had a text height of 2 decimal master design file units, the RTF text will be served with a font size of 14. In the above example, AutoCAD SHX front “Italic” will be mapped to “Verdana” font with a font scaling of 0.1, which is the default font scale factor. A font scaling factor of 9 will be applied to the TrueType font “Times New Roman”.

The font names specified in the .ini file will not be validated. If the client does not recognize the font name for a particular text element, then the display font for that text element will be according to the client’s behavior.

In the absence of the font mapping keyword in the .ini file, or in the absence of a mapping for a particular font number and the DEFAULT FONT, the default font of Arial will be used.

The font mapping specified in the .ini file is ignored if the .ini variable SERVE RICH TEXT: is set to FALSE.

NOTE: You can display MicroStation text as Rich Text Format (RTF) in the GeoWorkspace. This can be accomplished by using SERVE RICH TEXT: TRUE in the warehouse configuration file (.ini) defined for the CAD connection. The Define Warehouse Configuration Utility can be used to create the .ini file. Once created, edit the CAD Schema Definition (.csd) file and use Options > Connection to select the .ini file for the Warehouse configuration file.

RTF text embeds the text characteristics into the geometry of the record, so if you import the data into a read/write warehouse you can use the Edit > Text command to review/edit the characteristics. Serving text as RTF text is useful for situations where you have multiple text sizes within the same feature class. For example, if you have city names text each piece of MicroStation text can have different font characteristics. If your text has basically the same
sizes and font within any one feature class then serving RTF may not be required. Use of GeoMedia Style Definitions would be good in such cases for defining the default text characteristics.

When serving text as RTF you should also map the MicroStation fonts to Windows True Type fonts declaring **FONT NUMBER** and/or **DEFAULT FONT** mappings in the `.ini` file. These mappings allow you to essentially match MicroStation fonts to the desired windows font and font characteristics (for example, bold, italic, etc.). More importantly, they also allow you to set the font scaling (fscale) factor.

**Example from a warehouse configuration (.ini) file:**

SERVE RICH TEXT:TRUE

FONT NUMBER 59 = MONOTYPE CORSIVA,i,b,u,fscale:0.05

DEFAULT FONT = Times New Roman,b,fscale:.07

Note that font mappings using either **FONT NUMBER** and/or **DEFAULT FONT** are ignored if **SERVE RICH TEXT** is not set to TRUE.

In the above example, the CAD text will be served as RTF text into IMAGINE. If the CAD text is font 59 then it will be displayed in IMAGINE as:

Monotype Corsiva font, italic, bold, and underlined. The size of the text in IMAGINE will be a point size derived from the fscale value (0.05 in this case) where the Point Size = (fscale value)*(MicroStation Master Unit Text Height).

So if font 59 text was 147 feet (master units) high in the MicroStation CAD file. Then the resultant point size in IMAGINE would be 0.05 * 147=7.35. Since text point sizes must map to integer values, the resultant pt size in IMAGINE would be 7.

If any other font is found besides font 59, then the Default Font will be used, in our example: Times New Roman, Bold with a scaling factor of 0.07.
Appendix

CAD Server Schema

The CAD Server schema provides the definition of the feature classes for the CAD GDO server. The Define CAD Server Schema File utility is used to assist you in defining your feature classes. This task requires that you define the parameters needed by the Define CAD Server Schema File utility. You define your feature classes based on the different types of attributes that a graphic element may contain. This schema definition is stored in a Microsoft Access database. The Define CAD Server Schema File utility uses the template files delivered with the product to assist you in defining your feature classes. The following three templates are delivered with the product for MicroStation (IGDS), MicroStation Version 8, and AutoCAD:

- MstnTemplate.csd
- MstnV8Template.csd
- AutoCadTemplate.csd

The schema provides the following:

- Describes the storage for feature class definitions.
- Defines the storage of a graphic index.
- Defines the storage for the metadata of the element’s attributes (non-database attributes). This encompasses all attributes, even those that do not participate in the definition of a feature.
- Allows server builders to add more attribute metadata and more feature definitions.
- Does not allow feature definition to be based on the attributes of a database table.
- Is the same for all CAD servers.

If an attribute table exists for a feature class, all the elements of that feature class may or may not contain a linkage to that table.

In order to reduce the complexity of the schema, the following assumptions are made:

- The primary unique key for a graphic-only feature class (that is, no database linkage) consists of one attribute, and it is the same for all graphic-only feature classes defined in the schema. The schema defines the key. ID is the default primary unique key defined for the graphic-only feature classes.
The primary unique key for a feature class that has a database attribute table consists of one attribute, and it is the same for all feature classes that have attribute tables. The schema defines the key. In the MicroStation (IGDS) template file, mslink is the default primary unique key for any feature class with database linkages. In the MicroStation Version 8 and AutoCAD template files, ID is the default primary unique key for any feature class with database linkages.

AutoCAD Scanner

The CAD Data Server provides an interface for serving data from CAD warehouses. The AutoCAD graphic scanner reads the AutoCAD files. The AutoCAD scanner is capable of reading .dwg and .dxf files. The AutoCAD graphic scanner reads the graphic elements from the drawing files. The CAD ODBC scanner reads the database records (if there are any database linkages exposed).

Native Data Model

Geometry Storage

The geometry is stored in the AutoCAD drawing files (in .dwg or .dxf format).

Text entities

Text is stored as either TEXT or MTEXT entity.

Font: AutoCAD stores the font name along with the text as rich text. Both TrueType® fonts and AutoCAD compiled shape (SHX) fonts are supported. TrueType® fonts are stored in rtf by font family name. AutoCAD compiled shape (SHX) fonts are stored by the name of the file in which the fonts are stored.

Example:

- If a true type font is used, the text string will be stored as:
  
\{
|fTimes New Roman|b1|i1|c0|p18;\|C2;This is sample text
\}

- which corresponds to "This is sample text" (Times New Roman, Bold, Italic, Underline)
- If an AutoCAD font is used, the text string will be stored as:
  
\{\Fitalic.shx;\|This is sample text
\}

The bold and italic qualifiers are available only for the TrueType fonts.
**Text Height:** AutoCAD text entities have the text height stored along with the entity. Text height determines the size in drawing units of the letters in the font used. Except in TrueType fonts, the value usually represents the size of the uppercase letters.

For TrueType fonts, the value specified for text height represents the height of a capital letter plus an ascent area reserved for accent marks and other marks used in non-English languages. The relative portion of text height that is assigned to capital letters and ascent characters is determined by the font designer at the time the font is designed; consequently, it varies from font to font. In addition to the height of a capital letter and the ascent area that make up the text height specified by the user, TrueType fonts have a descent area for portions of characters that extend below the text insertion line, for example, y, j, p, g, and q.

**Color:** Each color is identified by an AutoCAD Color Index (ACI) number, an integer from 1 through 255. Standard color names are available only for colors 1 to 7. The colors are assigned as follows: 1 Red, 2 Yellow, 3 Green, 4 Cyan, 5 Blue, 6 Magenta, 7 White/Black. The gray shades are color numbers 250 through 255. A logical color (BYLAYER or BYBLOCK) specifies a color whose value depends either on the color of the layer on which the text resides, or on the color of the block to which the text belongs. Color is also used as a way to indicate line weight for color-dependent plotting.

**Attribute Storage**

There are several different ways to store attribute information in drawing files and to link the drawing file entities to external attributes. AutoCAD does not define any particular standard. There are three predominant ways of storing database attributes in AutoCAD drawing files:

**TAGs**

TAGs or block attributes are the attributes associated with a block instance. The TAGs come with a name-value pair. The set of TAGs used for one drawing entity can differ from that used for another entity of the same drawing file.

**Database links**

AutoCAD can be used to associate data contained in an external database table with AutoCAD graphical objects through the process of linking. Links are pointers to a database table that reference data from one or more records in that table. The drawing file stores the link information of the external database as an ASE (AutoCAD SQL Extension™) extended data associated with the entity. The extended data object has the link details and the value of the link field. All the link information is stored in the drawing file. There can be multiple links
defined in the drawing file. The link format specifies the path to the database table used by the link and differs in various versions of AutoCAD, as specified by the fields given below.

**Link format in R12**
- DBMS - specifies the database management system used by the link.
- Database - specifies the database used by the link.
- Table - specifies the table used by the link.

**Link Format in R13 and R14**
- Environment - specifies the environment used by the link.
- Catalog - specifies the catalog used by the link.
- Schema - specifies the schema used by the link.
- Table - specifies the table used by the link.
- Link Path Name - specifies the link path name used by the link.

**Link Format in AutoCAD 2000 and later**
- Data Source - specifies the data source for the link.
- Catalog - specifies the catalog for the link.
- Schema - specifies the schema for the link.
- Table - specifies the table for the link.
- Link Template - specifies the link template for the link.

**Extended data**
Extended data can contain proprietary information of any application, and thus can be used for storing the database attributes by a particular application.

**Versions and Variations**
AutoCAD Scanner supports DWG and DXF files from versions 2.5 through 14 of AutoCAD.
AutoCAD Scanner supports AutoCAD Release 2000 and AutoCAD 2002, starting from GeoMedia 5.0.
AutoCAD Scanner uses DWGDirect library (from Open Design Alliance) version 1.11.
### Native-to-GDO Field Type Mapping

**Graphic attributes**

The following table identifies the native field types.

<table>
<thead>
<tr>
<th>Native Field Name as exposed in the .csd file</th>
<th>Native Field Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>BlockName</td>
<td>The name of the AutoCAD block</td>
</tr>
<tr>
<td>EntityColor</td>
<td>The color for an entity</td>
</tr>
<tr>
<td>EntityHandle</td>
<td>This is not an attribute of the AutoCAD entity. This is an ID that uniquely identifies an entity in a .dwg file.</td>
</tr>
<tr>
<td>EntityIsVisible</td>
<td>Whether the entity is visible</td>
</tr>
<tr>
<td>EntityType</td>
<td>The type of the entity</td>
</tr>
<tr>
<td>FullName</td>
<td>This is not an attribute of the AutoCAD entity. This specifies the name of the map file along with its path.</td>
</tr>
<tr>
<td>HasExtendedData</td>
<td>Whether entity has extended data</td>
</tr>
<tr>
<td>ID</td>
<td>This is not an attribute of the AutoCAD entity. This field serves as the primary key for the CAD data server.</td>
</tr>
<tr>
<td>LayerIsFrozen</td>
<td>Whether layer is frozen</td>
</tr>
<tr>
<td>LayerIsLocked</td>
<td>Whether layer is locked</td>
</tr>
<tr>
<td>LayerIsOn</td>
<td>Whether layer is on</td>
</tr>
<tr>
<td>LayerName</td>
<td>The name of an AutoCAD Layer</td>
</tr>
<tr>
<td>LineTypeName</td>
<td>The name of the line type</td>
</tr>
<tr>
<td>MapName</td>
<td>This is not an attribute of the AutoCAD entity. This specifies the name of the map file.</td>
</tr>
<tr>
<td>PathName</td>
<td>This is not an attribute of the AutoCAD entity. This specifies the path of the map file.</td>
</tr>
<tr>
<td>Rotation</td>
<td>Rotation (applicable only for block entities)</td>
</tr>
<tr>
<td>ScaleX</td>
<td>Scaling along the X-axis (applicable only for block entities)</td>
</tr>
</tbody>
</table>
Overview of the Define CAD Server Schema File Utility

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>ScaleY</td>
<td>Scaling along the Y-axis (applicable only for block entities)</td>
</tr>
<tr>
<td>ScaleZ</td>
<td>Scaling along the Z-axis (applicable only for block entities)</td>
</tr>
<tr>
<td>TextJustification</td>
<td>How is the Tex justified-left, right or center</td>
</tr>
<tr>
<td>EntityColorRGB</td>
<td>This field is used to populate the EntityColor as RGB value. This field is used for the LE extension.</td>
</tr>
<tr>
<td>EntityWeightHiMetric</td>
<td>This field is used to populate the weight of an entity in HiMetric units. This field is used for the LE extension. The native line weight of the entity can be in mm or inches.</td>
</tr>
<tr>
<td>CustomSequence</td>
<td>This field is used to populate the scaled dash-gap lengths of the line type in HiMetric as a sequence. Only simple linetypes, i.e, patterns having any sequence of dash, dot, gap are supported by the scanner. The linetype definition is available with the drawing file.</td>
</tr>
<tr>
<td>FontSizeHiMetric</td>
<td>This field is used to populate the font size of the text element in HiMetric units. This value is calculated by multiplying the text height with a value of (35.27777777777775) and the font scaling factor as mentioned in the INI file.</td>
</tr>
</tbody>
</table>

Mapping of GeoMedia Style Property

**GFields used**

The GFields used to set the various properties on StyleDefinition are explained in the following table:

<table>
<thead>
<tr>
<th>GeoMedia style type</th>
<th>Style property</th>
<th>GFields / ABS expression used for the property value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Symbol style</td>
<td>OverrideColor</td>
<td>EntityColorRGB</td>
</tr>
<tr>
<td></td>
<td>Size</td>
<td>EntityWeightHiMetric</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
Overview of the Define CAD Server Schema File Utility

<table>
<thead>
<tr>
<th>Simple Line Style</th>
<th>Color</th>
<th>EntityColorRGB</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Width</td>
<td>EntityWeightHiMetric</td>
</tr>
<tr>
<td></td>
<td>SequenceType</td>
<td>gmgroSequenceTypeCustom</td>
</tr>
<tr>
<td></td>
<td>CustomSequence</td>
<td>CustomSequence</td>
</tr>
<tr>
<td>Fill style</td>
<td>Color</td>
<td>Not supported</td>
</tr>
<tr>
<td>Text style</td>
<td>Color</td>
<td>EntityColorRGB</td>
</tr>
<tr>
<td></td>
<td>FontName</td>
<td>Font Name</td>
</tr>
<tr>
<td></td>
<td>FontSize</td>
<td>FontSizeHiMetric</td>
</tr>
</tbody>
</table>

**NOTE** Concerning the CustomSequence style property: While honoring simple linetypes, linetype scaling defined in the drawing file is taken into consideration. The dash length and gap lengths of a particular pattern can be defined either in inches or in mm (in the linetype definition).

**Non-graphic attributes**

The non-graphic attribute types detailed in the next two sections are supported.

**Support for block attributes**

The block attributes come as name-value pairs and the data type of the TAG is not specified. The user has to update the .csd file with the list of exposed TAGs (TAG name and type). If a TAG (as defined in the .csd file) is not associated with a particular entity, the data server will populate the GField value of that record with NULL value. Similarly, the data server will populate all the GField values (for TAGs) of non-block entity records with NULL values. The TAGs are determined by their names. Unnamed TAGs are not supported.

**Support for database links**

Define CAD Server Schema File supports AutoCAD database links. If the .csd file does not contain the link details, the AutoCAD graphic scanner will read the associated table name and the link field name from the first link template of the drawing file.

In order to serve the database linkages, you must supply the following:

- DSN information of the external database - the connect string (mandatory)
- Name of the link table for a particular feature class (optional)
Overview of the Define CAD Server Schema File Utility

- Name of the link field for a particular feature class (optional)

If you do not specify the values for the above optional parameters (DBTableName and DBLinkFieldName) in the .csd file, the first link template definition encountered will be used to populate the database attributes.

The scanner does not do any validation to verify that the link template matches with the table name and the field name specified in the .csd file. The scanner will populate the database field values of a particular record with NULL value in the following cases:

- If a particular entity has no link value
- If there is no record in the database table that matches the link field value

Native-to-GDO Geometry Type Mapping

The following table identifies the mapping used when converting from native geometry types to GDO geometry types.

<table>
<thead>
<tr>
<th>Native Geometry Type</th>
<th>Native Meaning</th>
<th>GDO Geometry Type</th>
</tr>
</thead>
<tbody>
<tr>
<td>Line</td>
<td>Line</td>
<td>PolylineGeometry</td>
</tr>
<tr>
<td>Light weight Polyline</td>
<td>Simplified polyline with constant width, linetype, and so forth. It is supported in AutoCAD versions 14 and higher.</td>
<td>CompositePolylineGeometry/ CompositePolygonGeometry/ PolylineGeometry/ PolygonGeometry</td>
</tr>
<tr>
<td></td>
<td></td>
<td>In case of bulges a CompositePolygonGeometry or CompositePolylineGeometry blob is created depending upon whether the entity is closed or not.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>In case of no bulges a PolygonGeometry/Polyline- Geometry blob is created depending upon whether the entity is closed or not.</td>
</tr>
<tr>
<td>Text</td>
<td>Single line of text</td>
<td>TextPointGeometry</td>
</tr>
<tr>
<td></td>
<td></td>
<td>The text may be served up in rich text format, based on the .ini file options.</td>
</tr>
<tr>
<td>Point</td>
<td>Point</td>
<td>OrientedPointGeometry</td>
</tr>
</tbody>
</table>
## Overview of the Define CAD Server Schema File Utility

<table>
<thead>
<tr>
<th>Shape</th>
<th>Shape (from shapefile)</th>
<th>Not supported</th>
</tr>
</thead>
<tbody>
<tr>
<td>Circle</td>
<td>Circle</td>
<td>PolygonGeometry</td>
</tr>
<tr>
<td>Ellipse</td>
<td>Elliptical Arc / Ellipse</td>
<td>PolylineGeometry / PolygonGeometry</td>
</tr>
<tr>
<td>Trace</td>
<td>A solid filled path</td>
<td>PolygonGeometry</td>
</tr>
<tr>
<td>Solid</td>
<td>A filled region</td>
<td>PolygonGeometry</td>
</tr>
<tr>
<td>Insert</td>
<td>AutoCAD Block</td>
<td>OrientedPointGeometry/ TextPointGeometry/ GeometryCollection. This is served based on the .ini file variables</td>
</tr>
<tr>
<td>Spline, Dimension, Ray, Xline, Tolerance, Viewport</td>
<td>Not supported (as these are not GIS geometry types)</td>
<td></td>
</tr>
<tr>
<td>Leader line</td>
<td>A leader is a sequence of line segments with an arrowhead at one end and, typically, text at the other.</td>
<td>PolylineGeometry</td>
</tr>
<tr>
<td>Face3D</td>
<td>Face3D is a 3D planar region bounded by four points</td>
<td>PolygonGeometry</td>
</tr>
<tr>
<td>Multiline text</td>
<td>Multi-line text is a long text entity which can extend onto multiple lines</td>
<td>TextPointGeometry The text may be served up in rich text format, based on the .ini file options.</td>
</tr>
<tr>
<td>Multiline</td>
<td>Collection of lines</td>
<td>GeometryCollection</td>
</tr>
<tr>
<td>Arc</td>
<td>Circular arc</td>
<td>ArcGeometry</td>
</tr>
<tr>
<td>ProxyData</td>
<td>Includes lightweight polylines, generic proxy data, and irregular types such as ole2, hatch, and entity. Only lightweight polylines and generic proxy data are handled.</td>
<td>CompositePolylineGeometry</td>
</tr>
<tr>
<td>AttDef</td>
<td>Text related to blocks.</td>
<td>TextPointGeometry</td>
</tr>
<tr>
<td>----------------------</td>
<td>-------------------------</td>
<td>-------------------</td>
</tr>
<tr>
<td>TAG</td>
<td>Attributes that are attached to the block entities in the drawing file.</td>
<td>TextPointGeometry</td>
</tr>
<tr>
<td>Solid3D, Region, Body</td>
<td>All these three elements are stored in a similar way in AutoCAD. One of the following entities can be part of them: Box, Cone, Cylinder, EllipticalCone, EllipticalCylinder, Extruded Solid, Revolved Solid, Sphere, Torus or Wedge</td>
<td>Not supported</td>
</tr>
<tr>
<td>Rtext</td>
<td>Rich Text Object – new entity in AutoCAD R2000</td>
<td>TextPointGeometry</td>
</tr>
<tr>
<td>ARCALIGNEDTEXT</td>
<td>Text which is aligned along a given arc – new entity in AutoCAD R2000</td>
<td>GeometryCollection of TextPointGeometry</td>
</tr>
<tr>
<td>WIPEOUT</td>
<td>An image entity having a background color – new entity in AutoCAD R2000</td>
<td>Not Supported</td>
</tr>
<tr>
<td>DIMASSOC</td>
<td>New Object Type in AutoCAD 2002. This object is associated with the &quot;dimension&quot; data type with properties like snap type, snap point, rotated dimension type.</td>
<td>Not Supported</td>
</tr>
</tbody>
</table>
Serving text:

Based on the .ini file variables, the text entities (text, multiline text, Rtext, and ArcAlignedText) will be served in rich text format with the color, size, and font details read from the drawing file. The mapping of the font, size, and color details are explained below:

- **Font**: If the text is in true type font, the same font name (as stored with the text entity) is used along with other formatting details like bold, italic, and underline while serving the text in rich text format.
- If the text is in AutoCAD’s SHX font, the font name is mapped to the RTF font name based on the .ini file settings. The mapped font name is served in the rich text syntax along with the actual text. If no matching font is found, Arial is used as the default.
- **Size**: The text height of the text entity will be mapped to the font size of the rich text using the font scaling factor defined in the .ini file. If no scaling factor is defined in the .ini file, the default font scaling factor of 10 is used to calculate the font size.
- **Color**: The ACI (AutoCAD Color Index) value stored with the text entity is mapped to the RGB color as per AutoCAD’s color table.

AttDef and TAG entities do not have the font information and hence will be served up as plain text always.

Limitations and Issues

The following are the limitations of the AutoCAD scanner:

- Multiple linkages and multiple databases are not supported in this version.
- Linetype definitions are found in a .lin file, which is an ASCII file format that is delivered with the AutoCAD product, and the linetype definitions become part of the drawing file when loaded in AutoCAD. The linetype definition is just a replica of the linetype pattern defined in the AutoCAD product-delivered .lin files. The definition specifies the minimum dash length and gap length for a particular pattern. When a linetype is applied to a linear geometry in the AutoCAD product, the gap lengths are retained as is. The dashes that appear in the middle of line geometry are also retained as is, but the dash lengths at the beginning and end of line geometry are adjusted as needed. Because IMAGINE client is not aware of adjusting the dash lengths, the style pattern appears slightly different in AutoCAD and IMAGINE.
- Complex linetypes (linetypes with embedded text and shapes) like Fencelines, Railway lines, and ZigZag, etc., are not supported for CustomSequence GField. These are instead mapped to Solid line style.
IGDS Scanner

The CAD Data Server provides an interface for serving data from CAD warehouses. The IGDS graphic scanner reads the design files for the CAD server. This section documents the IGDS scanner.

Native Data Model

Geometry Storage

The geometry is stored in the design files as per the IGDS format. None of the Bentley-MicroStation extensions of IGDS format are supported except shared cell.

Z values in 2D design files

In 2D files the Z range will be set in IGDS/MicroStation, by default, to maximum negative 32 bit integer value. MGE interprets the max negative integer as an indication that the Z range was not set by an application. Most of the MGE applications place the contour values into the low Z range of the element header in the design files. If the contour value is not set, these applications put -2 billion value as the low Z range and not zero. This is because zero is also considered as a valid elevation point.

Versions and Variations

IGDS Scanner supports the geometry types as mentioned in the Native-to-GDO Geometry Type Mapping table. MicroStation-K and higher version design files are not supported.

Native-to-GDO Field Type Mapping

The following table identifies the native field types.

<table>
<thead>
<tr>
<th>Native Field Name as exposed in the .csd file</th>
<th>Native Field Meaning</th>
<th>Can this graphic attribute be used to set criteria?</th>
</tr>
</thead>
<tbody>
<tr>
<td>CellName</td>
<td>The name of the MicroStation Cell element.</td>
<td>Yes</td>
</tr>
<tr>
<td>CellScaleX</td>
<td>Specifies the scale factor along the x-axis. This is applicable only to elements of Type 2 (cell) and Type 35 (shared cell instance).</td>
<td>Yes</td>
</tr>
<tr>
<td>--------------------</td>
<td>-----------------------------------------------------------------------------------------------------------------</td>
<td>-----</td>
</tr>
<tr>
<td>CellScaleY</td>
<td>Specifies the scale factor along the y-axis. This is applicable only to elements of Type 2 (cell) and Type 35 (shared cell instance).</td>
<td>Yes</td>
</tr>
<tr>
<td>CellScaleZ</td>
<td>Specifies the scale factor along the z-axis. This is applicable only to elements of Type 2 (cell) and Type 35 (shared cell instance).</td>
<td>Yes</td>
</tr>
<tr>
<td>ElementColor</td>
<td>The color of an element. This is stored as a value in the 0-255 range.</td>
<td>Yes</td>
</tr>
<tr>
<td>ElementLevel</td>
<td>The level (from 0-63), on which an element is placed. Data in the design file is segregated into 63 drawing levels. Levels are similar to transparent overlays that can be put together to form a complete drawing.</td>
<td>Yes</td>
</tr>
<tr>
<td>Element Style</td>
<td>Description</td>
<td>Yes/No</td>
</tr>
<tr>
<td>---------------</td>
<td>-----------------------------------------------------------------------------</td>
<td>--------</td>
</tr>
<tr>
<td>Element Style</td>
<td>Part of the symbology of an element. For example, whether a line is solid,</td>
<td>Yes</td>
</tr>
<tr>
<td></td>
<td>continuous dashes, dots and dashes, and so on. This is an index in the</td>
<td></td>
</tr>
<tr>
<td></td>
<td>range 0 to 7. The values 0 to 7 represent the following line styles.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>0 - Solid</td>
<td></td>
</tr>
<tr>
<td></td>
<td>1 - Dotted</td>
<td></td>
</tr>
<tr>
<td></td>
<td>2 - Medium Dash</td>
<td></td>
</tr>
<tr>
<td></td>
<td>3 - Long Dash</td>
<td></td>
</tr>
<tr>
<td></td>
<td>4 - Dot Dash</td>
<td></td>
</tr>
<tr>
<td></td>
<td>5 - Short Dash</td>
<td></td>
</tr>
<tr>
<td></td>
<td>6 - Dash Double Dot</td>
<td></td>
</tr>
<tr>
<td></td>
<td>7 - Long Dash Short Dash</td>
<td></td>
</tr>
<tr>
<td>Element Type</td>
<td>This specifies the type of the MicroStation element.</td>
<td>Yes</td>
</tr>
<tr>
<td>Element Weight</td>
<td>The line weight of an element in pixels, stored as a value in the 0-31</td>
<td>Yes</td>
</tr>
<tr>
<td></td>
<td>range, where 0 is lightest (narrowest) and 31 is heaviest.</td>
<td></td>
</tr>
<tr>
<td>Element Z</td>
<td>Specifies the Z coordinate value associated with the IGDS element in either</td>
<td>No</td>
</tr>
<tr>
<td></td>
<td>a 2D or 3D design file.</td>
<td></td>
</tr>
</tbody>
</table>
### Overview of the Define CAD Server Schema File Utility

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
<th>Required</th>
</tr>
</thead>
<tbody>
<tr>
<td>EntityNumber</td>
<td>This corresponds to the entitynum column in the MSCATALOG row for a particular table. This contains the entity number of the table. The entity number is a positive integer from 1 to 65535 that uniquely identifies the table to the database. Each table used with a design file must have a unique entity number.</td>
<td>Yes</td>
</tr>
<tr>
<td>FontNumber</td>
<td>Specifies the font number of the IGDS text element.</td>
<td>Yes</td>
</tr>
<tr>
<td>FullName</td>
<td>Specifies the name of the map file along with its path. This is not an element of the MicroStation element.</td>
<td>No</td>
</tr>
<tr>
<td>GraphicGroupNumber</td>
<td>Specifies the number associated with a graphic group.</td>
<td>Yes</td>
</tr>
<tr>
<td>GraphicTextString</td>
<td>This field is not the attribute of a MicroStation element header. This field is used to populated the text valued associated with a text element as gdbText.</td>
<td>No</td>
</tr>
<tr>
<td>GraphicTextStringMemo</td>
<td>This field is not the attribute of a MicroStation element header. This field is used to populated the text valued associated with a text element as gdbMemo.</td>
<td>No</td>
</tr>
<tr>
<td>ID</td>
<td>This is not an attribute of the MicroStation element. This is used to serve as the primary key for the CAD data server.</td>
<td>No</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
<td>Required</td>
</tr>
<tr>
<td>-----------------------</td>
<td>-----------------------------------------------------------------------------</td>
<td>----------</td>
</tr>
<tr>
<td>MapName</td>
<td>Specifies the name of the map file in which the element is present. This is not an attribute of the MicroStation element.</td>
<td>No</td>
</tr>
<tr>
<td>OccurrenceNumber</td>
<td>Specifies the row of the database table that is linked to the element.</td>
<td>Yes</td>
</tr>
<tr>
<td>PathName</td>
<td>Specifies the path of the map file in which the element is present. This is not an attribute of the MicroStation element.</td>
<td>No</td>
</tr>
<tr>
<td>TextHeight</td>
<td>Specifies the height of the text characters in an IGDS text element in decimal master design file units of the corresponding design file.</td>
<td>Yes</td>
</tr>
<tr>
<td>TextWidth</td>
<td>Specifies the width of the text characters in an IGDS text element in decimal master design file units of the corresponding design file.</td>
<td>Yes</td>
</tr>
<tr>
<td>ElementColorRGB</td>
<td>This field is used to populate the element color as RGB value. This field is used for the LE extension.</td>
<td>No</td>
</tr>
<tr>
<td>ElementFillColorRGB</td>
<td>This field is used to populate the element fill color as RGB value. This field is used for the LE extension.</td>
<td>No</td>
</tr>
<tr>
<td>FontName</td>
<td>This field is used to populate the font name used while serving text geometry. The font name is retrieved by reading the INI parameters. This field is used for the LE extension.</td>
<td>No</td>
</tr>
</tbody>
</table>
FontSizeHiMetric

This field is used to populate the font size of the text element in HiMetric units. This value is calculated by multiplying the text height with a value of \((35.27777777777775)\) and the font scaling factor as mentioned in the INI file. This field is used for the LE extension.

The attributes **MapName**, **PathName**, and **FullName** have been added to allow the user to track the origin of each of the features that came from different design files.

In the case of orphan and unnamed cells (served as BoundaryGeometry), the graphic attributes of the first element in the sequence are used to populate the graphic attributes of the feature.

In case of named cells, the graphic attributes of the cell header are used to populate the graphic attributes of the feature.

For a sequence of complex shapes, the first of which is solid and subsequent ones holes (served as BoundaryGeometry), the graphic attributes of the first element in the sequence are used to populate the graphic attributes of the feature.

### GeoMedia Style Property to GField Mapping

The GFields used to set the various properties on StyleDefinition are explained in the following table:

<table>
<thead>
<tr>
<th>GeoMedia style type</th>
<th>Style property</th>
<th>GFields / ABS expression used for the property value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Symbol style</td>
<td>OverrideColor</td>
<td>EntityColorRGB</td>
</tr>
<tr>
<td></td>
<td>Size</td>
<td>ElementWeight*26.45833 (See Note below.)</td>
</tr>
<tr>
<td>Simple Line Style</td>
<td>Color</td>
<td>ElementColorRGB</td>
</tr>
<tr>
<td></td>
<td>Width</td>
<td>ElementWeight*26.45833</td>
</tr>
<tr>
<td></td>
<td>SequenceType</td>
<td>IF (ElementStyle&gt;=0 AND ElementStyle&lt;=7, ElementStyle, 0)</td>
</tr>
<tr>
<td>Fill style</td>
<td>Color</td>
<td>ElementFillColorRGB</td>
</tr>
</tbody>
</table>
Concerning the ElementWeight*26.45833 field: GeoMedia’s Style Definition expects the Size of the Symbol Style, Width of the Simple Line style, and FontSize of the Text style to be in HiMetric units. Hence the conversion is needed to convert the value to HiMetric units.

Native-to-GDO Geometry Type Mapping

For 2D files, the Z coordinate is populated with the minimum Z value of the range in the element header. If this value exceeds the threshold of ~1.8 billion, the Z coordinate is populated with a value of 0.0. This is because there cannot be NULL coordinates in the geometry blob. For 3D design files, the actual Z coordinate will be served.

The following table identifies the mapping used when converting from native geometry types to GDO geometry types.

<table>
<thead>
<tr>
<th>Native Geometry Type</th>
<th>Native Meaning</th>
<th>GDO Geometry Type</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cell - named (Type 2)</td>
<td>A complex element composed of a group of primitive or other complex elements that is stored in a cell library for repeated placement. This has a name associated with it.</td>
<td>OrientedPointGeometry/TextPointGeometry/CollectionGeometry. This is served based on the .ini file variables</td>
</tr>
<tr>
<td>Type</td>
<td>Description</td>
<td>Geometry Type</td>
</tr>
<tr>
<td>----------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
<td>------------------------</td>
</tr>
<tr>
<td>Cell - orphaned (Type 2)</td>
<td>A complex element composed of a group of primitive or other complex elements that is stored in a cell library for repeated placement. This has no name associated with it and the hole flag is set to TRUE. Orphan cells of a particular form (composed only of shape (type 6), ellipse (type 15) or complex shape (type 12) elements - the first element should be solid and the rest holes) result in the generation of Boundary geometry. Otherwise the cell will be treated as a named cell.</td>
<td>BoundaryGeometry</td>
</tr>
<tr>
<td>Cell - unnamed (Type 2)</td>
<td>Unnamed cells are identified by the lack of a cell name in the header. Since there is no name, there can be no corresponding element in the cell library and the hole flag setting is irrelevant. They are handled the same way as orphan cells.</td>
<td>BoundaryGeometry</td>
</tr>
<tr>
<td>Line (Type 3)</td>
<td>An open graphic element composed of points connected to each other.</td>
<td>PolylineGeometry/OrientedPointGeometry. In case of degenerate lines, OrientedPointGeometry is served.</td>
</tr>
<tr>
<td>LineString (Type 4)</td>
<td>An open graphic element composed of up to 100 line segments connected at the vertices.</td>
<td>PolylineGeometry</td>
</tr>
</tbody>
</table>
### Overview of the Define CAD Server Schema File Utility

<table>
<thead>
<tr>
<th>Shape (Type 6)</th>
<th>Closed primitive element composed of up to 100 linear segments.</th>
<th>PolygonGeometry</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ellipse (Type 15)</td>
<td>Ellipse</td>
<td>PolygonGeometry</td>
</tr>
<tr>
<td>Arc (Type 16)</td>
<td>A regularly curved open element that has a constant radius around a single center point.</td>
<td>PolylineGeometry/ArcGeometry ArcGeometry is served for circular arcs.</td>
</tr>
<tr>
<td>Complex String (Type 12)</td>
<td>An open complex element that is formed from a series of open elements, such as lines, line strings, and arcs.</td>
<td>CompositePolylineGeometry</td>
</tr>
<tr>
<td>Complex Shape (Type 14)</td>
<td>A closed complex element formed from a series of open primitive elements.</td>
<td>CompositePolygonGeometry BoundaryGeometry is served for a sequence of complex shapes, the first of which is solid and subsequent ones holes.</td>
</tr>
<tr>
<td>Curve (Type 11)</td>
<td>Curve element</td>
<td>CompositePolylineGeometry</td>
</tr>
<tr>
<td>Text (Type 17)</td>
<td>Text element</td>
<td>TextPointGeometry</td>
</tr>
<tr>
<td>TextNode (Type 7)</td>
<td>Multiple text elements grouped in a complex element.</td>
<td>TextPointGeometry (collection)</td>
</tr>
</tbody>
</table>

The text will be served up in rich text format, thus maintaining the text color, height, and width. The text justification and font are forced through the `.ini` variables.
Shared Cell (Type 35)  | A cell whose elements are stored only once in the design file, regardless of how often the cell is placed. Any change made to one instance of a shared cell is reflected in all instances of that shared cell. | OrientedPointGeometry

---

### Mapping of GeoMedia Style Property

#### *GFields used*

The GFields used to set the various properties on StyleDefinition are explained in the following table:

<table>
<thead>
<tr>
<th>GeoMedia style type</th>
<th>Style property</th>
<th>GFields / ABS expression used for the property value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Symbol style</td>
<td>OverrideColor</td>
<td>EntityColorRGB</td>
</tr>
<tr>
<td></td>
<td>Size</td>
<td>EntityWeightHiMetric</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Simple Line Style</td>
<td>Color</td>
<td>EntityColorRGB</td>
</tr>
<tr>
<td></td>
<td>Width</td>
<td>EntityWeightHiMetric</td>
</tr>
<tr>
<td></td>
<td>SequenceType</td>
<td>gmgroSequenceTypeCustom</td>
</tr>
<tr>
<td></td>
<td></td>
<td>CustomSequence</td>
</tr>
<tr>
<td>Fill style</td>
<td>Color</td>
<td>Not supported</td>
</tr>
<tr>
<td>Text style</td>
<td>Color</td>
<td>EntityColorRGB</td>
</tr>
<tr>
<td></td>
<td>FontName</td>
<td>Font Name</td>
</tr>
<tr>
<td></td>
<td>FontSize</td>
<td>FontSizeHiMetric</td>
</tr>
</tbody>
</table>
Serving text:

MicroStation text and textnode elements will be served in rich text format with the color, size and font details read from the IGDS element. The IGDS text/textnode element has the text height and width stored in the design file in UORs. MicroStation saves its coordinates as 32-bit integers. Accordingly, the design plane has 232 points in each dimension. The distance between two adjacent points is the smallest distance MicroStation can address. This distance is one positional unit or unit of resolution (UOR) The mapping of the color, size and the font details are explained below:

- **Font:** The font number of the IGDS element is mapped to the font name based on the .ini settings. The mapped font name is served in the rich text syntax, along with the actual text. If no matching font is found, Arial is used as the default.

- **Size:** The text height of the IGDS element will be mapped to the font size of the rich text using the font scaling factor defined in the .ini file. The character scaling value (specified by \\charscalex, as a percentage of font size) will be calculated using the text height and text width.

- **Color:** If the MicroStation design file has the color table attached to it (this is determined by the presence of type 5 color table element in the design file), the color index stored in the element’s display header is mapped to the RGB color using the color table. If no color table is attached to the design file (determined by the absence of type 5 color table element), the color index stored in the element’s display header is mapped to the RGB color using the default color table delivered with the CAD-IGDS data server. In the absence of the type 5 color table element and the default color table file, the color is not served with the rich text.

The delivered MicroStation color table file color.tbl will be used by the IGDS scanner.

Limitations and issues

The following is a limitation of the IGDS scanner:

- Custom line styles like Border, Center, and DashDot are not mapped to corresponding styles in IMAGINE (while serving the LegendEntry extension). These are instead mapped to Solid line style.
MicroStation Version 8 Scanner

Native Data Model

Geometry Storage

MicroStation v8 has graphical elements with same element types as in its older versions. However the element definitions have changed to support increased workspace, size of elements, and higher precision through floating point coordinates. The storage format of the graphical elements in the design file is not open to the user unlike in the older versions.

Geometry Indexing

There is no geometry indexing.

Attribute Storage

Graphic attributes of each element are defined in the element header, display header, and with the element. The data types of all graphic attributes in v8 have been enhanced over the earlier versions to support increased range.

Data linkage to the graphical elements is through the attribute offset as in earlier versions. However, data linkages will not be read by the v8 scanner.

Database Linkages

The linkage information is stored on the element in the design file. When a database row is linked to a graphical element, attribute data, in the form of an attribute linkage containing the MSLINK and entity number, is written to the element. The entity number corresponds to the table in the external databases (as defined in the MSCATALOG table). The MSLINK value is a numeric value that corresponds to a row of data in the table.

The linkages can be represented in an eight-word format (following the format used in ODBC, Oracle, Informix and other database management software) or a four-word format (the DMRS format). The eight-word format contains the entity number in the fourth word and the MSLINK in the fifth and sixth words. The four-word format contains the entity number in the second word, the MSLINK in the third word, and the high order byte in the fourth word. The database linkages are represented as hexadecimal numbers.
Range of valid MSLINK values

With the eight-word format, four bytes are available for storing the MSLINK number: 0 to 232 -1
With the four-word format, three bytes are available for storing the MSLINK number: 0 to 224 –1

Fonts

Fonts are not embedded in the design file. MicroStation v8 supports TrueType and AutoCAD SHX fonts natively, along with the traditional MicroStation fonts (stored in the resource file “font.rsc”). Each font type has a specific font number range, as follows:
- MicroStation fonts: 0-255
- AutoCAD SHX fonts: 512-1023
- TrueType fonts: 1024-65535

The underline and italic qualifiers for a particular text element are stored along with the text element as user data linkages.

Versions and Variations

This data server is designed to support MicroStation versions 8.0 and 8.1.

Native-to-GDO Field Type Mapping

The following table identifies the native field types.

<table>
<thead>
<tr>
<th>Native Field Name, as exposed in the csd file</th>
<th>Native Field Meaning</th>
<th>Can this graphic attribute be used to set criteria ?</th>
</tr>
</thead>
<tbody>
<tr>
<td>CellName</td>
<td>The name of the MicroStation Cell element.</td>
<td>Yes</td>
</tr>
<tr>
<td>CellScaleX</td>
<td>Specifies the scale factor along the x-axis. This is applicable only to elements of Type 2 (cell) and Type 35 (shared cell instance).</td>
<td>Yes</td>
</tr>
<tr>
<td>Attribute</td>
<td>Description</td>
<td>Required</td>
</tr>
<tr>
<td>--------------------</td>
<td>-----------------------------------------------------------------------------</td>
<td>----------</td>
</tr>
<tr>
<td>CellScaleY</td>
<td>Specifies the scale factor along the y-axis. This is applicable only to elements of Type 2 (cell) and Type 35 (shared cell instance).</td>
<td>Yes</td>
</tr>
<tr>
<td>CellScaleZ</td>
<td>Specifies the scale factor along the z-axis. This is applicable only to elements of Type 2 (cell) and Type 35 (shared cell instance).</td>
<td>Yes</td>
</tr>
<tr>
<td>ElementColor</td>
<td>Symbology. Color of element. Similar to style of element.</td>
<td>Yes</td>
</tr>
<tr>
<td>ElementId</td>
<td>Unique ID of the element, which is persistent through out the life of the .dgn file. Every element in .dgn file has unique ID (Int64). Though there is no equivalent GDO field Type, this attribute needs to be exposed.</td>
<td>No</td>
</tr>
<tr>
<td>ElementLevelName</td>
<td>Named level. Levels are similar to transparent overlays that can be put together to form a complete drawing. Levels are stored as Int 32 values. User interacts only as named values. Name/value pairs are stored as level table elements. When a .dgn file is created there is one level named as &quot;default&quot;.</td>
<td>Yes</td>
</tr>
</tbody>
</table>
### Overview of the Define CAD Server Schema File Utility

<table>
<thead>
<tr>
<th>ElementLevelNumber</th>
<th>Level Number in which the element resides.</th>
<th>Yes. If criteria is set on both level name and on level number, elements that have either matching level name or matching level number will be returned. This is because level number or level name actually mean the same thing.</th>
</tr>
</thead>
<tbody>
<tr>
<td>ElementStyle</td>
<td>Symbology. Style of an element. Stored as Int32 value. Each level can have a default style set. The style of an element can be independently set or &quot;by level&quot;. If set to &quot;by level&quot; the default symbology settings of the level in which the element lies get attributed to this element. The values 0 to 7 represent the following line styles. 0 - Solid 1 - Dotted 2 - Medium Dash 3 - Long Dash 4 - Dot Dash 5 - Short Dash 6 - Dash Double Dot 7 - Long Dash Short Dash</td>
<td>Yes</td>
</tr>
<tr>
<td>ElementType</td>
<td>Type of element</td>
<td>Yes</td>
</tr>
<tr>
<td>ElementWeight</td>
<td>Symbology. Weight of element in pixels. Similar to style of element.</td>
<td>Yes</td>
</tr>
<tr>
<td>ElementZ</td>
<td>Specifies the Z coordinate value associated with the element in a 2D or 3D design file. This will be the minimum Z value of the range of the element. For 2D .dgn files, if the minimum Z of the range of the element exceeds the threshold of −1.8 billion, a NULL will be served.</td>
<td>No</td>
</tr>
<tr>
<td>---</td>
<td>---</td>
<td>---</td>
</tr>
<tr>
<td>EntityNumber</td>
<td>This corresponds to the entitynum column in the MSCATALOG row for a particular table. This contains the entity number of the table. The entity number is a positive integer from 1 to 65535 that uniquely identifies the table to the database; each table referenced by a design file must have a unique entity number.</td>
<td>Yes</td>
</tr>
<tr>
<td>FontNumber</td>
<td>Specifies the font number of the MicroStation v8 text element.</td>
<td>Yes</td>
</tr>
<tr>
<td>FullName</td>
<td>Specifies name of the map file with its path. This is not an attribute of the MicroStation element.</td>
<td>No</td>
</tr>
<tr>
<td>GraphicGroupNumber</td>
<td>Specifies the number associated with a graphic group.</td>
<td>Yes</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
<td>Note</td>
</tr>
<tr>
<td>----------------------------</td>
<td>-----------------------------------------------------------------------------</td>
<td>------</td>
</tr>
<tr>
<td>GraphicTextString</td>
<td>This field is not the attribute of a MicroStation element header. This field is used to populate the text value associated with a text element as a gdbText field.</td>
<td></td>
</tr>
<tr>
<td>GraphicTextStringMemo</td>
<td>This field is not the attribute of a MicroStation element header. This field is used to populate the text value associated with a text element as a gdbMemo field.</td>
<td></td>
</tr>
<tr>
<td>ID</td>
<td>This is not an attribute of the MicroStation element. This is used to serve as the primary key for the CAD data server. This is an auto number field generated by the server and is hidden from the client, IMAGINE.</td>
<td></td>
</tr>
<tr>
<td>MapName</td>
<td>Specifies name of the map file in which the element is present. This is not an attribute of the MicroStation element.</td>
<td></td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
<td>Required</td>
</tr>
<tr>
<td>-------------------</td>
<td>-----------------------------------------------------------------------------</td>
<td>----------</td>
</tr>
<tr>
<td>ModelName</td>
<td>Model is a named set of elements in a <code>.dgn</code> file. A <code>.dgn</code> file can have multiple models. When a <code>.dgn</code> file is created, a model by name &quot;default&quot; is created. A model can be placed as a cell or attached as a reference. Every element in the <code>.dgn</code> file belongs to a specific model or to a default model.</td>
<td>Yes</td>
</tr>
<tr>
<td>OccurrenceNumber</td>
<td>Specifies the row of the database table that is linked to the element. Valid values are 0 to (2^{32}-1).</td>
<td>Yes</td>
</tr>
<tr>
<td>PathName</td>
<td>Specifies path of the map file in which the element is present. This is not an attribute of the MicroStation element.</td>
<td>No</td>
</tr>
<tr>
<td>TextHeight</td>
<td>Specifies the height of the text characters in the text element in decimal master design file units of the corresponding design file.</td>
<td>Yes</td>
</tr>
<tr>
<td>TextWidth</td>
<td>Specifies the width of the text character in the text element in decimal master design file units of the corresponding design file.</td>
<td>Yes</td>
</tr>
<tr>
<td>ElementColorRGB</td>
<td>This field is used to populate the element color as RGB value.</td>
<td>No</td>
</tr>
<tr>
<td>ElementFillColorRGB</td>
<td>This field is used to populate</td>
<td>No</td>
</tr>
</tbody>
</table>
the element fill color as RGB value.

<table>
<thead>
<tr>
<th>FontName</th>
<th>This field is used to populate the font name used while serving text geometry. The font name is retrieved by reading the INI parameters.</th>
</tr>
</thead>
<tbody>
<tr>
<td>FontSizeHiMetric</td>
<td>This field is used to populate the fontsize of the text element in HiMetric units. This value is calculated by multiplying the text height with a value of (35.27777777777775) and the font scaling factor as mentioned in the INI file.</td>
</tr>
</tbody>
</table>

In the case of orphan and unnamed cells (served as BoundaryGeometry), the graphic attributes (GraphicGroupNumber, ElementLevelName, ElementLevelNumber, ElementStyle, ElementWeight, and ElementColor) of the first element in the sequence will be used to populate the graphic attributes of the feature and to set the criteria. In case of named cells, the graphic attributes of the cell header will be used.

For a sequence of complex shapes, the first of which is solid and subsequent ones holes, (served as BoundaryGeometry), the graphic attributes of the first element in the sequence are used to populate the graphic attributes of the feature.

### GeoMedia Style Property to GField Mapping

The GFields used to set the various properties on StyleDefinition are explained in the following table:

<table>
<thead>
<tr>
<th>GeoMedia style type</th>
<th>Style property</th>
<th>GFields / ABS expression used for the property value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Symbol style</td>
<td>OverrideColor</td>
<td>EntityColorRGB</td>
</tr>
<tr>
<td></td>
<td>Size</td>
<td>ElementWeight*26.45833 (See Note below.)</td>
</tr>
</tbody>
</table>
Overview of the Define CAD Server Schema File Utility

<table>
<thead>
<tr>
<th>Simple Line Style</th>
<th>Color</th>
<th>ElementColorRGB</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Width</td>
<td>ElementWeight*26.45833</td>
</tr>
<tr>
<td></td>
<td>SequenceType</td>
<td>IF (ElementStyle&gt;=0 AND ElementStyle&lt;=7, ElementStyle, 0)</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Fill style</th>
<th>Color</th>
<th>ElementFillColorRGB</th>
</tr>
</thead>
</table>

<table>
<thead>
<tr>
<th>Text style</th>
<th>Color</th>
<th>EntityColorRGB</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>FontName</td>
<td>Font Name</td>
</tr>
<tr>
<td></td>
<td>FontSize</td>
<td>FontSizeHiMetric</td>
</tr>
</tbody>
</table>

**NOTE**: Concerning the ElementWeight*26.45833 field: GeoMedia’s Style Definition expects the Size of the Symbol Style, Width of the Simple Line style, and FontSize of the Text style to be in HiMetric units. Hence the conversion is needed to convert the value to HiMetric units.

### Database Attributes

The database attributes are served using the existing CAD ODBC scanner. The ODBC scanner will read the database attributes from the external database table bases on the values of the EntityNumber and OccurrenceNumber fields populated by the graphics scanner.

For the data server to serve the database attributes for a database-linked feature class, at least one of the linkage attributes (EntityNumber/OccurrenceNumber) must be exposed in the .csd file, and the database linkage attribute (EntityNumber) should be used in setting the criteria.

If neither entity number nor occurrence number participates in the feature class definition (criteria), and if the element has one or more linkages, then the EntityNumber and OccurrenceNumber fields are populated with the first linkage values.

### Native-to-GDO Geometry Type Mapping

For 2D design files, the Z coordinate is populated with the minimum Z value of the range of the element. If this value exceeds the threshold of –1.8 billion, the Z coordinate is populated with a value of 0. This is because there cannot be NULL coordinates in the geometry blob.

For 3D design files, the actual Z coordinate will be served.

The following table identifies the mapping used when converting from native geometry types to GDO geometry types.
<table>
<thead>
<tr>
<th>Native Geometry Type</th>
<th>Native Meaning</th>
<th>GDO Geometry Type</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cell - named (Type 2)</td>
<td>A complex element composed of a group of primitive or other complex elements that is stored in a cell library for repeated placement. This has a name associated with it. Hole flag for the cell is set to false. Orphan / shared cells can also be constituent elements. Incorrectly constructed orphan cells will be treated as a named cell. Nested cells are also supported.</td>
<td>OrientedPointGeometry / TextPointGeometry / CollectionGeometry. This is served based on the .ini file variables</td>
</tr>
<tr>
<td>Cell - orphaned (Type 2)</td>
<td>A complex element composed of a group of primitive or other complex elements for repeated placement. This has a name associated with it but the hole flag is set to TRUE - indicating that there is no corresponding element in the cell library. Orphan cells of a particular form (composed only of shape (type 6), ellipse (type 15) or complex shape (type 12) elements - the first element should be solid and the rest holes) result in the generation of Boundary geometry. Otherwise the cell will be treated as a named cell.</td>
<td>BoundaryGeometry</td>
</tr>
<tr>
<td>Cell - unnamed (Type 2)</td>
<td>Unnamed cells are identified by the lack of a cell name in the header. Since there is no name, there can be no corresponding element in the cell library and the hole flag setting is irrelevant. They are to be handled the same way as orphan cells (if the form is appropriate, create a boundary geometry, otherwise treat as a named cell).</td>
<td>BoundaryGeometry</td>
</tr>
<tr>
<td>------------------------</td>
<td>-------------------------------------------------------------------------------------------------</td>
<td>------------------</td>
</tr>
<tr>
<td>Line (Type 3)</td>
<td>An open graphic element composed of 2 points connected to each other.</td>
<td>PolylineGeometry / OrientedPointGeometry In case of degenerate lines, OrientedPointGeometry is served</td>
</tr>
<tr>
<td>LineString (Type 4)</td>
<td>An open graphic element composed of line segments connected at the vertices. A line string element can have a maximum of 5000 vertices. If more than 5000 vertices are defined, a complex chain consisting of one or more line string elements is created.</td>
<td>PolylineGeometry</td>
</tr>
<tr>
<td>Shape (Type 6)</td>
<td>Closed primitive element composed of up to 100 linear segments.</td>
<td>PolygonGeometry</td>
</tr>
<tr>
<td>TextNode (Type 7)</td>
<td>Multiple text elements grouped in a complex element. When a text is placed in MicroStation V8 product &quot;along element,&quot; a text node is placed with each letter of the text string placed as an independent text (Type 17) element.</td>
<td>GeometryCollection (TextPointGeometry) / TextPointGeometry If the text node is composed of only single-character and zero length text elements; then it is served as a composite text collection. For this, the options field of each text blob is set to gptCompositeText (0x01). See the SERVE TEXTNODE AS MULTILINE TEXT INI keyword section for more details.</td>
</tr>
<tr>
<td>---</td>
<td>---</td>
<td>---</td>
</tr>
<tr>
<td>Curve (Type 11)</td>
<td>Curve element</td>
<td>PolylineGeometry (Stroked)</td>
</tr>
<tr>
<td>Complex String (Type 12)</td>
<td>An open complex element that is formed from a series of open elements, such as lines, line strings, and arcs.</td>
<td>CompositePolylineGeometry</td>
</tr>
<tr>
<td>Complex Shape (Type 14)</td>
<td>A closed complex element formed from a series of open primitive elements.</td>
<td>CompositePolygonGeometry BoundaryGeometry is served for a sequence of complex shapes, the first of which is solid and subsequent ones holes.</td>
</tr>
<tr>
<td>Ellipse (Type 15)</td>
<td>MicroStation Ellipse (Type 15)</td>
<td>PolygonGeometry</td>
</tr>
<tr>
<td>Arc (Type 16)</td>
<td>Regularly curved open element that has a constant radius around a single center point.</td>
<td>Stroked PolylineGeometry for elliptical arcs / ArcGeometry for circular arcs</td>
</tr>
<tr>
<td>Text (Type 17)</td>
<td>Text string element</td>
<td>TextPointGeometry</td>
</tr>
</tbody>
</table>
Point string (Type 22) | A string of points with each point associated with orientation. The points will be assigned zero orientation. | GeometryCollection (OrientedPointGeometry) 

Shared Cell (Type 35) | A cell whose elements are stored only once in the design file, regardless of how often the cell is placed. Any change made to a shared cell is reflected in all instances of that shared cell. Orphan, named and shared cells can also be constituent elements. | OrientedPointGeometry / TextPointGeometry / CollectionGeometry. This is served based on the .ini file variables 

All other Microstation V8 types, like Multiline, Cone, Surface, Solid, Bspline, Dimensions, Raster, etc. | Not supported. |

**Serving Text**

MicroStation text and text node elements will be served in rich text format with the color, size, and font details read from the MicroStation element. The MicroStation text/text node element has the text height and width stored in the design file in UORs. The mapping of the color, size, and font details are explained below:

**Font:** For MicroStation fonts, the font number of the MicroStation text element is mapped using the FONT NUMBER mapping specified in the .ini file. For AutoCAD SHX fonts, the font is mapped using the FONT NAME mapping specified in the .ini file. If no matching font is found, Arial is used as the default.

**Size:** The text height of the MicroStation text element will be mapped to the font size of the rich text using the font scaling factor defined in the .ini file. The character scaling value (specified by \charscalex, as a percentage of font size) will be calculated using the text height and text width.

**Color:** If the MicroStation design file has the color table attached to it, the color index of the text element is mapped to the RGB color using the color table. If no color table is attached to
the design file, the color index stored in the element’s display header is mapped to the RGB color using the default color table delivered with IMAGINE. In the absence of the type 5 color table element and the default color table file, the color is not served with the rich text.

Limitations and issues

The following are the limitations of the MicroStation V8 scanner:

- Multiple database linkages and multiple databases are not supported.
- Custom line styles like Border, Center, and DashDot are not mapped to corresponding styles in IMAGINE (while serving the LegendEntry extension). These are instead mapped to Solid line style.

Error Handling

In any particular command, all the mandatory information has to be filled in before clicking OK. If any such information is missing or is invalid, you are prompted with an error message to enter a valid value. In the case of defining a feature class, all the information on all the tabs is validated when you click OK.

While creating or opening a .csd file, the input .csd file is validated and appropriate error messages will be given. For example:

- If the template file is corrupt, then the following error message is displayed:
  
  The selected template file is either invalid or corrupt.

- If the .csd file is corrupt, then the following error message is displayed:
  
  The selected CAD Schema definition file is either invalid or corrupt.

- If the .csd file contains folders that do not exist, then the following error message is displayed:
  
  One or more folders cannot be found. Use "Select Maps" or Select Coordinate System Files to change the folders.

- If the .csd file contains map files that do not exist, then the following error message is displayed:
  
  One or more map files cannot be found. Use the "Select Maps" command to edit.
- If the .csd file contains coordinate system files that do not exist, then the following error message is displayed:

  One or more coordinate system files cannot be found. Use the "Select Coordinate System" command to edit.

In the Select Maps or the Select Coordinate System Files command the following messages are displayed:

- If the selected folder does not exist, then the following error message is displayed:

  This folder cannot be found. Do you want to change the folder?

- While changing the folders in Select Maps, if there is any coordinate system file in the folder that is present in the .csd file, then the following message is displayed:

  This folder is also used for coordinate system files. Do you want this same change to the coordinate system files folder?

- While changing the folders in the Select Coordinate System Files command, the above message is changed accordingly.

- If selected map files are unselected or folders containing selected map files are removed, then when you click on OK, the decision message displayed is:

  Some of the unselected or removed map files are associated with feature classes or with coordinate system files. Click Yes to disassociate the map files.

- While in Select Coordinate System Files, the above message is changed accordingly, as follows:

  Some of the unselected or removed coordinate system files are associated with feature classes or map files

  Click Yes to disassociate the coordinate system files.

- If you change the folder of coordinate system files and the already selected map files are also contained in the new folder then the following message is displayed:

  This folder is also used for map files. Do you want to make this same change to the map files folder?

- When you try to remove an existing folder in the Select Coordinate System Files dialog box, the following message is displayed:

  Removing this folder will also remove the coordinate system files in the folder. Do you want to continue?

- When you try to remove an existing folder in the Select Map Files dialog box, the following message is displayed:
• Removing this folder will also remove the map files in the folder. Do you want to continue?

In feature class definition dialog boxes, the following messages are displayed:

• For invalid feature class name the displayed message is:

  Feature class name is not set to a valid value. The name must start with a letter and can only contain letters, numbers, and/or underscores.

• Without selecting the primary geometry, if you change the tab from General to any other tab, then the following error message is displayed:

  A geometry type must be specified for the feature class.

• If you click OK on the dialog box without specifying the criteria, then the following error message is displayed:

  Classification criteria must be specified for the feature class.

• If you give an invalid value as the criteria for any attribute on the criteria tab, then the following error message is displayed:

  Invalid values: Attribute “%s”

• If you enter an invalid table or field name in the Linkage tab, then the following error message is displayed:

  Invalid/missing database table name or linkage field name. Do you want to continue?

• If tag information is incomplete on the Tags tab, then the following error message is displayed:

  Incomplete tags information.

• If any of the selected tags has the same name as that of the primary key field for graphic only features (for example, ID), then the following error message is displayed:

  The primary key for the graphic only features has the same name as one of the selected tags. The tag field name must be unique.

• If any of the selected tags has the same name as that of the primary key field for database linked features, then the following error message is displayed:

  The primary key for the database linked features has the same name as one of the selected tags. The tag field name must be unique.

• If any of the selected tags has the same name as that of the selected graphic attributes, the following error message is displayed:
• One of the graphic attributes has the same name as one of the selected tags. 
  The tag field name must be unique.

• If you try to delete the selected feature classes, then the following error message is displayed:
  Are you sure you want to delete the selected feature classes?

• If you try to unselect both EntityNumber and OccurrenceNumber attributes for a database linked feature class, then the following error message is displayed.
  Either EntityNumber or OccurrenceNumber attribute must be selected for feature classes with database linkages.
  Are you sure you want to unselect both of these attributes?

In the Connection command from the Options menu, the following messages are displayed:

• If the .ini file you entered does not exist, then the following error message is displayed:
  The INI file does not exist.

In the Primary Unique Key command, the following messages are displayed:

• If you try to unselect the primary unique key for the graphic only feature classes, then the following error message is displayed:
  A graphic only feature class must have a primary unique key.

• If you try to unselect the primary unique key for the database linked feature classes in case of a .csd file built from the MicroStation template file, then the following error message is displayed:
  A database linked feature class must have a primary unique key.

In the Advance Database Linkage command, the following messages are displayed:

• If you try to unselect the graphic to database table linkage, then the following error message is displayed:
  A database linked feature class must have the database table linkage information.

• If you try to unselect the graphic to database row linkage, then the following error message is displayed:
  A database linked feature class must have the row linkage information.

In the Update Map MBRs command, the following messages are displayed only for a .csd file built upon unknown templates:

• If you try to enter invalid MBR values, then the following error message is displayed:
  Enter a valid coordinate value.

• If all the MBR values are not entered, then the following error message is displayed:
All the four extents of the selected map are required.

While saving the .csd file, all the information entered will be validated and an appropriate error message will be given. For example:

- If no feature class is defined for the .csd file, the following error message is displayed:
  
  *At least a single feature class must be defined to save the csd file.*

- If the feature class is not associated with any map, the following message is displayed:
  
  *The feature class %s is not associated with any map. Each feature class should be associated with at least one map.*

- If the feature class is not associated with any coordinate system file, while the associated map files are associated with coordinate system files, the following message is displayed:
  
  *The feature class %s is not associated with any coordinate system. Each feature class should be associated with one coordinate system.*

- If the map is not associated with any coordinate system file, the following message is displayed:
  
  *The map %s is not associated with any coordinate system. Each map should be associated with one coordinate system.*

- If the .csd file contains some folders for maps or .csf files, which do not exist, then the following error messages is displayed:
  
  *One or more folders cannot be found. Use "Select Maps" or Select Coordinate System Files" to change the folders.
  Do you want to save the file without changing the folders?*

- If the path of the coordinate system files selected earlier is changed, the the following error message is displayed:
  
  *One or more coordinate system files cannot be found. Use the "Select Coordinate System Files" command to edit.

- If the .csd file contains coordinate system files that do not exist, then the following error message is displayed:
  
  *One or more coordinate system files cannot be found. Use the "Select Coordinate System Files" command to edit or save without editing.
  Do you want to save the file without editing?*

- If the .csd file contains map files that do not exist, then the following error message is displayed:
• One or more map files cannot be found. Use the "Select Map" command to edit or save without editing.
  Do you want to save the file without editing?
• If the .csd file contains coordinate system files that do not exist, then the following error message is displayed:
  One or more coordinate system files cannot be found. Use the "Select Coordinate System Files" command to edit or save without editing.
  Do you want to save the file without editing?

Rich Text Format (RTF) Specification

Font pitch
The control word, denoted as \fprqN, specifies if the font is Fixed or Variable. If the font pitch is Fixed, every character has the same width. If the font pitch is Variable some letters are wider than others (that is, the letter "i" is not as wide as the letter "W"). Values for N are 0 (default pitch), 1 (fixed pitch) and 2 (variable pitch).

Font family
RTF supports font families so that applications can attempt to intelligently choose fonts if the exact font is not present on the reading system. RTF uses the following control words to describe the various font families.

<table>
<thead>
<tr>
<th>Control word</th>
<th>Font family</th>
<th>Examples</th>
</tr>
</thead>
<tbody>
<tr>
<td>\fnil</td>
<td>Unknown or default fonts (the default)</td>
<td>Not applicable</td>
</tr>
<tr>
<td>\froman</td>
<td>Roman, proportionally spaced serif fonts</td>
<td>Times New Roman, Palatino</td>
</tr>
<tr>
<td>\fswiss</td>
<td>Swiss, proportionally spaced sans serif fonts</td>
<td>Arial</td>
</tr>
<tr>
<td>\fmodern</td>
<td>Fixed-pitch serif and sans serif fonts</td>
<td>Courier New, Pica</td>
</tr>
<tr>
<td>\fscript</td>
<td>Script fonts</td>
<td>Cursive</td>
</tr>
<tr>
<td>\fdecor</td>
<td>Decorative fonts</td>
<td>Old English, ITC Zapf Chancery</td>
</tr>
<tr>
<td>\ftech</td>
<td>Technical, symbol, and mathematical fonts</td>
<td>Symbol</td>
</tr>
<tr>
<td>\fbidi</td>
<td>Arabic, Hebrew, or other bidirectional font</td>
<td>Miriam</td>
</tr>
</tbody>
</table>
## Charset

The control word, denoted as `\charsetN`, specifies the character set of a font in the font table. Values for N are defined by Windows header files, as follows:

<table>
<thead>
<tr>
<th>Value</th>
<th>Character Set</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>ANSI</td>
</tr>
<tr>
<td>1</td>
<td>Default</td>
</tr>
<tr>
<td>2</td>
<td>Symbol</td>
</tr>
<tr>
<td>3</td>
<td>Invalid</td>
</tr>
<tr>
<td>77</td>
<td>Mac</td>
</tr>
<tr>
<td>128</td>
<td>Shift Jis</td>
</tr>
<tr>
<td>129</td>
<td>Hangul</td>
</tr>
<tr>
<td>130</td>
<td>Johab</td>
</tr>
<tr>
<td>134</td>
<td>GB2312</td>
</tr>
<tr>
<td>136</td>
<td>Big5</td>
</tr>
<tr>
<td>161</td>
<td>Greek</td>
</tr>
<tr>
<td>162</td>
<td>Turkish</td>
</tr>
<tr>
<td>163</td>
<td>Vietnamese</td>
</tr>
<tr>
<td>177</td>
<td>Hebrew</td>
</tr>
<tr>
<td>178</td>
<td>Arabic</td>
</tr>
<tr>
<td>179</td>
<td>Arabic Traditional</td>
</tr>
<tr>
<td>180</td>
<td>Arabic user</td>
</tr>
<tr>
<td>181</td>
<td>Hebrew user</td>
</tr>
<tr>
<td>186</td>
<td>Baltic</td>
</tr>
<tr>
<td>204</td>
<td>Russian</td>
</tr>
<tr>
<td>222</td>
<td>Thai</td>
</tr>
<tr>
<td>238</td>
<td>Eastern European</td>
</tr>
</tbody>
</table>
Overview of the Define CAD Server Schema File Utility

<table>
<thead>
<tr>
<th>254</th>
<th>PC 437</th>
</tr>
</thead>
<tbody>
<tr>
<td>255</td>
<td>OEM</td>
</tr>
</tbody>
</table>
Overview of the Define Coordinate System File Utility

The Define Coordinate System File utility lets you define and edit coordinate system files. The software stores geographic data with reference to one of many possible coordinate systems. These coordinate systems provide the mathematical basis for relating the features in your study area to their real-world positions.

Defining or Editing a Coordinate System File

A coordinate system provides a way to associate a geographic coordinate to each model coordinate in the GIS storage space. The data residing in the storage space can be characterized by its accuracy (deviation from the "true" geographic location) and by its precision (the level of detail). The typical data set has an accuracy of no better than 1 centimeter. However, software and hardware advancements allow the GIS to maintain and exhibit levels of precision that are below 1 centimeter.

The software stores geographic data with reference to one of many possible coordinate systems. These coordinate systems provide the mathematical basis for relating the features in your study area to their real-world positions.

Three categories of coordinate systems are supported:

- Projected coordinate systems express coordinates as X,Y,h, where X normally points east on the plane of the map, and Y point north at the point chosen for the origin of the map. The X coordinate is called easting; the Y, northing. The h represents height. Projected coordinate systems differ in how they represent the curved surface of the earth on the flat surface of a map.
- Geographic Coordinate systems express coordinates as lon,lat,h, where long (longitude) is the angular distance from a zero meridian, lat (latitude) is the angular distance from the equator, and h is height.
- Geocentric coordinate systems express coordinates as defining the position of a specific point with respect to the center of the earth. These coordinates are Cartesian (X, Y, Z) where the X axis of the geocentric system passes through the intersection of the prime meridian and the equator, the Y axis passes through intersection of the equator with 90
degrees East, and the Z axis corresponds with the earth's polar axis. The X and Y axes are positive pointing outwards, while the Z axis is positive towards the North Pole.

The software interprets horizontal coordinates with reference to a geodetic datum, which defines precisely the reference ellipsoid and its position relative to the surface of the earth. The ellipsoid is the model used to represent the shape of the earth’s surface. The software interprets vertical coordinates (height values) with reference to a network of vertical control or other vertical reference frame called the vertical datum.

**Defining a Coordinate System File**

1. Run the Define Coordinate System File.
2. Select the General tab.
3. Select the Coordinate system type for your coordinate system: Geographic, Projection, or Geocentric.
4. For projected coordinate systems only: On the Projection Space tab, select a projection algorithm from the Projection algorithm drop-down list.
5. Click Projection Parameters to open the Projection Parameters dialog box.
6. In the text boxes, type the appropriate parameters, and click OK. Depending on the projection algorithm you selected, some of the text boxes may be read-only.
7. Optional: Click the Geographic Space tab.
8. From the Geodetic datum drop-down list, select the geodetic datum for your coordinate system.
   
   **NOTE**: The drop-down list contains all of the standard (pre-defined) and named (configurable) geodetic datums available on the system. Named horizontal geodetic datums are defined in the file ..\cssruntm\cfg\NamedHDatum.ini.
9. If you select the user-defined (non-standard) geodetic datum, you can change the ellipsoid on the Geographic Space tab (using the Reference ellipsoid drop-down list), and if you select the user-defined (non-standard) ellipsoid, you can change ellipsoid parameters as well. Click Ellipsoid Parameters to open the Reference Ellipsoid Parameters dialog box.
10. Review (or when allowed, edit) the parameters, and click Cancel (or click OK when allowed to edit).
11. On the Geographic Space tab, select the vertical datum from the Vertical datum drop-down list, which contains all of the standard (pre-defined) vertical datums available on the system.
12. **Optional for the GeoWorkspace coordinate system:** On the **Storage Space** tab, set the horizontal storage unit, vertical storage unit, geocentric storage unit, and storage center parameters. (The content of this tab varies depending on the base storage type. For the geographic base storage type, you define the horizontal and vertical storage units, but the storage center options are longitude, latitude, and height. For the geocentric base storage type, you define the geocentric storage unit and the storage center options of X, Y, and Z.)

13. Click **OK** on the **GeoWorkspace Coordinate System** dialog box.

14. The **Save Coordinate System File As** dialog box appears.

15. From the **Save in** drop-down list, select the appropriate location to save the coordinate system file.

16. In the **File name** text box, type the name that you want to give to the coordinate system file.

17. Verify that the **Save as type** is set to **Coordinate System File**.

18. Click **Save**.

**NOTES**

- Ellipsoid parameters are preset per geodetic datum and cannot be changed unless the geodetic datum and reference ellipsoid are both set to **user-defined (non-standard)**.

- Setting the projection algorithm (on the **Projection Space** tab) to certain values causes the geodetic datum to be preset and unchangeable. For the British National Grid, Budapest Stereographic, EOV, the three Hungarian Oblique Cylindric systems, HR_HDKS, both Japan Plane Rectangular systems, KKI, MK_TM, both New Brunswick Stereographic systems, New Zealand Map Grid, New Zealand Transverse Mercator, RD (Amersfoort), RT 90, SI_TM, State Plane 1927, SWEREF 99, both Switzerland LV systems, and the Spherical Mercator for Visualization system, the geodetic datum is preset and cannot be changed. For the State Plane 1983 projection algorithm, the datum is preset to the North American 1983 datum and may be changed only to the North American 1983 - HARN datum. For the Gauss-Boaga projection algorithm, the datum is preset to the Rome 1940 datum and may be changed only to the Monte Mario datum. An exception for these preset systems is that a named datum may be used with them provided that its base standard datum is the appropriate preset datum.

- Changing the coordinate system type from **Projection** or **Geocentric** to **Geographic** resets the horizontal storage unit to 1 degree and the vertical storage unit to 1 meter. Changing the coordinate system type from **Geographic** or **Geocentric** to **Projection** resets the horizontal and vertical storage units to 1 meter. Changing the coordinate system type from
Overview of the Define Coordinate System File Utility

Projection or Geographic to Geocentric resets the geocentric storage unit to 1 meter. Each of these changes resets the storage center to (0,0,0).

- Changing the coordinate system type from Projection or Geographic to Geocentric resets the vertical datum to Ellipsoid (geometric).
- Transformation of coordinates between the GeoWorkspace coordinate system and any other, different coordinate system (such as a warehouse feature class coordinate system) is controlled by entries in the autodt.ini configuration file.

To accurately display raster images, or data from many non-Intergraph proprietary formats in a GeoWorkspace, the coordinate system of the GeoWorkspace must either match that of the feature data in the warehouse or you must define a coordinate system file for the feature data so that it can be correctly converted for you. Assigning a coordinate system to your source data is the only way to ensure that the software understands the source projection of your data.

Data servers which use coordinate system files typically specify the association of feature name to coordinate system file in their .ini file. In some cases these data servers allow the same coordinate system file to be shared by all features in the warehouse. To create a coordinate system file (*.csf), you use the Define Coordinate System File executable that is delivered with the software. A common method to create the .ini file is the Define Warehouse Configuration File utility.

Editing a Coordinate System File

To edit an existing .csf file, double click the filename. This opens the Define Coordinate System File dialog box. Make changes to the file as appropriate and save it. You can also open an existing .csf file within the Define Coordinate System File utility by clicking Load to display the Load Coordinate System From File dialog box, on which the file filter text will show Coordinate System Files (*.csf) as the default selection, with Design Files (*.dgn), Projection Files (*.prj), and All Files (*.*) as optionally available filters.

General Tab

Allows you to define the type of the coordinate system and to optionally provide a name and a description.

Dialog Box Options

Coordinate system type
Allows you to select the type of the coordinate system. For a coordinate system that describes a physical storage (such as a warehouse feature class or the model space of imagery), the coordinate system type defines the base storage type for the data. For other coordinate systems (such as one describing a displayed view) the coordinate system type indicates the essence and predominant usage of the coordinate system (for example, a coordinate system for a map view display defines distortion characteristics which may be noticed in the map view display).

**Geographic**
Expresses coordinates as longitude, latitude, and height.
The Y coordinate (parallel) in a geographic coordinate system. Latitude is typically measured in degrees, minutes, and seconds from the equator.
The X coordinate (meridian) in a geographic coordinate system. Longitude is typically measured in degrees, minutes, and seconds from the central or zero meridian.

**Projection**
Expresses coordinates as X, Y, height. X normally points east on the plane of the map, and Y normally points north at the point chosen for the map's origin. The X coordinate is called easting; the Y, northing. Projected coordinate systems differ in how they represent the curved surface of the earth on the flat surface of a map.

A system of intersecting coordinate lines—meridians and parallels—on a flat surface on which features from the curved surface of the earth are mapped and used to measure spatial location.

Unscaled X and Y mapping coordinates in the same units of measurement as ground measurements, such as kilometers, meters, centimeters, kilofeet, feet, inches, miles, or survey feet.

Unscaled X and Y mapping coordinates in the same units of measurement as ground measurements, such as kilometers, meters, centimeters, kilofeet, feet, inches, miles, or survey feet.

**Geocentric**
Expresses coordinates as defining the position of a specific point with respect to the center of the earth. These coordinates are Cartesian (X, Y, Z) where the X axis of the geocentric system passes through the intersection of the prime meridian and the equator, the Y axis passes through the intersection of the equator with 90 degrees East, and the Z axis corresponds with the earth's polar axis. The X and Y axes are positive pointing outwards, while the Z axis is positive towards the North Pole.

**Optional information**

**Name**
Enter the name of the coordinate system being defined. The name is limited to 100 characters in length.
Description
Enter a description for the coordinate system being defined. The description is limited to 255 characters in length.

Storage Space Tab
Allows you to define the storage units and storage type for the coordinate system in the active GeoWorkspace or feature class.

Dialog Box Options (Geographic Storage Space)

Horizontal storage unit
This combination of a text box and unit-of-measure drop-down list allows you to specify the horizontal storage unit for the geographic storage space. The horizontal storage unit defines the distance between sequential integer coordinate values. (For example, if the storage unit is 0.0001 sec., and the x coordinate of a point changes from 1 to 2, the distance in the x direction of the change is 0.0001 sec.) The number used must be greater than zero, and the default value is 1 degree.

A geographic coordinate system references a spheroid, expressing coordinates as longitude, latitude, height, where longitude is the angular distance from a prime meridian, latitude is the angular distance from the equator, and height is measured above a known reference surface.

NOTE When the dialog box is reached from the Define Coordinate System File executable, the horizontal storage unit you choose will be stored in the resulting .csf file and will be used for subsequent editing of the .csf file.

Vertical storage unit
This combination of a text box and unit-of-measure drop-down list allows you to specify the vertical storage unit for the geographic storage space. The vertical storage unit defines what the distance between sequential Z coordinate values is. This option is only available when the

---

1 A file through which you view geographic data. If you are connected to a read-write warehouse, you can also place and manipulate data from the GeoWorkspace.
base storage type is geographic or projection. The number used must be greater than zero, and the default value is 1 meter (m).

**NOTE** When the dialog box is reached from the Define Coordinate System File executable, the vertical storage unit you choose will be stored in the resulting .csf file and will be used for subsequent editing of the .csf file.

**Storage center**

Allows you to offset the range of storage coordinates that is used. For example, you may want all coordinates to be positive. A normal data set has a center of (0,0), which means no shifting is defined.

- **Longitude**
  Allows you to specify the longitude value for the center of the geographic storage space. The X coordinate (meridian) in a geographic coordinate system. Longitude is typically measured in degrees, minutes, and seconds from the central or zero meridian.

- **Latitude**
  Allows you to specify the latitude value for the center of the geographic storage space. The Y coordinate (parallel) in a geographic coordinate system. Latitude is typically measured in degrees, minutes, and seconds from the equator.

- **Height**
  Allows you to specify the height value for the center of the geographic storage space.

**Dialog Box Options (Projection Storage Space)**

- **Horizontal storage unit**
  This combination of a text box and unit-of-measure drop-down list allows you to specify the horizontal storage unit for the projection storage space. The horizontal storage unit defines the distance between sequential integer coordinate values. (For example, if the storage unit is 0.0001 ft., and the x coordinate of a point changes from 1 to 2, the distance in the x direction of the change is 0.0001 ft.) The number used must be greater than zero, and the default value is 1 meter (m).

  A representation of the 3-D curved surface of the earth on a flat (2-D) surface.

- **Vertical storage unit**
  This combination of a text box and unit-of-measure drop-down list allows you to specify the vertical storage unit for the geographic storage space. The vertical storage unit defines what the distance between sequential Z coordinate values is. This option is only available when the
Overview of the Define Coordinate System File Utility

base storage type is geographic or projection. The number used must be greater than zero, and the default value is 1 meter (m).

**NOTE** When the dialog box is reached from the Define Coordinate System File executable, the horizontal and vertical storage units you choose will be stored in the resulting .csf file and will be used for subsequent editing of the .csf file.

**Storage center**

Allows you to offset the range of storage coordinates that is used. For example, you may want all coordinates to be positive. A normal data set has a center of (0,0), which means no shifting is defined.

- **X**
  - Allows you to specify the X value for the center of the projection storage space.

- **Y**
  - Allows you to specify the Y value for the center of the projection storage space.

- **Height**
  - Allows you to specify the height value for the center of the geographic storage space.

**Dialog Box Options (Geocentric Storage Space)**

**Geocentric storage unit**

This combination of a text box and unit-of-measure drop-down list allows you to specify the geocentric storage unit for the geocentric storage space. For the coordinate system of a data source, the geocentric storage unit defines what the distance between the sequential X, Y, or Z coordinate values is, when the base storage type is geocentric. The number used must be greater than zero, and the default value is 1 meter (m).

**NOTE** When the dialog box is reached from the Define Coordinate System File executable, the geocentric storage unit you choose will be stored in the resulting .csf file and will be used for subsequent editing of the .csf file.

**Storage center**

Allows you to offset the range of storage coordinates that is used. For example, you may want all coordinates to be positive. A normal data set has a center of (0,0), which means no shifting is defined.

- **X**
  - Allows you to specify the X value for the center of the geocentric storage space.

- **Y**
  - Allows you to specify the Y value for the center of the geocentric storage space.

- **Z**
  - Allows you to specify the Z value for the center of the geocentric storage space.
Allows you to specify the Z value for the center of the geocentric storage space.

**Projection Space Tab**

Allows you to select a projection algorithm and to define projection parameters that are unique to the selected algorithm.

A representation of the 3-D curved surface of the earth on a flat (2-D) surface.

**Dialog Box Options**

- **Projection algorithm**
  Allows you to select from the list of valid projection algorithms. Some projection algorithms, such as State Plane 1927, also set the datum and ellipsoid.
  
  The model used to represent the shape of the earth. Because the shape of the earth’s surface differs from one geographic area to another, different ellipsoids describe different areas.

- **Projection Parameters**
  Opens the Projection Parameters dialog box. The gadgets on the Projection Parameters dialog box change depending on the projection algorithm you chose. This button is disabled if you select Rectangular Grid or Krovak as your projection algorithm.

**Projection Parameters Dialog Box**

Specifies the parameters for the selected projection algorithm, such as projection centers and false easting, northing. If no parameters are available for the selected projection, this dialog box is unavailable. The gadgets on the Projection Parameters dialog box change depending on the projection algorithm you choose.

**Dialog Box Options**

- **Central line defined by**
  Specify how the oblique central line of the projection will be defined.
  
  - **Two points**
    Select to define the central line by two points. When this option is selected, you must enter the longitude and latitude of each point.
  
  - **Map center and azimuth angle**
Select to define the central line by map center and azimuth angle. When this option is selected, you must type in the longitude and latitude of the map center.

**Azimuth angle**

The azimuth of the central line at the map center for oblique projections. Used to calculate the location of the line where the cylindrical projection surface is tangent to the surface of the ellipsoid. For the Laborde, Oblique Mercator, preset Hungarian (EOV and Oblique Cylindric), and preset Swiss projections, the map center is also the projection angle. The azimuth is expressed in the default azimuth unit and precision set on the **Units and Formats** tab of the **Coordinate System** dialog box.

**Azimuth angle at skew origin**

The azimuth of the central line at the skew origin, which is approximately the intersection of the central line with the equator. The azimuth is expressed in the default azimuth unit and precision set on the **Units and Formats** tab of the **Coordinate System** dialog box.

**Azimuth angle at map center**

The azimuth angle of the central line at map center for Oblique Mercator projections. This text box is read-only when the **Two points** option is selected, in which case the displayed value is based upon the definition of the central line and the latitude of the map center point. When the **Map center and azimuth angle** option has been selected, this text box is read-write and the coordinates of the map center and the azimuth angle at the map center are used to define the central line of the projection. The azimuth is expressed in the default azimuth unit and precision set on the **Units and Formats** tab of the **Coordinate System** dialog box.

**Longitude of origin**

The geographic point of the origin of the projection. The longitude/latitude of the projection origin specifies the geographic location for the user-defined false easting, northing. The longitude of this point is used as the central meridian of the projection. The longitude is expressed in the default geographic unit and precision set on the **Units and Formats** tab of the **Coordinate System** dialog box.

**Longitude of map center**

Longitude of the geographic point in the area of interest used to locate the central line for oblique projections which use the skew origin for the actual projection origin. The longitude is expressed in the default geographic unit and precision set on the **Units and Formats** tab of the **Coordinate System** dialog box.

**Longitude of points 1 and 2**
The longitude of the two points that define the central line. These text boxes are available when the **Two points** option for defining the central line has been selected. The longitude is expressed in the default geographic unit and precision set on the **Units and Formats** tab of the **Coordinate System** dialog box.

**Latitude of origin**

The geographic point of the origin of the projection. The longitude/latitude of the projection origin specifies the geographic location for the user-defined false easting, northing. The latitude is expressed in the default geographic unit and precision set on the **Units and Formats** tab of the **Coordinate System** dialog box. For the stereographic projection algorithm, when the latitude of origin is at either pole, the **Latitude of true scale** field is available, whereas when the latitude of origin is not at either pole, the **Geographic radius of standard circle** field is available.

**Latitude of map center**

Latitude of the geographic point in the area of interest used to locate the central line for oblique projections which use the skew origin for the actual projection origin. The latitude is expressed in the default geographic unit and precision set on the **Units and Formats** tab of the **Coordinate System** dialog box.

**Latitude of true scale**

The latitude where the projection surface is tangent to or secant to the ellipsoid. It is also the line of true scale. The latitude is expressed in the default geographic unit and precision as defined on the **Units and Formats** tab of the **Coordinate System** dialog box. When you change the latitude of true scale, the content of the **Scale reduction factor at origin** (or **Scale reduction factor at pole**) field is updated to reflect the changed projection geometry.

For the Stereographic projection, this text box appears when the projection origin is at a pole.

**Latitude of points 1 and 2**

The latitude of the two points that define the central line. These text boxes are available when the **Two points** option for defining the central line has been selected. The latitude is expressed in the default geographic unit and precision set on the **Units and Formats** tab of the **Coordinate System** dialog box.

**Standard parallel**

The line where the projection surface is tangent to or intersects the ellipsoid. This is also the line of true scale. The parallel is expressed in the default geographic unit and precision set on the **Units and Formats** tab of the **Coordinate System** dialog box.

**Standard parallel 1**
The first of two lines where the projection surface is tangent to or intersects the ellipsoid. These are also the lines of true scale. The parallel is expressed in the default geographic unit and precision set on the Units and Formats tab of the Coordinate System dialog box.

**Standard parallel 2**
The second of two lines where the projection surface is tangent to or intersects the ellipsoid. These are also the lines of true scale. The parallel is expressed in the default geographic unit and precision set on the Units and Formats tab of the Coordinate System dialog box.

**False X**
The X coordinate value assigned to the origin of the projection system for a set of data. False X (or False easting) and False Y (or False northing) are constants added to the actual coordinate values to avoid negative coordinate values. False X and False Y values influence only the appearance of the coordinates—not their geometry, distortions, accuracy, or usefulness. The coordinates are expressed in the default projection unit and precision as defined on the Units and Formats tab of the Coordinate System dialog box.

**False Y**
The Y coordinate value assigned to the origin of the projection system for a set of data. False X (or False easting) and False Y (or False northing) are constants added to the actual coordinate values to avoid negative coordinate values. False X and False Y values influence only the appearance of the coordinates—not their geometry, distortions, accuracy, or usefulness. The coordinates are expressed in the default projection unit and precision as defined on the Units and Formats tab of the Coordinate System dialog box.

**False X at skew origin**
The X coordinate value assigned to the skew origin of the Rectified Skew Orthomorphic and Oblique Mercator projections. The skew origin is approximately the intersection of the central line with the equator. False X (or False easting) and False Y (or False northing) are constants added to the actual coordinate values to avoid negative coordinate values. False X and False Y values influence only the appearance of the coordinates—not their geometry, distortions, accuracy, or usefulness. The coordinates are expressed in the default projection unit and precision, as defined on the Units and Formats tab of the Coordinate System dialog box.

**False Y at skew origin**
The Y coordinate value assigned to the skew origin of the Rectified Skew Orthomorphic and Oblique Mercator projections. The skew origin is approximately the intersection of the central line with the equator. False X (or False easting) and False Y (or False northing) are constants added to the actual coordinate values to avoid negative coordinate values. False X and False Y
values influence only the appearance of the coordinates—not their geometry, distortions, accuracy, or usefulness. The coordinates are expressed in the default projection unit and precision, as defined on the Units and Formats tab of the Coordinate System dialog box.

**Official standard transformed parallel 1**
The first of two standard parallels for Bipolar Oblique Conic Conformal. The parallel is expressed in the default geographic unit and precision set on the Units and Formats tab of the Coordinate System dialog box.

**Official standard transformed parallel 2**
The second of two standard parallels for Bipolar Oblique Conic Conformal. The parallel is expressed in the default geographic unit and precision set on the Units and Formats tab of the Coordinate System dialog box.

**Scale reduction factor along longitude of origin**
The value of the scale factor at a given standard location. The standard location is anywhere along the meridian passing through the longitude of origin for Transverse Mercator, Universal Transverse Mercator, Gauss-Boaga, Gauss Conformal (South Africa), Gauss-Kruger, HR_HDKS, Japan Plane Rectangular, KKI, RT 90, and SWEREF 99.

**Scale reduction factor at parallels**
The value of the scale factor at a given standard location. The standard location is anywhere along the standard transformed parallels for Bipolar Oblique Conic Conformal.

**Scale reduction factor at the pole**
The value of the scale factor at a given standard location. The standard location is the North Pole for North Polar Stereographic and the South Pole for South Polar Stereographic. For these projections, when you change the scale reduction factor, the content of the Latitude of true scale text box is updated to reflect the changed projection geometry.

**Scale reduction factor at the equator**
The value of the scale factor at a given standard location. The standard location is the equator for Mercator. When you change the scale reduction factor for Mercator, the content of the Latitude of true scale text box is updated to reflect the changed projection geometry.

**Scale reduction factor at map center**
The value of the scale factor at a given standard location. The standard location is the map center for Rectified Skew Orthomorphic and Oblique Mercator.

**Scale reduction factor at origin**
Define the unitless scale reduction factor that applies at the projection origin. For the Stereographic projection, when the origin is at a pole and you change the scale reduction factor, the content of the **Latitude of true scale** text box is updated to reflect the changed projection geometry. When the projection origin is not at a pole and you change the scale reduction factor, the content of the **Geographic radius of standard circle** text box is updated to reflect the changed projection geometry.

**Scale reduction factor**

The value of the scale factor at a given standard location (which may vary with the projection); controls the distribution of scale distortions on the map; and when a value other than 1.0 is used, geometrically indicates the reduction of the projection surface so that the surface becomes secant to rather than tangent to the ellipsoid.

**Zone**

Allows you to select a zone number for the Universal Transverse Mercator, Japan Plane Rectangular, Gauss-Boaga, Gauss Conformal, Gauss-Kruger, HR_HDKS, and KKJ projection algorithms. Allows you to select a zone name for the ARC (Equal Arc-second Raster Chart/Map), RT 90, and SWEREF 99 projection algorithms. Changing the Zone value updates the remaining dialog box fields to reflect the parameter values for the selected zone. In all cases, Zone is the only active option; the other fields are read-only. Additionally for the ARC system, zone selection determines what fields are displayed, where non-polar zones are defined with the Standard Parallel parameter and polar zones are not

**Zone number**

Allows you to select a zone number for State Plane projection algorithms.

**Zone name**

Allows you to select the zone name corresponding to the zone number for State Plane projection algorithms.

**Hemisphere**

Allows you to select the **Northern** or **Southern** hemisphere.

**X-axis azimuth defined by Two points**

Allows you to select to specify that the azimuth of the X-axis of the projection will be defined by two points.

**X-axis azimuth defined by Angle keyin**

Allows you to select to specify that the azimuth of the X-axis of the projection will be defined by angle keyin.
Overview of the Define Coordinate System File Utility

X-axis azimuth angle
If the X-axis azimuth defined by Angle keyin option is selected, this option allows you to type in the azimuth of the X-axis of the projection. The azimuth is expressed in the default azimuth unit and precision set on the Units and Formats tab of the Coordinate System dialog box.

Geometric height of origin
Allows you to type a value for the geometric height for the projection origin. The height is expressed in the default height unit and precision set on the Units and Formats tab of the Coordinate System dialog box.

Geometric height of point 1
Allows you to type a value for the geometric height for the first of two points that will define the X-axis azimuth. The height is expressed in the default height unit and precision set on the Units and Formats tab of the Coordinate System dialog box.

Geometric height of point 2
Allows you to type a value for the geometric height for the second of two points that will define the X-axis azimuth. The height is expressed in the default height unit and precision set on the Units and Formats tab of the Coordinate System dialog box.

Geographic radius of standard circle
This text box is available when the projection origin is not at a pole. It allows you to define the geographic radius of standard circle projection parameter. The radius is expressed in the default geographic unit and precision as defined by the Units and Formats tab of the Coordinate System dialog box. When you change the geographic radius of standard circle, the content of the Scale reduction factor at origin text box is updated to reflect the changed projection geometry.

Geographic Space Tab
Allows you to select horizontal and vertical datums and to review or select the associated reference ellipsoid. It also allows you to review or to define parameters associated with the selected ellipsoid. Standard ellipsoids are linked to a predefined spheroid model.
Dialog Box Options

Geodetic datum
Allows you to define the horizontal geodetic datum for the coordinate system. For the British National Grid, Budapest Stereographic, EOV, the three Hungarian Oblique Cylindric systems, HR_HDKS, both Japan Plane Rectangular systems, KKI, MK_TM, both New Brunswick Stereographic systems, New Zealand Map Grid, New Zealand Transverse Mercator, RD (Amersfoort), RT 90, SI_TM, State Plane 1927, SWEREF 99, both Switzerland LV systems, and the Spherical Mercator for Visualization system, the geodetic datum is preset and cannot be changed. For the State Plane 1983 projection algorithm, the datum is preset to the North American 1983 datum and may be changed only to the North American 1983 - HARN datum. For the Gauss-Boaga projection algorithm, the datum is preset to the Rome 1940 datum and may be changed only to the Monte Mario datum. An exception for these preset systems is that a named datum may be used with them provided that its base standard datum is the appropriate preset datum. When you select a geodetic datum, the associated reference ellipsoid appears in the Reference Ellipsoid box.

Precise location of the ellipsoid relative to the earth's surface and a network of control points (geodetic control). This definition usually includes the origin point of the ellipsoid, its orientation, and the radius and eccentricity of the ellipsoid.

NOTE The drop-down list contains all of the standard (predefined) and named (configurable) geodetic datums available on the system. Named horizontal geodetic datums are defined in the file ..\cssruntm\cfg\NamedHDatum.ini.

Reference ellipsoid
Displays the reference ellipsoid associated with the geodetic datum you selected. You can change the ellipsoid only if the geodetic datum is set to user-defined (non-standard). The selection upon initial display is based upon the ellipsoid of the given coordinate system.

Ellipsoid Parameters
Opens the Reference Ellipsoid Parameters dialog box. This dialog box allows you to review the parameters for the ellipsoid. Default parameter values are supplied per datum and ellipsoid selection. You may change the ellipsoid parameters only if the ellipsoid is set to user-defined (non-standard).

Vertical Datum
Allows you to define the vertical datum. The selection in the drop-down list upon initial display is based on the vertical datum string property of the given coordinate system.
Vertical Datum Reference
This read-only field allows you to review the reference of the vertical datum. This information comes from the coordinate system being defined and is presented as a string. The three possible string values are Geoid (orthometric), Ellipsoid (geometric), and Unspecified. The vertical datum reference is derived from the vertical datum selection.

Reference Ellipsoid Parameters Dialog Box
Specifies the default parameters based on the selected datum and ellipsoid. The ellipsoid parameters cannot be modified unless you choose user-defined as the reference ellipsoid. You can modify user-defined ellipsoid parameters by entering an equatorial radius value and any other parameter. The software automatically calculates the remaining values for you.

The model used to represent the shape of the earth. Because the shape of the earth’s surface differs from one geographic area to another, different ellipsoids describe different areas.

Dialog Box Options

   Equatorial radius
   The equatorial radius in distance units.

   Polar radius
   The polar radius in distance units.

   Eccentricity
   The eccentricity value, which has no units.

   Flattening
   The flattening value, which has no units.

   Flattening inverse
   The flattening inverse value, which has no units.
Overview of the Define Coordinate System File Utility

Units and Formats Tab

This tab allows you to set default unit and formatting options that apply to the coordinate system you are editing.

In some cases the units, formatting, and measurement interpretation chosen for a coordinate system may apply to other measurement commands and controls, and the options available on this tab may vary depending on how the dialog box is accessed.

Tab Options

Default units and precision

These options apply to each coordinate type. The type chosen and then the applicable unit and precision may be selected.

Type
Specifies the coordinate type for which default units and precision are set. Each unit type used by the software is listed. When the software outputs values of the specified unit type, those values, by default, will be displayed using the units and precision specified here. Some commands allow you to override these defaults.

Unit
Displays the linear, areal, or angular unit of measure. The choices vary with the unit type.

Precision
Defines the number of decimal places of precision in the coordinate readout or applicable measurement commands. A separate precision may be specified for each unit type.

Measurement interpretation

Specifies how Earth curvature and nominal map scale are accounted for in measurements and coordinate calculations.

True (spheroidal)
Specifies that ground measurements should take into account Earth curvature when calculating distance/area/azimuth (bearing) measurements and coordinate calculations. This method is also referred to as the geographic method of measurement. These measurements do not contain any projection distortions.

Projected (planar)
Specifies that ground measurements should not take into account Earth curvature when calculating distance/area/azimuth (bearing) measurements and coordinate calculations. This method is also referred to as the projection method of measurement. These measurements do not contain any projection distortions. Projected (planar) is the default setting.

Paper (scaled)
This option, when available, specifies that distance/area/azimuth (bearing) measurements are computed on the paper plane that is scaled in relation to the projection plane at the current
nominal map scale.

**NOTE:** This option is available only when the **Units and Formats** dialog box is displayed with the **Tools > Measure Distance/Area** dockable control.

**Example**
The picture box shows an example of the active measurement method.

**Geographic coordinate format**

- **Axis order**
  Specifies the order of latitude and longitude coordinate readouts. These options apply if the coordinate type has been set to Geographic. The choices for axis ordering are **Longitude/Latitude** and **Latitude/Longitude**.

- **Positive axes**
  Specifies the positive direction of the two axes. The choices are dependent upon the axis order.

**Projection coordinate format**

- **Axis order**
  Specifies the ordering of projection east/west and north/south values. The choices for axis ordering are **East/West, North/South** and **North/South, East/West**.

- **Positive axes**
  Specifies the positive direction of the two axes. For example, **+East, +North** indicates that the first coordinate of the pair is positive along the East axis, and that the second coordinate is positive along the North axis. Similarly, **+East, -South** indicates that the first coordinate of the pair is positive along the East axis, but that the second coordinate is positive along the South axis. In this case, the positive second value would be “down” instead of “up”. This option applies to the Projection coordinate type. The order selection choices are dependent upon the axis order.

**Azimuth settings**

- **Direction**
  Specifies the direction to use when setting and displaying azimuths. Select clockwise or counterclockwise.

- **Start from**
  Specifies the direction to use as a starting point when setting and displaying azimuths. Select **North, South, East**, or **West**.
Overview of the Define Text File Server Format File Utility

Introduction

The Define Text File Server Format File utility reads various text files to bring the data into IMAGINE. The format of the input file must be defined before connecting to the dataset.

The utility consists of two primary parts. The first part is an application window titled Define Text File Server Format. The application window is a resizable, empty client area with File, Edit, and Help menus. If you already have an active .tfd file defined, you can select Edit > Text Format Definition on the Define Text File Server Format dialog box.

The second part is a wizard invoked from the Text Format Definition menu item. The wizard dialogs or panels of the utility help you to define the format of the input data file by displaying the file in the preview window.

Input

The data file to be displayed in IMAGINE through the Text File data server is the input to the utility. The input file can be any text file, and may just be a sample of the type of file to be served.

Output

The output is the .tfd file that contains the format definition of the input file. The output file is a simple text file. The utility writes the format of the input text file in such a way that the GDO server can understand.

Terminology

The terminology used in the wizard to define the format definition file is as follows:

Row – Each line in the input data file is called a row.

Delimited data – The data is delimited by spaces or characters such as commas or/and semicolons. The delimiters must be different from the data representation.

Fixed-width data – The input data file has a fixed format with the columns aligned in the file.

Uniform row – Every row in the input data file has the same data format.

Non-uniform row – Each row in the input data file may contain different types of data. For instance, each row with the coordinate information might be followed by a row of comment. Generally, in such cases, the row with the coordinate information contains a line identifier. This information is used in defining the format.
Overview of the Define Text File Server Format File Utility

**Single coordinates per row** – Each row in the file has a single coordinate value (X, Y, Z).

**Multiple coordinates per row** – Each row in the file has multiple coordinate values. For instance, all the coordinates of a particular record of a line feature class might be defined in a single row.

**Workflow**

**Workflow Overview**

The **Define Text File Server Format File** utility provides a Graphical User Interface for defining the format of the input data file. It saves the format that you define as a `.tfd` (text file server format definition) file. You must give this `.tfd` file as input in addition to the input data file while connecting to the Text File data server. The `.tfd` file defines the format of the input file in a way the Text File data server understands.

**Supported Formats**

A pre-built `Normal.tfd` file is delivered along with the product in the `\Program Files (x86)\Common Files\Intergraph\GeoMedia\Templates` folder. The “`Normal.tfd`” file is a default blank template.

There are five types of ASCII file formats that can be defined using the utility. Examples follow:

1. Delimited, uniform, and single coordinate per row:

   KC117,273.000,392179.000,3188853.000,3271.767  
   KC117,283.000,392056.000,3188636.000,3277.066  
   KC117,293.000,391934.000,3188419.000,3278.399  
   KC117,303.000,391812.000,3188201.000,3279.732  
   KC117,313.000,391689.000,3187984.000,3280.000  
   KC117,323.000,391566.000,3187757.000,3280.335  
   KC117,333.000,391443.000,3187539.000,3280.666  
   KC117,343.000,391320.000,3187311.000,3281.000  
   KC117,353.000,391197.000,3187084.000,3281.333  
   KC117,363.000,391074.000,3186857.000,3281.666  
   KC117,373.000,390951.000,3186630.000,3282.000  
   KC117,383.000,390828.000,3186403.000,3282.333  
   KC117,393.000,390705.000,3186176.000,3282.666  
   KC117,403.000,390582.000,3185949.000,3283.000
2. Delimited, non-uniform and single coordinate per row.

The following snippet of the text file has some rows starting with the line identifier “SS”. The format definition file (.tfd) can be set up to read only those rows that contain the identifier “SS”:

```
CO, C:\File1.mwd
CO, Downloaded 16-Aug-94 14:21:43
CO, Software: AP700 version: 1.03
CO, Instrument: Nikon DTM730
CO, Dist Units: Feet INTL
CO, Angle Units: Degrees
CO, Attributes: FCOUNTY, FROUTE, FSEG, FOFFSET, FLENGTH, FDIR,
                 FDATE, FLATSIG, FLONGSIG

SS,20,0079,1364,0,52,1,20010706,41:28:53.11200, - 80:09:59.76000
SS,20,0079,1364,52,52,1,20010706,41:28:53.61600, - 80:09:59.76000
SS,20,0079,1364,105,52,1,20010706,41:28:54.15600, - 80:09:59.72400
SS,20,0079,1364,158,52,1,20010706,41:28:54.66000, - 80:09:59.68800
SS,20,0079,1364,211,52,1,20010706,41:28:55.20000, - 80:09:59.68800
SS,20,0079,1364,264,52,1,20010706,41:28:55.74000, - 80:09:59.65200
SS,20,0079,1364,316,52,1,20010706,41:28:56.24400, - 80:09:59.65200
SS,20,0079,1364,369,52,1,20010706,41:28:56.74800, - 80:09:59.65200
SS,20,0079,1364,422,52,1,20010706,41:28:57.25200, - 80:09:59.65200
SS,20,0079,1364,475,52,1,20010706,41:28:57.79200, - 80:09:59.61600
SS,20,0079,1364,528,52,1,20010706,41:28:58.29600, - 80:09:59.58000
```

3. Delimited, non-uniform, and multiple coordinates per row.

The following snippet of the text file has multiple coordinates per row, making it non-uniform:

```
14,25,35.11,-106.61,35.25,-106.56,35.33,-106.51,35.39,-106.43,35.51,-106.23...
15,90,42.68,-73.85,42.73,-73.9,42.75,-73.93
```
Overview of the Define Text File Server Format File Utility

16,40,36.03,-78.98,36,-78.95,35.99,-78.92,35.95,-78.88,35.9,-78.87,35.87,-78.85...
17,20,32.34,-88.79,32.34,-88.77,32.34,-88.74,32.34,-88.68,32.35,-88.67...
18,70,40.18,-80.25,40.18,-80.22,40.16,-80.21,40.16,-80.19
19,35,32.07,-97.08,32.07,-97.16,32.36,-97.18,32.42,-97.22,32.47,-97.27
20,80,41.02,-102.14,41.02,-102.01,41.11,-101.72,41.12,-101.66,41.11,-101.38....
21,35,32.65,-96.81,32.55,-96.82,32.5,-96.82,32.41,-96.87,32.35,-96.87
22,80,38.57,-121.47,38.57,-121.57,38.55,-121.68,38.51,-121.75,38.38,-121.93....
23,10,32.23,-106.69,32.15,-106.65,32.05,-106.59,32,-106.58,32,-106.58,31.95,-106.57..
24,5,38.57,-121.47,38.62,-121.51,38.64,-121.52,38.67,-121.56,38.67,-121.72...

4. Fixed-width, uniform, and single coordinates per row:

| KC117 | 273.000 392179.000 | 3188853.000 | 3271.767 |
| KC117 | 283.000 392056.000 | 3188636.000 | 3277.066 |
| KC117 | 293.000 391934.000 | 3188419.000 | 3278.399 |
| KC117 | 303.000 391812.000 | 3188201.000 | 3279.732 |
| KC117 | 313.000 391689.000 | 3187984.000 | 3280.000 |
| KC117 | 353.000 391224.000 | 3187102.000 | 3238.399 |
| KC117 | 363.000 391109.000 | 3186881.000 | 3236.400 |
| KC117 | 373.000 391001.000 | 3186656.000 | 3235.060 |
| KC117 | 383.000 390894.000 | 3186430.000 | 3233.883 |
| KC117 | 393.000 390789.000 | 3186204.000 | 3232.706 |
| KC117 | 403.000 390685.000 | 3185977.000 | 3232.000 |
| KC117 | 413.000 390582.000 | 3185751.000 | 3232.000 |
| KC117 | 423.000 390476.000 | 3185525.000 | 3232.000 |

5. Fixed-width, non-uniform, and single coordinate per row.

The following snippet is a portion of the text file data that has attributes on a different row from those of the coordinate information, thus making the column format as “combination”, which means the attributes are delimited and coordinates are fixed-width.

In the snippet below, the attributes are on the first row followed by coordinates which are on the same line. The data represents a Boundary Geometry with holes in it. The * marker is a hole marker (also called interior boundary marker) which can be on a line by itself or on the
same line as the first coordinate of the polygon it identifies, preceding that coordinate. The EOC is End Of Coordinate marker which is used to identify the end of coordinates for a particular feature.

```
10, OAK
566238.02  5088688.48
565795.01  5088200.50
564846.53  5088207.34
564413.99  5088340.63
564564.85  5088739.13
565097.46  5088917.52
565577.02  5089149.37
566220.59  5088705.55
566238.02  5088688.48
*  
565235.76  5088884.53
565339.02  5088902.92
565234.82  5088970.79
565235.76  5088884.53
*  
565825.36  5088580.43
565927.49  5088702.33
565821.59  5088925.47
565806.80  5088701.00
565773.26  5088614.37
565825.36  5088580.43
EOC
```

**Flow Diagram**

The possible sequences of wizard panels and dialogs would be as follows. The numbers are used for clarity.
The six types of input files supported by the utility take the paths as given below. The numbers indicate the wizard panels as described in the above diagram.

1. Delimited, uniform and single coordinate per row – 1,3,5,6
2. Delimited, non-uniform and single coordinate per row – 1,2,3,5,6
3. Delimited, non-uniform and multiple coordinates per row – 1,2,3,5,6
4. Fixed-width, uniform and single coordinate per row – 1,4,5,6
5. Fixed-width, non-uniform and single coordinate per row – 1,2,4,5,6
6. Combination, non-uniform and single coordinate per row – 1,2,3,4,5,6

Example Workflow

Using the Define Text File Server Format File utility, the following workflow describes the steps to define the .tfd format file for the delimited, non-uniform, and single coordinate per row dataset given below.

The snippet file mentioned under delimited, non-uniform and single coordinate per row format file type has header information followed by attribute and coordinate information on the same line.

SS,20,0079,1364,0,52,1,20010706,41:28:53.11200,-80:09:59.76000
1. Using the **Define Text File Server Format File** utility, open a new file. The utility consists of two primary parts, an application window with menus, and a wizard invoked from the Text Format Definition menu item. In the application window, select **File > New**. Select the Normal.tfd template file to open the wizard.
2. Define File Type Definition: The snippet file data consists of centerline point location markers as collected from a GPS unit. The text data has header information followed by attribute and coordinate information on the same line. The attribute and coordinate information are comma delimited. Since they have attribute and coordinate types of data, this makes the row format non-uniform. The **Start row** text box control is used to specify the row number from which the data is to be imported. This helps in avoiding any header information or comment rows.

**Define Text File Server Format - File Type Definition**

<table>
<thead>
<tr>
<th>Column format</th>
<th>Row format</th>
</tr>
</thead>
<tbody>
<tr>
<td>□ Delimited - Characters such as commas separate each field</td>
<td>□ Uniform - All records have the same format</td>
</tr>
<tr>
<td>□ Fixed-width - Fields are aligned in columns</td>
<td>□ Non-uniform - Records may have different formats</td>
</tr>
<tr>
<td>□ Combination - Attributes are delimited and coordinates are fixed-width</td>
<td></td>
</tr>
</tbody>
</table>

**Geometry type:** Point

**Sample text file:**

```
SS,122 AVENUE NW / 231 STREET NW, 122 AVENUE NW, 53.34.17, 113.42.48.9
SS,231 STREET NW (Address 12203-12758), 122 AVENUE NW, 231 STREET NW, 53.34.17, 113.42.48.9
SS,122 AVENUE NW / 231 STREET NW, 122 AVENUE NW, 53.34.17, 113.42.48.9
SS,123 AVENUE NW / 231 STREET NW, 120 AVENUE NW, 53.34.28, 113.42.48.89
SS,231 STREET NW / 120 AVENUE NW, 121 STREET NW, 53.34.28, 113.42.48.89
SS,118 AVENUE NW / 231 STREET NW, 118 AVENUE NW, 53.34.13.05, 113.42.48.89
SS,221 STREET NW / 118 AVENUE NW, 231 STREET NW, 53.34.13.05, 113.42.48.89
SS,221 STREET NW / YELLOWHEAD TRAIL NW (Eastbound), 231 STREET NW, 53.34.11.21, 113.42.48.99
SS,221 STREET NW / YELLOWHEAD TRAIL NW (Westbound), 231 STREET NW, 53.34.11.21, 113.42.48.99
SS,YELLOWHEAD TRAIL NW (Eastbound), 231 STREET NW (Southbound) 121 STREET NW (Southbound) 120 STREET NW |
```
3. Non-uniform Row Definition: This panel is used to define the non-uniform data as displayed in the preview window. In the Include frame, you specify to include Rows that contain 'SS'.

4. Delimited Data Definition: On this panel, you identify the type of delimiters. The input file is a comma delimited file. The Start of row column is used to specify the point in the row from where the data is read. The default is 1.
5. Define Geometry Definition: In the Geometry definition panel, navigate across the geometry columns in the preview pane, and set the column numbers for the following geometry properties:

- X/Lon/E-W Axis
6. Define Attributes: In the Attribute Definition panel, set the attribute names, and from the attribute data type option, select the appropriate data type for each attribute name. The size of the attribute is set only for text attributes and is disabled for all other cases. The default value is 20.
The attributes of only the first record are displayed in the preview window (if the attributes are present on different row(s) than the coordinates).
Overview of the Define Text File Server Format File Utility

7. Integration of the input data file along with the format definition file (.tfd) in the IMAGINE environment: In IMAGINE, the Text File Data Server imports the text data using the format definition file. In IMAGINE, make a new connection of Text File type, and supply the input text file, the format definition file, and the coordinate system file (.csf).

![New Connection](image)

Limitations

- Multi-file formats cannot be defined using the utility. Only single-file formats are supported.
- Only one feature class per file can be defined using the utility.
- Multiple geometry fields within a feature class are not supported.
- Collection geometries are not supported.
- Arc geometries are not supported.
- Boundary geometries are supported for “single coordinate per row” format only.
- Datasets having multiple coordinates per row and the attribute information after the coordinates are not supported.
Overview of the Define Text File Server Format File Utility

File Type Definition

The geometry type of the feature class has to be set in this panel. This panel displays in the preview window as it is. Also, the data type (delimited or fixed-width) and the row format (uniform or non-uniform) has to be set. The information given in this panel is used by the utility to display the next panels.

Dialog Box Options

**Column format:** This is a grouping of three option buttons, *Delimited, Fixed-width* and *Combination*. Your selection here influences the sequence of subsequent panels in the wizard.

**Row format:** This is a grouping with the two option buttons, *Uniform* and *Non-uniform*. Your selection here influences the sequence of subsequent panels in the wizard. A row format is uniform when every row in the data file has the same data format. A non-uniform row may
contain different types of data. For example, each row can contain varying number of vertices (coordinates) for a Line geometry feature.

Geometry type: Allows you to specify the geometry type of the feature class. Only one feature class per file is supported. The geometry type can be one of the following:

- Point
- Line
- Area
- None (None means that only attribute data without any geometry information is read by the data server.)

Sample text file: Allows you to enter the sample data filename. Use the Browse button next to the text box to browse for the input file. If you enter the sample data filename, the preview window displays a preview of the input data file. This control is optional in this panel.

Text encoding: Allows you to specify the text encoding for the input text file. However, if the input file contains BOM (Byte Order Mark), the text encoding setting in the .TFD file will be overwritten by BOM text encoding. The drop-down list is populated with the following values

- ANSI (the default)
- UTF-8
- UTF-16
- UTF-16BE

Start row: Allows you to specify the starting row number. This indicates the row number from which the data has to be imported. All the data in the rows before this number are ignored. The default is 1. Any different row number can be entered. This helps in avoiding any header information or comment rows. You can select a row in the preview window to identify the starting row. By default, the first row is selected and is highlighted.

Set From Preview: This button is enabled when a sample text file has been loaded and a row in the preview has been selected. When you click this button, the selected row number is obtained from the preview and substituted in the keyin control associated with the “Start row” control.
Non Uniform Row Definition

If the non-uniform option in the File Type Definition dialog box is set, a new dialog for defining the non-uniform data is displayed.

**Include**
- **All rows**
- **Rows that start with** [ ]
- **Rows that contain** [ ]

Number of attribute rows: 3

Area hole marker [ ]

**Each row contains**
- **Single coordinate**
- **Multiple coordinates**

- **Coordinate count precedes the coordinates**
- **End of coordinates marker** EOC

Text file preview:
- 32322:WHITE MUD DRIVE NE, 1445, 1646
- 53.28, 58.68, -113.19, 154.19, -9.0001
- 53.28, 58.51, -113.20, 00.07, -9.0001
- 53.28, 58.23, -113.20, 04.95, -9.0001
- EOC
- 32321:WHITE MUD DRIVE NE, 1435, 1645
- 53.28, 58.68, -113.19, 154.13, -9.0001
- 53.28, 58.73, -113.20, 02.35, -9.0001
- EOC
- 32394:WHITE MUD DRIVE NE, 1645, 2009

**Dialog Box Options**

**Include**: This is a grouping with the option buttons **All rows**, **Rows that start with**, and **Rows that contain**, and a text box control. The line qualifier has to be specified in the text box and the line qualifier can contain up to ten characters. This indicates that only those rows with the line qualifier (either at the beginning of each row or embedded within the row) be read. All other rows are ignored. The preview window displays only those rows from the input data file that have the line qualifier that is highlighted in the text box. If the option **All rows** is selected, all the rows are displayed in the preview window. By default, the option **All rows** is selected.
Each row contains: This is a grouping with the option buttons Single coordinate and Multiple coordinates. The default selection is Single coordinate. If the input data file has multiple coordinates per row, this information has to be specified by setting the option button Multiple coordinates. If the input data file is non-graphic, i.e.; the geometry type is None, then both the option buttons are disabled.

Number of attribute rows: Allows you to specify the number of rows the attribute information is spread over. This is set if the input data file has the attribute information in a different row from the coordinate information. A value of ‘n’ indicates that the attribute information is spread over ‘n’ rows and the coordinate information starts at row ‘n+1’. The default value is zero.

Area Hole Marker: This option is enabled only when the geometry type was set as Area in the first panel. The Area Hole Marker as specified in the text box separates boundary geometry exteriors and holes for area features.

Coordinate count precedes the coordinates: Allows you to specify if the data contains “Number of Coordinates value” (NOC) or not. If present, the “Number of coordinates” value should always precede the coordinates. The control is mutually exclusive with the End of Coordinate marker.

End of Coordinates marker: Allows you to specify the End of Coordinates marker. The End of Coordinates marker has to be set in the text box and the EOC marker can contain a maximum of ten characters. The text box and the radio button controls are enabled only when there is single coordinate information per row in the input data file. If the Multiple coordinates option button in selected, these controls are disabled.

The Number of Coordinates value specifies the total number of coordinates per record (say a boundary, including the coordinates of the exterior polygon and the interior polygon). The End of Coordinates marker specifies the end of the coordinate information. Further information beyond the End of Coordinates marker is not read.

The options Area hole marker, Coordinate count precedes the coordinates, and End of coordinates marker are enabled only if set to single coordinate per row.

All the options in this panel except the Include frame control are disabled if the geometry type is chosen as None in the first panel, which is the File Type Definition dialog box.
Fixed Width Data Definition

If the coordinate data is fixed-width, the column breaks (or field widths) have to be set up in this panel. Lines with arrows signify column breaks. This panel allows you to define where each data field starts and stops with a vertical line. The first row in the Text file preview window has the column numbers in it to help you place the column breaks easily. You can create, delete, or move the line that represents the column break.
If the sample data is in Unicode (UTF-8, UTF-16 or UTF-16BE) text encoding, the following panel appears. The column width in the control is greater to accommodate greater variability in character width.
Delimited Data Definition

If the data is delimited, the delimiter(s) used to separate the fields in the data file have to be chosen in this panel. All the controls are enabled in this panel. If the column format is of type **Combination**, the delimiter(s) used to separate the attributes in the data file have to be chosen in this panel, and only the **Delimiters** frame controls are enabled.

**Dialog Box Options**

**Delimiters**: This is a grouping of all the delimiters. Select the delimiters from any of the check box controls available: **Tab**, **Space**, **Semicolon**, and **Comma**. Any other new delimiter can be set using the **Other** check box and the associated text box. The default delimiter is set as **Tab**.

**Treat consecutive delimiters as one**: Check to specify that consecutive delimiters are to be treated as a single delimiter. The default selection is “Off”.

---

GeoMedia Objects Reference Guide for ERDAS IMAGINE
**Text enclosed by:** Use this option to specify the text qualifier. The text qualifier specifies that the text strings in a delimited file are to be read with the given qualifier. For example, if the data is delimited by space and if the row has data such as “This is a text string”, specifying the quotation mark (”) as the text qualifier allows the text to be read as a single column instead of five columns. Possible values that can be selected from the drop down are single quote (‘) and double quote (”). The user may also key in a value.

**Start of row column:** Use this option to specify the point in the row from where the data is read. For example, if all the rows in the data start with a line qualifier, this can be set to ignore the first few characters in every row while reading the data. The default is 1.

**Start of field column:** Use this option to specify the point in each field from where the data has to be read. This is used when each field has a fixed qualifier. The first few characters in each column are ignored while reading the file. The default is 1.

**Text file preview:** This window displays the files with a vertical line between the fields. The fields are decided based on the selected delimiters.
Geometry Definition - Point

The Geometry Definition panel consists of two variations in the user interface based on the geometry type given in the File Type Definition panel. These panels display all the data fields for the first occurring coordinate row only. Each of the coordinate data fields can be selected, and appropriate coordinate attributes (X, Y, Z) can be set in this panel. Note that the Geometry Definition panel is not displayed if the geometry type is chosen as “None” in the first panel – File Type Definition.

If no sample data file was selected in the first panel and if the data was chosen to be of type Delimited, the number of fields is fixed to 20 in this panel.

You can navigate across different columns of the preview pane and use the Set from Preview to set the column numbers for the following geometry properties:

- X / Lon / E-W Axis
- Y / Lat / N-S Axis
Overview of the Define Text File Server Format File Utility

- Z / Height
- Orientation
- Skip

For the geometry information, the X, Y, and Z fields have to be set appropriately. The X and Y fields are mandatory. Their default column numbers are 1 and 2, respectively. If the geometry type is Point and if the input data has orientation information, the field Orientation must be set appropriately. The rest of the fields must be designated with “Skip” as the column name.

Set From Preview: When you click this button, the selected column number is obtained from the preview and substituted in the keyin control associated with the coordinate column. The Z and Orientation columns can be reset to skip by deleting the number in the respective text box controls.
Geometry Definition - Line and Area

The Geometry Definition panel consists of two variations in the user interface based on the geometry type given in the File Type Definition panel. These panels display all the data fields for the first occurring coordinate row only. Each of the data fields can be selected, and the column name along with the data format for the geometry attributes can be set in this panel. This panel is not displayed if the geometry type is chosen as “None” in the first panel – File Type Definition.

Dialog Box Options

The following list explains the controls in the Lines and Areas panel:

**Coordinate order**: The drop-down contains the following eight combinations of coordinate pairs/triplets:

- X, Y
- Y, X
The coordinate order has to be selected from the combo-box drop down for the first coordinate.

The selected coordinate order is applied from the **Coordinates start at column** until the end of the row, assuming they are contiguous once started.

**Coordinates start at column**: This keyin control shows the starting column of the coordinate order. It can be edited or obtained from the preview using the **Set From Preview** button. The default value is 1.

**Set From Preview**: When you click this button, the selected column number is obtained from the preview and substituted in the keyin control associated with the **Coordinates start at column** control.
### Attribute Definition

The **Attribute Definition** dialog box allows you to define the attribute columns. The DefTFD utility can handle any number of attribute columns. If you did not select a sample data file in the first panel and if you chose the data type **Delimited**, the number of fields is fixed to 20 in this panel.

#### Dialog Box Options

**Attribute name**: Allows you to specify the attribute name to be used for the column. Select the attribute name from the following special keywords, or type it in as a unique name:

- NOC – Specifies that the column is the “Number of coordinates” value. This column is not served as an attribute by the GDO server.
- Skip – Specifies that the column be skipped from being served by the GDO server.
NOTE: IMAGINE does not allow field names to have spaces or any special characters (other than the underscore character). At least one attribute must be defined for identifying a spatial feature.

**Attribute Data Type:** Allows you to specify the type for each attribute. The attribute data type must be selected from the available list box. The supported data types are as follows:

- Text
- Memo
- Byte
- Integer
- Long Integer
- Single
- Double
- Currency
- Boolean
- Date
- GUID

**Size:** Allows you to set the size of the attribute for text attributes. The edit control **Size** is enabled when the attribute data type is chosen to be **Text**. For all other cases, this control is disabled. The default value is 20.

**Set attribute definition:** To set the data type and the attribute name, place a data point on a column, and then specify the attribute data type and the attribute name. To validate and register the data, click the **Set attribute definition** button before proceeding to the next attribute field. Duplicate name entries are not allowed. The attribute name is reflected in the respective column of preview only after clicking this button.

The attributes of only the first record are displayed in the preview window if the attributes are present on different rows than the coordinates; the column breaks set for this row might not apply to the other rows in case of fixed-width data. Hence this attribute information has to be delimited; it cannot be fixed-width except in the case of point geometry. When the column format is of type “Combination”, delimiters set previously in the “Delimited Definition” are used in this panel also.

The **Finish** button only closes the Wizard dialog box; the .tfd file remains active and its name is shown in the title bar. You can save or close the file using the **File** menu commands.
Overview of the Define Warehouse Configuration File Utility

The Define Warehouse Configuration File utility provides a graphical user interface that allows you to create or to edit a warehouse configuration file. This is helpful because the file format of the warehouse configuration file might be unknown. It also helps you to avoid syntax errors.

Introduction to Define Warehouse Configuration File

Introduction
Data servers such as ArcInfo, ArcView, MapInfo, CAD-AutoCAD, CAD-IGDS, CAD-MicroStation V7, CAD-MicroStation V8, I/CAD Map, KML, WCS, WFS Read-Only, WFS Read-Write, and WMS require a warehouse configuration file (.ini) to get INI key values.

The Define Warehouse Configuration File utility provides a graphical user interface that allows you to create or to edit a warehouse configuration file. This is helpful because the file format of the warehouse configuration file might be unknown. It also helps you to avoid syntax errors.

Input
Input the warehouse configuration file to be created or edited, select the data server for which you want to create the file, input the connection and/or other information, and set values for the INI keywords you want to use.

Output
When you select Finish on the wizard, the warehouse configuration file will be saved.
If you are editing an existing file, all invalid keywords will be discarded, and any commented lines in the .ini file will also be discarded.
Workflow for ArcInfo, ArcView, and MapInfo Data Servers

To Define a Warehouse Configuration File for ArcInfo, Arcview, and MapInfo Data Servers

1. Open Define Warehouse Configuration File utility to define the warehouse configuration file.

   The Define Warehouse Configuration File dialog box is displayed.

2. Select the data server for which you want to define the warehouse configuration file.
Overview of the Define Warehouse Configuration File Utility

For ArcInfo, ArcView and MapInfo data servers, the following dialog box is displayed:

3. Key in the workspace folder name.
4. If needed, create a new .csf file.
5. Input the .csf file for the warehouse.
6. If needed, edit the .csf file.
7. Select an existing warehouse configuration file to be edited, or input a new name for the warehouse configuration file to be created.

The same dialog box is displayed for ArcInfo, ArcView, and MapInfo except for appropriate changes in labels in the Warehouse information frame.
Overview of the Define Warehouse Configuration File Utility

8. Select **Next** to display the panel in which you want to set values for INI keywords.

9. Select an INI keyword from the **Available keywords** list to see its description.

10. Select an INI keyword for which you want to set the value and click **Add**.

11. Click **Add** to display the **Modify Keyword Value** (see "Modify Keyword Value Dialog Box" on page 247) dialog box that contains different graphical user interfaces for different INI keywords.

12. Use the dialog box to set the value for the keyword and click **OK** to return to the wizard.

13. Remove keywords that you do not need from the **Selected keywords** list.

14. Click **Finish** to save the INI file.
Workflow for CAD Data Servers

To Define a Warehouse Configuration File for CAD Data Servers

1. Open Define Warehouse Configuration File utility to define the warehouse configuration file.

   The Define Warehouse Configuration File dialog box is displayed.

2. Select the data server for which you want to define the warehouse configuration file.
For a CAD data server, the following dialog box is displayed:

3. Select the CAD type — AutoCAD, MicroStation V7, or Microstation V8.
4. Select an existing warehouse configuration file to be edited, or input a new name for the warehouse configuration file to be created.
5. Select **Next** to display the next panel.

![Define Warehouse Configuration File Utility](image)

6. Select an INI keyword from the **Available keywords** list to see a description.

7. Select an INI keyword for which you want to set a value, and click **Add**.

8. Click **Add** to display the **Modify Keyword Value** (see "Modify Keyword Value Dialog Box" on page 247) dialog box, which contains different graphical user interfaces for different INI keywords.

9. Use the dialog box to set the value for the keyword, and click **OK** to return to the wizard.

10. Remove keywords that you do not need from the **Selected keywords** list.

11. Click **Finish** to save the INI file.
Workflow for I/CAD Map Data Server

To Define a Warehouse Configuration File for I/CAD Map Data Server

1. Select Start > Programs > Product > Utilities > Define Warehouse Configuration File to define the warehouse configuration file.

The Define Warehouse Configuration File dialog box is displayed.

2. Select the data server for which you want to define the warehouse configuration file.
For the I/CAD Map data server, the following dialog box is displayed:

3. Select an existing warehouse configuration file to be edited, or input a new name for the warehouse configuration file to be created.
Overview of the Define Warehouse Configuration File Utility

4. Select **Next** to display the next panel.

![Define Warehouse Configuration File](image)

5. Select an INI keyword from the **Available keywords** list to see a description.

6. Select an INI keyword for which you want to set the value and click **Add**.

7. Click **Add** to display the **Modify Keyword Value** (see "Modify Keyword Value Dialog Box" on page 247) dialog box that contains different graphical user interfaces for different INI keywords.

8. Use the dialog box to set the value for the keyword and click **OK** to return to the wizard.

9. Remove keywords that you do not need from the **Selected keywords** list.

10. Click **Finish** to save the INI file.
Workflow for KML Data Server

To Define a Warehouse Configuration File for KML Data Server

1. Select Start > Programs > Product > Utilities > Define Warehouse Configuration File to define the warehouse configuration file.

The Define Warehouse Configuration File dialog box is displayed.

2. Select the data server for which you want to define the warehouse configuration file.
For the KML data server, the following dialog box is displayed:

3. Select an existing warehouse configuration file to be edited, or input a new name for the warehouse configuration file to be created.
Overview of the Define Warehouse Configuration File Utility

4. Select **Next** to display the next panel.

5. Select an INI keyword from the **Available keywords** list to see a description.

6. Select an INI keyword for which you want to set the value and click **Add**.

7. Click **Add** to display the **Modify Keyword Value** (see "Modify Keyword Value Dialog Box" on page 247) dialog box that contains different graphical user interfaces for different INI keywords.

8. Use the dialog box to set the value for the keyword and click **OK** to return to the wizard.

9. Remove keywords that you do not need from the **Selected keywords** list.

10. Click **Finish** to save the INI file.
Workflow for WCS Data Server

**To Define a Warehouse Configuration File for WCS Data Server**

1. Open Define Warehouse Configuration File utility to define the warehouse configuration file.

   *The Define Warehouse Configuration File dialog box is displayed.*

2. Select the data server for which you want to define the warehouse configuration file.
For the WCS data server, the following dialog box is displayed:

3. Select an existing warehouse configuration file to be edited, or input a new name for the warehouse configuration file to be created.
4. Select **Next** to display the next panel.

5. Select an INI keyword from the **Available keywords** list to see a description.

6. Select an INI keyword for which you want to set the value and click **Add**.

7. Click **Add** to display the **Modify Keyword Value** (see "Modify Keyword Value Dialog Box" on page 247) dialog box that contains different graphical user interfaces for different INI keywords.

8. Use the dialog box to set the value for the keyword and click **OK** to return to the wizard.

9. Remove keywords that you do not need from the **Selected keywords** list.

10. Click **Finish** to save the INI file.
Workflow for WFS Read-Only Data Server

To Define a Warehouse Configuration File for WFS Read-Only Data Server

1. Open Define Warehouse Configuration File utility to define the warehouse configuration file.

   The Define Warehouse Configuration File dialog box is displayed.

   ![Define Warehouse Configuration File](image)

   Identify the data server, the warehouse, and the warehouse configuration file.

   - Data server

2. Select the data server for which you want to define the warehouse configuration file.
Overview of the Define Warehouse Configuration File Utility

For the WFS Read-Only data server, the following dialog box is displayed:

3. Select an existing warehouse configuration file to be edited, or input a new name for the warehouse configuration file to be created.
4. Select **Next** to display the next panel.

5. Select an INI keyword from the **Available keywords** list to see a description.

6. Select an INI keyword for which you want to set the value and click **Add**.

7. Click **Add** to display the **Modify Keyword Value** (see "Modify Keyword Value Dialog Box" on page 247) dialog box that contains different graphical user interfaces for different INI keywords.

8. Use the dialog box to set the value for the keyword and click **OK** to return to the wizard.

9. Remove keywords that you do not need from the **Selected keywords** list.

10. Click **Finish** to save the INI file.
Workflow for WFS Read-Write Data Server

To Define a Warehouse Configuration File for WFS Read-Write Data Server

1. Open Define Warehouse Configuration File utility to define the warehouse configuration file.

   The Define Warehouse Configuration File dialog box is displayed.

2. Select the data server for which you want to define the warehouse configuration file.
For the WFS Read-Write data server, the following dialog box is displayed:

3. Select an existing warehouse configuration file to be edited, or input a new name for the warehouse configuration file to be created.
4. Select **Next** to display the next panel.

5. Select an INI keyword from the **Available keywords** list to see a description.

6. Select an INI keyword for which you want to set the value and click **Add**.

7. Click **Add** to display the **Modify Keyword Value** (see "**Modify Keyword Value Dialog Box**" on page 247) dialog box that contains different graphical user interfaces for different INI keywords.

8. Use the dialog box to set the value for the keyword and click **OK** to return to the wizard.

9. Remove keywords that you do not need from the **Selected keywords** list.

10. Click **Finish** to save the INI file.
Workflow for WMS Data Server

**To Define a Warehouse Configuration File for WMS Data Server**

1. Open **Define Warehouse Configuration File** utility to define the warehouse configuration file.

   *The Define Warehouse Configuration File dialog box is displayed.*

2. Select the data server for which you want to define the warehouse configuration file.
For the WMS data server, the following dialog box is displayed:

3. Select an existing warehouse configuration file to be edited, or input a new name for the warehouse configuration file to be created.
4. Select **Next** to display the next panel.

5. Select an INI keyword from the **Available keywords** list to see a description.

6. Select an INI keyword for which you want to set the value and click **Add**.

7. Click **Add** to display the **Modify Keyword Value** (see "Modify Keyword Value Dialog Box" on page 247) dialog box that contains different graphical user interfaces for different INI keywords.

8. Use the dialog box to set the value for the keyword and click **OK** to return to the wizard.

9. Remove keywords that you do not need from the **Selected keywords** list.

10. Click **Finish** to save the INI file.
First Panel - Select Data Server Dialog Box

Open Define Warehouse Configuration File utility to display the first panel for the Define Warehouse Configuration File utility. This panel allows you to identify a data server. After you select a data server, the graphical user interface changes.

Dialog Box Options

Data Server

Allows you to select the data server from the drop-down list.

Select a data server from this list to display the data server specific panel, which shows the Warehouse information and the Warehouse configuration file to create or edit. The appearance varies depending upon which data server you select. Refer to the following workflows for each data server for examples of the specific graphical user interface:
Overview of the Define Warehouse Configuration File Utility

- **ArcInfo, ArcView and MapInfo data servers** (see "Workflow for ArcInfo, ArcView, and MapInfo Data Servers" on page 216)
- **CAD data server** (see "Workflow for CAD Data Servers" on page 219)

**Next**

Select **Next** to move to the second panel, which is the **Set Values for INI Keywords** (see "Second Panel - Set Values for INI Keywords" on page 242) dialog box.

**Cancel**

Select **Cancel** to dismiss the **Define Warehouse Configuration File** utility.
Second Panel - Set Values for INI Keywords

Open Define Warehouse Configuration File utility to display the first panel for the Define Warehouse Configuration File utility. Select a data server, and then select Next to display the second panel of the wizard, which allows you to set values for INI keywords.
Dialog Box Options

Available Keywords List

This option is always enabled. Once a keyword in this list is defined (using the Add button), it is moved to the Selected keywords list. Double click an item to simulate the Add button click. Single click an item to display the description for the INI keyword in the Description field.

Description

This field is invisible when no item is selected in the list. When you select an item in the Available keywords list or in the Selected keywords list, the description field is displayed.

Selected Keywords List

The items in the list are the ones that fit the following criteria:

- Are designated as a must for the specified data server.

This keyword allows a **Chinese character set** to be served by the ArcInfo server.
Were already defined in the INI file that is being edited.
Were the ones that were added from the Available keywords list.

Double-click an item to simulate the **Remove** button click. Single-click an item to display the value for the keyword (giving you a chance to edit) and the description, as illustrated below:

### Add
This option is enabled only when an item is selected in the **Available keywords** list. Click **Add** to display the **Modify Keyword Value** (see "Modify Keyword Value Dialog Box" on page 247) dialog box.

### Remove
This will be enabled only when an item is selected in the **Selected keywords** list. Click **Remove** to remove the item from the **Selected keywords** list and move it to the **Available keywords** list.
Overview of the Define Warehouse Configuration File Utility

Reset All
This option is always enabled and will reset the dialog box to its default parameters.

Up and Down Arrows
Select these arrows to order the INI keywords.

Keyword Value field and the Browse Option
This field is visible only when an INI keyword is selected in the Selected keywords list, and its label will be the same as the selected INI keyword.

There are different kinds of possible keyword values, as follows:

- **The keyword can only have one value**
  Examples:
  - CHARACTER SET:CNS 11643
  - CACHE FILE:CADcache.csc
  - CACHE UPTODATE:TRUE | FALSE
  For keywords that do not have a possible list of values, such as in the first example, a single line textbox will be displayed and the Browse button will be invisible.
  For keywords that do not have a possible list of values and when the value is a filename, such as in the second example, a single line textbox will be displayed, and the Browse button will be enabled.
  For keywords that have a possible list of values, a drop-down list box will be displayed and the Browse button will be invisible.

- **The keyword can have many values**
  Examples:
  - COORDINATE SYSTEM:
    Table1=\gmds1\datasets\arcinfo\butler\b1.csf
    Table2=\gmds1\datasets\arcinfo\butler\b2.csf
    Table3=\gmds1\datasets\arcinfo\butler\b1.csf
  [CoordinateSystem]
  FILE=<.dgn or .csf file>

  [GRAPHICS]
  ACCESS=<Access mode>
  PATH=<local path>|EXPIRATION=<days>
  For these kind of keywords, a multi-line textbox will be displayed. The Browse button will be enabled if it contains a filename.

  Hypertext: <Birds,Photo>
Overview of the Define Warehouse Configuration File Utility

<Birds,Audio>
<Birds,Video>
For these kind of keywords, a multi-line textbox will be displayed.

Hypertext: <Birds,Photo>
Hypertext: <Birds,Audio>
Hypertext: <Birds,Video>

**Back**
Click this option to display the previous (First) panel.

**Cancel**
Click this option to terminate the Define Warehouse Configuration File utility.

**Finish**
Click this option to create the warehouse configuration file.
Modify Keyword Value Dialog Box

Select an INI keyword from the Available keywords list in the second panel of the wizard, and click ADD to display this dialog box.

This dialog box is not displayed for the following INI keywords:
- GEOMETRY TYPE (see "Geometry Type - MapInfo Server Keyword Value Dialog Box" on page 248) (MapInfo Server)

Special dialog boxes are displayed to set values for the above INI keywords.

Dialog Box Options

Keyword Name
This read-only text box displays the keyword name.

Value
This field will show the default or current value of the keyword. There are different kinds of possible keyword (see "Second Panel - Set Values for INI Keywords" on page 242) values.

Description
Displays the description and the uses of the specified keyword.
Geometry Type - MapInfo Server Keyword Value Dialog Box

When the data server is MapInfo and you select GEOMETRY TYPE from the Available keywords list in the second panel of the wizard, click **Add** to display this dialog box.

### Dialog Box Options

**Geometry type and Feature Class (list view)**

The list view will show the tables available. Displays a list of each feature class and its geometry type.

**Geometry type**

Use the geometry type drop-down list to change the default COMPOUND geometry type to POINT, LINE, AREA, or TEXT.

**OK**

Click **OK** to copy the values set in this dialog box to the **Value** field in the second panel of the wizard.

**Cancel**

Click **Cancel** to dismiss this dialog box with no action.
Font-related keywords Dialog Box

This dialog box allows you to define FONT-related keywords of AutoCAD, IGDS, and Microstation V8 scanners. To display this dialog box, select a data server; select a DEFAULT FONT, FONT NAME, or FONT NUMBER keyword from the Available keywords box in the second panel (Set values for INI keywords) of the wizard; and select the Add option. The appearance varies depending upon the data server selected.

![Image of the dialog box]

**Dialog Box Options**

**Keyword name**

This read-only text box displays the keyword name whose value is being set or modified. This text box is always disabled.

**Font number box**
Overview of the Define Warehouse Configuration File Utility

This box is shown only in the case of a MicroStation V7 or MicroStation V8 FONT NUMBER keyword. It is populated with the font numbers already mapped (if any) and will allow you to map the MicroStation V7 or MicroStation V8 font number to the Microsoft font settings. It allows you to key in a new font number for mapping. Selecting any font number from the box will populate all other controls in the Target font details frame with the corresponding settings.

Font name box
This box is shown only in the case of a AutoCAD - FONT NAME keyword. It is populated with the font names already mapped (if any). This box will allow you to map the AutoCAD SHX font name to the Microsoft font settings. It allows you to key in a new font name for mapping. Selecting any font name in the box will populate all other controls in the Target font details frame with the existing corresponding settings.

Target Font Details
This frame allows you to select the font, font style, and additional parameters, such as Pitch, Character set, and Scaling factor.

Font style
This option contains check boxes for Bold, Italic, and Underline. For the AutoCAD scanner, the Underline qualifier is not applicable and is always disabled. For the MicroStation V8 scanner, the Italic and Underline qualifiers are not applicable and are always disabled. Checking any box will include the corresponding qualifier in the keyword value. For a new mapping, if the default font mapping already exists, the check boxes reflect the default settings. If the default font mapping does not exist, the check boxes will be unchecked.

Font
This box is editable and lists all the fonts installed on the system. If the default font setting is already defined, the default font is selected by default in the box. Otherwise, no font is selected in the box.

Font family
Lists the font family names — nil, roman, swiss, modern, script, decor, tech, and bidi. If the default font setting is already defined, the default font family is selected by default in the box.

Pitch
Lists the font pitch settings — 0 (Default pitch), 1 (Fixed pitch), and 2 (Variable pitch). If the default font setting is already defined, the default pitch is selected by default in the box.

Character set
This text box is used to specify the character set. Only positive numeric values are valid. If the default font setting is already defined, the text box is populated with the default font character set.

Scaling factor
This text box is used to specify the scaling factor. Only positive numeric values are valid. If the default scaling factor is already defined, the text box is populated with the default scaling
factor. Otherwise, it is populated with the default scaling factor of the scanner.

Description
Displays descriptive help for the keyword.

OK
Click OK to update the value list box on the second panel (Set values for INI keywords) of the wizard with all the modifications and to dismiss the dialog box. This option will be enabled only when a font name is specified on the dialog box.

Cancel
Click Cancel to dismiss this dialog box without saving modifications.

Apply
This option is visible for the FONT NUMBER/FONT NAME keywords. It is not visible for the DEFAULT FONT keyword. Clicking this option will update the value list box on the second panel (Set values for INI keywords) with all the modifications done for the selected font number/font name. Clicking this option will not dismiss the dialog box.

Close
This option is visible for the FONT NUMBER/FONT NAME keywords. It is not visible for the DEFAULT FONT keyword. Clicking this option will close the dialog box without saving any updates or changes to font mapping since the last Apply.
Index

.INI File • 118

A
Advanced Database Linkage Dialog Box • 115
Appendix • 134
Attribute Definition • 228
AutoCAD Keywords • 54
AutoCAD Scanner • 135

C
CACHE FILE • 47
CACHE UPTODATE • 47
CAD Server Definition Workflow • 87
CAD Server Schema • 134
CHARACTER SET • 38
Connecting to a CAD Warehouse • 13
Connecting to a FRAMME Warehouse • 14
Connecting to a GeoGraphics Warehouse • 15
Connecting to a GML Warehouse • 15
Connecting to a KML Warehouse • 17
Connecting to a MapInfo Warehouse • 17
Connecting to a SmartStore Server Warehouse • 21
Connecting to a SQL Server Spatial Warehouse • 20
Connecting to a SQL Server Warehouse • 20
Connecting to a Text File Server Warehouse • 22
Connecting to a WCS Warehouse • 22
Connecting to a WFS Server Warehouse • 23
Connecting to a WMS Warehouse • 25
Connecting to an Access Warehouse • 11
Connecting to an ArcInfo Warehouse • 11
Connecting to an ArcView Warehouse • 12
| Connecting to an I/CAD MAP Warehouse • 15 |
| Connecting to an MGE or MGDM Warehouse • 19 |
| Connecting to an MGSM Warehouse • 19 |
| Connecting to an ODBC Tabular Warehouse • 19 |
| Connecting to an Oracle Object Model Warehouse • 19 |
| Connections • 31 |
| COORDINATE SYSTEM (ARC/INFO) • 38 |
| COORDINATE SYSTEM (ArcView) • 41 |
| COORDINATE SYSTEM (MapInfo) • 75 |
| Creating Data Server .INI Files • 37 |
| Criteria Tab • 104 |

| D |
| Define CAD Server Schema File • 85 |
| Define CAD Server Schema File Dialog Box • 93 |
| Define Feature Class Dialog Box • 98 |
| Defining or Editing a Coordinate System File • 181 |
| Delimited Data Definition • 222 |
| Delivery and Connection • 27, 31 |

| Displaying Data That Has No Coordinate System Specified • 33 |
| Domain Authentication • 28 |

| E |
| Edit Coordinate System to Feature Class Associations Dialog Box • 110 |
| Edit Coordinate System to Map Associations Dialog Box • 108 |
| Edit Feature Class to Map Associations Dialog Box • 111 |
| Error Handling • 172 |

| F |
| Feature Class Menu • 91 |
| File Menu • 89 |
| File Type Definition • 216 |
| First Panel - Select Data Server Dialog Box • 257 |
| Fixed Width Data Definition • 220 |
| Font-related keywords Dialog Box • 267 |

| FORCE TEXT JUSTIFICATION |
| LOWERLEFT / CENTERLEFT / UPPERLEFT: • 62 |
| FORCE TEXT JUSTIFICATION (CAD) • 49 |

<p>| G |
| General Keywords • 47 |</p>
<table>
<thead>
<tr>
<th>Topic</th>
<th>Page Numbers</th>
</tr>
</thead>
<tbody>
<tr>
<td>General Tab</td>
<td>100, 184</td>
</tr>
<tr>
<td>Geographic Space Tab</td>
<td>196</td>
</tr>
<tr>
<td>Geometry Definition - Line and Area</td>
<td>226</td>
</tr>
<tr>
<td>Geometry Definition - Point</td>
<td>224</td>
</tr>
<tr>
<td>GEOMETRY TYPE</td>
<td>65, 68</td>
</tr>
<tr>
<td>Geometry Type - MapInfo Server Keyword Value Dialog Box</td>
<td>265</td>
</tr>
<tr>
<td>GEOMETRY TYPE (MapInfo)</td>
<td>76</td>
</tr>
<tr>
<td>Graphic Attributes Tab</td>
<td>102</td>
</tr>
<tr>
<td>GRAPHICSTEXTSTRING DELIMITER</td>
<td>48</td>
</tr>
<tr>
<td>GROUP GEOMETRY BY GRAPHIC GROUP</td>
<td></td>
</tr>
<tr>
<td>TRUE/FALSE:</td>
<td>54, 61</td>
</tr>
<tr>
<td>GROUP TEXT BY GRAPHIC GROUP</td>
<td></td>
</tr>
<tr>
<td>TRUE/FALSE</td>
<td>53, 61</td>
</tr>
<tr>
<td>Help Menu</td>
<td>92</td>
</tr>
<tr>
<td>IGDS Keywords</td>
<td>48</td>
</tr>
<tr>
<td>IGDS Scanner</td>
<td>146</td>
</tr>
<tr>
<td>Introduction</td>
<td>203</td>
</tr>
<tr>
<td>Introduction to Define Warehouse Configuration File</td>
<td>231</td>
</tr>
<tr>
<td>KMZ PROCESSING</td>
<td>73</td>
</tr>
<tr>
<td>LEVEL COLUMN ALIAS</td>
<td></td>
</tr>
<tr>
<td>and SYMBOL COLUMN ALIAS</td>
<td>39</td>
</tr>
<tr>
<td>Linkages Tab</td>
<td>108</td>
</tr>
<tr>
<td>LOCK TIMEOUT THRESHOLD</td>
<td>48</td>
</tr>
<tr>
<td>MAXIMUM NUMBER OF FILES OPEN</td>
<td>62</td>
</tr>
<tr>
<td>MEASURE COLUMN ALIAS</td>
<td></td>
</tr>
<tr>
<td>, MINIMUM MEASURE COLUMN ALIAS</td>
<td></td>
</tr>
<tr>
<td>, AND MAXIMUM MEASURE COLUMN ALIAS</td>
<td>42</td>
</tr>
<tr>
<td>Menus</td>
<td>89</td>
</tr>
<tr>
<td>MicroStation Version 8 Scanner</td>
<td>157</td>
</tr>
<tr>
<td>Modify Keyword Value Dialog Box</td>
<td>264</td>
</tr>
<tr>
<td>Native Queries</td>
<td>29</td>
</tr>
<tr>
<td>New (Feature Class Definition) Dialog Box</td>
<td>100</td>
</tr>
<tr>
<td>Non Uniform Row Definition</td>
<td>218</td>
</tr>
<tr>
<td>NUMBER OF LINKAGES</td>
<td>66</td>
</tr>
<tr>
<td>Options Menu</td>
<td>92</td>
</tr>
</tbody>
</table>
Overview of GeoMedia Objects Integration • 11
Overview of the Database Utilities • 85
Overview of the Define CAD Server Schema File Utility • 85
Overview of the Define Coordinate System File Utility • 181
Overview of the Define Text File Server Format File Utility • 203
Overview of the Define Warehouse Configuration File Utility • 231

P
Preparing to Connect • 11
Prerequisites • 31
Primary Unique Key Dialog Box • 113
Projection Parameters Dialog Box • 189
Projection Space Tab • 189

R
Read-Only Connections • 27
Read-Write Connections • 27
Reference Ellipsoid Parameters Dialog Box • 197
Rich Text Format (RTF) Specification • 177
RICH TEXT, SERVE RICH TEXT • 66
Running Define CAD Server Schema File • 86

S
Second Panel - Set Values for INI Keywords • 259
Select Coordinate System Files Dialog Box • 96
Select Map Files Dialog Box • 94
SERVE BLOCK GEOMETRY • 56
SERVE BLOCK ORIGIN • 54
SERVE BLOCK TEXT • 56
SERVE CELL GEOMETRY • 50, 60
SERVE CELL ORIGIN • 50, 60
SERVE CELL ORIGIN, SERVER CELL GEOMETRY, and SERVE CELL TEXT Keywords • 50
SERVE CELL TEXT • 51, 60
SERVE FILES FROM SECURE SITES WITHOUT A VALID CERTIFICATE • 73
SERVE NUMERIC WIDTH AS INTEGER
, SERVE NUMERIC WIDTH AS LONG
, and SERVE NUMERIC WIDTH AS SINGLE • 45
SERVE RICH TEXT
TRUE/FALSE (And the Related INI Keywords) • 51
TRUE/FALSE: • 57

SERVE TEXTNODE AS MULTILINE TEXT • 62

Specify Connection Parameters Dialog Box • 112

Storage Space Tab • 186

T
Tags Tab • 107

TEXT • 77

TEXT ENCODING • 44

TEXT ORIGIN BY RANGE • 51

The ARC/INFO Data Server .INI File • 37

The ArcView Data Server .INI File • 41

The CAD Data Server .INI File • 45, 46

The FRAMME Data Server .INI File • 64

The GeoGraphics Data Server .INI File • 64

The I/CAD MAP Data Server .INI File • 64

The KML Data Server .INI File • 67

The MapInfo Data Server .INI File • 74

The MGDM Data Server .INI File • 78

The MGE Data Server .INI File • 78

The MGSM Data Server .INI File • 78

The WCS Data Server .INI File • 79

The WFS Data Server .INI File • 80

The WMS Data Server .INI File • 82

U

Units and Formats Tab • 199

Update Map MBRs Dialog Box • 116

Using Oracle Connections • 27

Using SQL Server Connections • 31

W

Workflow • 204

Workflow for ArcInfo, ArcView, and MapInfo Data Servers • 232

Workflow for CAD Data Servers • 235

Workflow for I/CAD Map Data Server • 238

Workflow for KML Data Server • 241

Workflow for WCS Data Server • 245

Workflow for WFS Read-Only Data Server • 248

Workflow for WFS Read-Write Data Server • 251

Workflow for WMS Data Server • 254